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your payment of the applicable fees, grants to you a nonexclusive license subject to the following conditions:  
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at any time-sharing system. It may not be copied, altered, modified, translated, or used to create a derivative work. You may not reverse 
engineer, decompile or disassemble the SOFTWARE PRODUCT. You may use the SOFTWARE PRODUCT for your individual use or 
for use within your company, but you may not use the SOFTWARE PRODUCT to produce attendance records to be sold or distributed 
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Purchasers who have paid for a license may currently run and use the SOFTWARE PRODUCT for the number of licenses purchased. For 
additional users, additional license purchases are required. In general, the database allows only the number of users licensed access to the 
common database at one Location (business site). A wide-area network (WAN) license is required for multiple business sites (locations).  
 
Your right to use or install the SOFTWARE PRODUCT automatically terminates upon failure to comply with any provision of this SLA, 
violation of any term of this SLA, or upon your destruction of all copies of the SOFTWARE PRODUCT. In any of the foregoing 
circumstances, you must remove the SOFTWARE PRODUCT from your computer’s hard drive, application server or other mass data 
storage devices and cease use of the product. The License is deemed accepted and delivered in the State of Florida and shall be construed, 
interpreted and governed by the laws of the State of Florida, without regard or effect given to its or any other jurisdiction’s choice of law 
jurisprudence. 
 
G.Neil warrants the SOFTWARE PRODUCT will operate in accordance with its published specifications for a period of ninety (90) days 
following the date of purchase (30 days for opened software). In the event the SOFTWARE PRODUCT  fails to operate in accordance 
with the published specifications during that period, you may return it to G.Neil. G Neil will, at its option, repair or replace the defective 
program or refund the purchase price. THIS IS YOUR SOLE AND EXCLUSIVE REMEDY. 
 
G.NEIL SPECIFICALLY DISCLAIMS ALL OTHER WARRANTIES, EXPRESSED OR IMPLIED, INCLUDING BUT NOT 
LIMITED TO, IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE WITH 
RESPECT TO THE USE AND INSTALLATION OF THE SOFTWARE PRODUCT, DEFECTS IN PRODUCT MEDIA AND 
THE PROGRAM, AS WELL AS THE SOFTWARE PRODUCT’S INTERACTION AND COMPATIBILITY WITH OTHER 
PROGRAMS, SYSTEMS, AND HARDWARE. IN NO EVENT SHALL G.NEIL BE LIABLE FOR ANY LOSS OF PROFIT OR 
ANY OTHER COMMERCIAL DAMAGE, INCLUDING, BUT NOT LIMITED TO, SPECIAL, INCIDENTAL, 
CONSEQUENTIAL OR OTHER DAMAGES EVEN IF G.NEIL HAS BEEN ADVISED OF THE POSSIBILTY OF SUCH 
DAMAGES. THE SOLE AND EXCLUSIVE REMEDY AVAILABLE TO PURCHASERS/LICENSEES UNDER THIS 
AGREEMENT IS LIMITED TO REPLACEMENT, REFUND OF SALES PRICE, OR FULL CREDIT. FAILURE TO COMPLY 
WITH THE TERMS OF THIS SOFTWARE LICENSING AGREEMENT IS STRICTLY PROHIBITHED AND MAY VIOLATE 
COPYRIGHT LAW. 
 
HR•Ware, Attendance Controller and Confidential Employee Record are trademarks of G.Neil Corporation. Microsoft, Windows and 
Internet Explorer are registered trademarks of Microsoft Corporation. Entire work © G.Neil 2003. All Rights Reserved. 
 
 

We welcome your suggestions and comments. Contact us at G.Neil, 720 International Parkway, Sunrise, FL 33345 
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Chapter 1: 

Welcome! 
 
Thank you for choosing Optima Time Clock by G.Neil. This application replaces 
mechanical time clocks, eliminating hand correcting and tallying of time cards and 
dramatically reducing payroll prep time. 
 
When combined with Optima Attendance Controller, this powerful tool provides a 
comprehensive time and attendance tracking system for your business. Features include: 
¾ Easy clocking in/out using keyboard or swipe card 
¾ Detailed time and date stamping of all entries, including supervisor changes 
¾ Instant knowledge of employee status through a virtual in/out board 
¾ Fully customizable work schedules, rounding rules, overtime settings and more 
¾ Data export function to major payroll provider software 
¾ Direct transfer of time card runs into employee timesheets in QuickBooks® Pro and 

Premier Editions 2003 and/or 2004 
¾ Flexible security access for employee and managers alike 
¾ Integration with other Optima programs simplifies data entry  
 
 

Chapter Contents: 

Unlocking the Demo .................................................................... 10 

System Requirements ................................................................... 10 

Network Requirements ................................................................ 10 

Magnetic Stripe Card Reader Specifications ............................ 11 
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Unlocking the Demo .............................................................................................. 
If you have already installed the demo of Optima Time Clock, you can unlock it by 
following the steps listed here.  
 
1. Run Optima Time Clock.  
2. Select Alter Current Product License from the Help menu; click the Edit key.  
3. Enter the Product Key you received with your purchase (it starts with the letter T). 

You’ll find this on the inside of the Optima CD sleeve.   
4. Click OK.  If the confirmation message does not appear, verify that you entered the 

correct key.  The key is not case sensitive.    
 

NOTE: There is a different product key for each G.Neil software product. 
 

System Requirements ............................................................................................. 
Minimum Requirements 
¾ Windows 98 (SE) or later 
¾ Pentium 266MHz or faster processor 
¾ 64 MB available RAM (Random Access Memory) 
¾ 30 MB available hard disk space* 
¾ Access to a CD-ROM drive 
¾ SVGA monitor with 800 x 600, 16-bit color depth or higher 
* Database size dependent on amount of data. 
 
Recommended Requirements  
¾ Pentium III or higher processor 
¾ 128 MB available RAM (Random Access Memory) 
¾ 30 MB available hard disk space* 
¾ CD-ROM drive 
¾ SVGA monitor with 1024 x 768, High Color or higher 
¾ Windows compatible, graphics-quality printer 
¾ Database must reside on a Windows-based operating system 
* Database size dependent on amount of data. 
 

Network Requirements ........................................................................................... 
¾ Windows-based Server or PC – The included Interbase database is not compatible 

with a non-Windows-based operating system, such as Novell. However, you may 
run the database on a Windows-based server or PC connected to a non-Windows 
based network.  

¾ A static (persistent) IP address so that the database will be always connected to 
the client application 
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¾ Proper user license – The database will only allow the purchased number of users 
to be connected at any one time to the database. Wide-Area Networks (WAN) 
require a WAN license based on the number of geographic locations. The Product 
Key is affixed to the inside cover of the CD sleeve. 

¾ CD-ROM drive or access to our software product download area on 
www.gneiltechsupport.com.  

 
Magnetic Stripe Card Specifications ....................................................................... 

This information is if you are going to utilize a card reader.  
¾ Keyboard Wedge – The reader may be a magnetic stripe card or bar code reader. 

We have tested with a keyboard wedge, which the keyboard connects into the 
reader and then to the computer. 

¾ Formats: ISO 7811, AAMVA, and CA DMV. 
¾ Cards must be pre-encoded (on one track only) with up to 24 alphanumeric 

characters on track 1, 2 or 3, with a single carriage return at the end. 
¾ Contact G.Neil at (800) 999-9111 to order card readers and ID Badge Kits. If you 

have a technical question, please contact G.Neil Tech Support at (888) 925-7740. 
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Chapter 2:  

Installing Optima 
Time Clock 
 
 
This chapter explains how to install Optima Time Clock to a Network or Standalone 
computer and answers frequently asked questions about installing.  
 

Chapter Contents: 

Overview ......................................................................................... 14 

License Options ............................................................................. 14 

Frequently Asked Questions ....................................................... 14 

Installing From the CD Menu ..................................................... 16 

Setup Types .................................................................................... 16 

Network Installation Instructions .............................................. 17 

Standalone Computer Installation Instructions ...................... 18 

Quick Note About Peer-to-Peer Installations .......................... 19 

Upgrading from previous versions ............................................ 19 

Remote Terminals .......................................................................... 19 
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Overview ................................................................................................................ 
Optima Time Clock can be installed on a single standalone workstation or a network for 
database sharing among several users, depending on your needs.  
 
Regardless of which license you purchased, you may install the database to a network 
directory for the purpose of backup.  Please consult your network administrator before 
installing to a network directory.  
 

License Options ......................................................................................................  
The license options currently available: 
¾ Single User – Only one application of the Time Station and one application of the 

Time Clock Admin can run at a time.   
¾ Five Users – Five applications of the Time Station and five applications of the 

Time Clock Admin can run at the same time when connected to a single, common 
database. 

¾ Ten Users – Ten applications of the Time Station and ten applications of the Time 
Clock Admin can run at the same time when connected to a single, common 
database. 

¾ Unlimited User License – Any number of users can run either the Time Station 
and/or Time Clock Admin application at the same time when connected to a single, 
common database.  

¾ Wide-Area Network (WAN) License – This is an unlimited multi-site license 
based on the number of geographic locations where application clients are 
connecting to a single, common database. 

 
IMPORTANT NOTE ON UPGRADING 

If you are upgrading from a previous version of Attendance Controller or Confidential 
Employee Record, please read the section on Upgrading BEFORE installing Optima 
Time Clock.  
 

Frequently Asked Questions ................................................................................... 
Q:  Can I map the drive to the database as I did in Version 6 of your other 
software? 
A:  No. There is no mapping involved. If the database is on a network drive, the Client 
Workstation communicates to the Server through TCP/IP.  When you enter the path for 
the Server, it must be “as seen” from the Server. (For example, if the Server Name is 
Server 1 and the Optima Database Path on the Server is: 
c:\program files\gneil optima\hrware\hrware.gdb 
then this is what will be entered (EXACTLY) when installing to a Client Workstation.  
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Q:  What do I need to know before installing to a network drive? 
A: Installing the database to the network and the program files to a Client Workstation(s) 
is a two-step process. You’ll need to install onto the Server (must be physically at the 
Server), and then to the Client Workstation(s). Keep these things in mind: 
1. No drive mapping is involved.  
2. TCP/IP must be installed at the Client and Server if database is on the Server.  
3. When installing to the Server, you will be prompted to write down or print out the 

Server name and database path. Make sure you write these down EXACTLY as 
shown. You cannot install to the Server from the Client. When installing to the 
Client and when prompted for the Server name and database path, enter these in 
EXACTLY as shown from the Server install. NO DRIVE MAPPING IS 
NEEDED. 

4. After installing check to make sure you can run the program from the Server. If 
you’re having problems connecting to the database, check to make sure you have 
System – Full Control on the Optima folder. 

 
Q: What is the difference between the Time Station and the Time Clock Admin? 
A: The Time Station is where your employees clock in/out from and is usually installed 
on a computer(s) in a convenient location accessible to employees. This computer can 
also have a swipe card reader attached to make clocking in/out easier. The Time Clock 
Admin is for managers and supervisors. This is where administrative work is done, such 
as setting up Time Clock access, and editing and printing time cards. 
 
Q:  What type of install (Standalone, Server, or Client) should I perform? 
A: We recommend putting the database on the Server and the program on a Client 
Workstation. A Server has a less likely chance of locking up or crashing and allows the 
database to remain stable. A Client-Server installation requires 1) installing to a Server, 
and then 2) installing the Client(s).  
 
Q:  There isn’t room on the C:\ drive on the Server. Can I install the database 
files and Interbase files to another drive other than c:\? 
A:  Yes. Follow these steps: 
1. When installing Optima to the Server, install the program and database files first. 

Select Custom after the Setup type and click Next. This will give you the choice of 
where to install the program and database files.  

2. After you click on Finish, it will prompt you to install Interbase, the database engine. 
Click Cancel to quit the installation process at this point. 

3. Using Windows Explorer, navigate on the Optima CD to the BIN\Interbase6 
folder and run the IBWIN32Setup.exe file. This will allow you to install Interbase 
to a physical drive.  

 
NOTE: The Optima files need to reside on a physical drive, not a mapped drive. 
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Installing from the CD Menu ..................................................................................  
To begin installing Optima follow these steps: 
1. Close ALL running programs.  
2. Insert the Optima CD-ROM into the appropriate drive of your computer.  
3. The menu will appear. Select which product you want to install. (If the installation 

menu does not appear, click Start, Run. The Run dialog will appear. In the dialog 
box type D:\setup. exe where D: is the letter of your CD-ROM drive. Click OK or 
press Enter. ) 

4. Once the installation procedure begins, follow the on-screen instructions to install 
the software. See Setup Types below for more information. It is recommended that 
you accept the default setting for each step of the install process. If you are installing 
the software in a network environment (Client-Server Installation), you should 
consult your network administrator prior to installation. You must have proper 
network rights in Windows 2000, NT and XP in order to install Optima software. 

5. When installation is complete, the G.Neil program group will be added to your Start 
menu and an Optima Time Clock icon will be on your desktop. 

 
Setup Types ............................................................................................................ 

¾ STANDALONE: Use this option if you are installing to a standalone computer. 
This will install the application files (Time Clock Admin and Time Station) and 
database files to your local drive.  

¾ SERVER: This is the first of two steps in the Client-Server Installation, either for 
true client-server configurations or peer-to-peer network that may be using a 
workstation PC for the database. Choose this option to install the database and 
application files (Time Clock Admin and Time Station) on the Server and before 
installing the Client application to PC workstations. 

¾ CLIENT: This is the second step in the Client-Server installation. This will install 
the application files (Time Clock Admin and Time Station) and ask for the Server 
Name and Database Path. 

 
After clicking on a Setup Type, you will have the following options: 
¾ EXPRESS: We recommended that you select this option if you are installing or 

upgrading Optima for the first time. This will take you through the installation 
process with minimum user intervention.  

¾ CUSTOM: This option is for Advanced Users who have specific installation needs, 
such as installing just the Time Station program on a client.  

 
NOTE: A Client-Server Installation is recommended. The database is more secure 
than if you install it on a Standalone computer, especially when installing Optima Time 
Clock. When running Optima Time Clock on a Standalone computer, you run the risk of 
someone changing the clock settings and creating false time card entries. With a Client-
Server Installation, the database and time are pulled from the server, not from the client 
workstation. 
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Network Installation – (Client-Server) .................................................................... 
Installing a Client-Server setup is a two-step process. You will need to install to the 
Server first and then to the Workstation(s).  
 
To install to a network requires these items: 
¾ Windows-based Server or PC – The included Interbase database is not compatible 

with a non-Windows-based operating system, such as Novell. However, you may 
run the database on a Windows-based server or PC connected to a Non-Windows 
based network.  

¾ A static (persistent) IP address so that the database will be always connected to 
the client application. 

¾ Proper user license – The database will only allow the purchased number of users 
to be connected at any one time to the database. Wide-Area Networks (WAN) 
require a WAN license based on the number of geographic locations. The Product 
Key is affixed to the inside cover of the CD sleeve. 

¾ CD-ROM drive or access to our software product download area on 
www.gneiltechsupport.com. 

 
NOTE: G.Neil cannot provide technical assistance with setting up or maintaining your 
computer network. Please consult your computer manufacturer or network administrator 
before contacting G.Neil Tech Support. 
 
Server Installation Instructions 
Install to the Server first by following these instructions: 
1. Insert the Optima CD on the Server. (Follow the CD Menu Instructions above.) 
2. At the Setup Type, select Server. Click Next.  
3. Select Express. Click Next.  
4. IMPORTANT STEP!: Write down the Server Name and Database Path 

EXACTLY as they appear on the screen.  
5. Click “I have written this information down.” Click Close.  
6. Click Next at the Current Settings screen. This will install the program files to the 

Server.  
7. Click Finish. This will start the installation of the database files.  
8. Click Next, then the I Agree button if you agree to the license.  
9. After the installation, click Finish.   
10. Follow the installation instructions for the Client Workstation. 

 
NOTE: You only have to run the Server installation once. Then you may install 
multiple Clients for the Optima Version of Attendance Controller, Confidential 
Employee Record, or Time Clock, if purchased, or to run as a demo. 
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Client Workstation Installation Instructions 
Install to the Client Workstation by following these instructions.  
1. Insert the Optima CD on the Client Workstation. (Follow the CD Menu 

Instructions above.) 
2. Select Client as the Setup type.  
3. Select Express, then click Next.  
4. Enter the Server Name and Database Path exactly as you wrote down from Step 4 

of the Server Installation. Then Click Next.  
5. Click Next at the Current Settings screen. This will install the program files to the 

Server.  
6. Click Finish. This will start the installation of the needed files to run the database.  
7. Click Next, then the I Agree button if you agree to the license.  
8. After the installation, click Finish.  
9. Install the Client for any other Optima versions. (You do not have to install to the 

Server again.) You may also install to other Workstations, if needed.  
10. Double-click on the desktop application shortcut; the default Login and Password 

are ADMIN. 
 

Standalone Computer Installation Instructions ....................................................... 
Installing to a Standalone Computer requires these items: 
¾ Product Key - Printed on the inside cover of the manual that came with your 

purchase.  
¾ The Optima Version CD-ROM or Program Update from our web site. 
¾ A Computer running a Windows-based operating system.  
 
Installing to a Standalone Computer is quick and easy. Follow these steps: 
1. Insert the Optima CD on Standalone Computer. (Follow the CD Menu Instructions 

above.) 
2. Select Standalone as the Setup Type.  
3. Click on Express, then click Next.  
4. Click Next at the Current Settings screen. This will install the program files.  
5. Click Finish. This will start the installation of the database files.  
6. Click Next, then the I Agree button if you agree to the license.  
7. After the installation, click Finish.  
8. Double-click on the desktop application shortcut; the default Login and Password 

are ADMIN. 
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IMPORTANT NOTE FOR VERSION 6 AND EARLIER USERS 
Optima Time Clock does not share the same database with Version 6 or earlier of 
Attendance Controller and Confidential Employee Record. You will need the Optima 
Version to share the database among the three separate programs. For this reason, you 
should also upgrade Confidential Employee Record to the Optima Version at the same 
time as Attendance Controller; otherwise, you may create multiple non-synchronized 
databases. 
 

Quick Note About Peer-to-Peer Installations .......................................................... 
A peer-to-peer connection allows you to share information between two computers 
without the need of a formal client-server connection. The peer-to-peer connection 
must be in place before following these instructions. See your Network 
Administrator for more details on setting up this type of connection.  
 
On the host computer (the one on which you wish the database to reside), follow the 
instructions above for a Server installation. Write down the Server Name and Database 
Path when prompted. Note: The Server installation will install both the software client 
application and database files to the host computer. Then install the application Client on 
the other computer that will be sharing the information, entering the Server Name and 
Database Path when prompted. 
 

Upgrading from previous versions .......................................................................... 
Upgrading from Version 7 to Version 8 
If you’re upgrading from Version 7 to Version 8, no conversion is required. Opening 
Optima for the first time will update the database to Version 8. The Optima program 
must have exclusive use of the database to perform the update. Because all Optima 
programs share the same database, you must upgrade all programs from Version 7 to 
Version 8 at once. 
 
Version 3 and Below 
If you’re upgrading from Version 3 or below, you will need to upgrade to Version 6, if 
not already installed, and then convert the data to Version 7 before upgrading to Version 
8. Version 6 and 7 are on the Optima CD under the BIN\Legacy directory. Please 
contact our Technical Support Department (see Chapter 14, Contacting Technical 
Support) if you have any questions. 
 
NOTE:  When running the Version 6 DB Repair, it may display information or error 
messages; click OK to continue through this process.   
 

Remote Terminals ................................................................................................... 
This section explains how our program works with remote terminals. A remote terminal 
is a data collection station that looks like a 10-key pad with a magnetic stripe card reader 
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attached. The remote terminal is connected by a network cable that allows you to have a 
small data collection station in areas where you don’t want or need to have a full 
computer and monitor setup.  
 
A remote terminal collects the data (such as someone clocking in/out) and sends the 
information to the database where it processes the data through stored procedures. In 
other words, it does all the processing at the Server where the database resides. The 
remote terminal has a live connection to the Server, so if the Server goes down, 
employees will not be able to clock in or out until the Server connection is restored.  
 
Setting Up a Remote Terminal   
To set up a remote terminal you will need the following: 
¾ One or more Time Clock Remote hardware clocking stations  
¾ G.Neil Remote Terminal Program 
¾ Optima Time Clock Program 
¾ Static IP Address 
 
The Remote Terminal Program allows you to enter an IP Address of the Remote 
Terminal.  
 
You can set up the remote terminal anywhere you can setup a connection to the 
network.  
 
Setting the IP Address on a remote terminal 
1. Have your Network Administrator set up a static IP Address for each remote 

terminal you plan to implement. NOTE: G.Neil Tech Support cannot assist in 
setting this up.  

2. Connect the Remote Terminal to your network through an Ethernet cable 
 
Time Clock Ethernet Terminal 
Time Clock Ethernet Terminals are small, low cost data collection devices that 
communicate with Optima Time Clock over a TCP/IP network. The network interface 
supports both 10BaseT and 100BaseT Ethernet connections. The operator interface 
consists of an LCD display and membrane switch keypad with additional operator input 
options for barcode, mag-stripe, and auxiliary RS-232 serial port.  
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Theory of Operation 
When the Time Clock Remote terminal is connected to an Ethernet network it functions 
similar to a “dumb” terminal. The host software can send commands and displayable 
messages to the terminal via the network. User input is entered at the keypad or mag-
stripe reader and is sent to the host software. To minimize network traffic, the user input 
is transferred as complete strings instead of character by character. Strings are terminated 
by the “Enter” key and terminated with the ASCII <CR> & <LF> characters. The mag-
stripe input automatically includes the “Enter” function. 
 
Terminal Emulation 
The ET214 terminal has two (2) emulation modes, the “Virtual Terminal Command” 
(VTC) mode and the “ANSI Emulation Mode”.  The VTC mode provides a unique but 
simple protocol that eliminates the need to know all the particulars of the lower level 
ANSI protocol.  The ANSI emulation mode is a subset of the standard ANSI terminal 
protocol that supports most of the standard display manipulation command set. For 
more information on these emulation modes see the “Software Interface” section. 
 
Network Interface 
The Time Clock Remote terminal connects to a 10BaseT or 100BaseT hub via a standard 
RJ-45 Ethernet cable. From a network perspective, it occupies a single “socket” at a 
specified TCP/IP address and port number. The device must be configured with a 
unique IP address, net mask, and port number BEFORE it is installed on the network 
(see “Network Configuration Mode”). The host software communicates with the 
terminal by establishing a connection with the terminal and then sending and receiving 
ASCII text command strings. 
 
Operator Interface 
The Time Clock Remote includes an LCD display and a numeric keypad as the primary 
operator console interface. In addition, the terminal may include optional barcode 
and/or mag-stripe input readers and an auxilliary RS-232 serial port for connection of a 
serial input device. 
 
Display 
The Time Clock Remote display is a two (2) line by twenty four (24) column LCD 
character display. It can display the 96 standard ASCII characters and 96 non-standard 
symbols in a 5 x 7 dot matrix font. The cursor position is identified by a blinking box 
and can be positioned under software control. A display backlight is available as an 
option for low light installations. 
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Keypad 
The Time Clock Remote operator keyboard consists of a four (4) row by six (6) column 
membrane switch keypad. Two (2) shift keys (“S1” & “S2”) are provided to generate 
upper case alpha characters and several special characters. The keypad also includes “IN” 
and “OUT” keys for manually clocking in/out and “YES” and “NO” keys for answering 
program questions.  
 
Default Alpha/Numeric Mode 
 
 
A         B    
       7 

C         D 
       8 

E         F 
       9 

G          H 
  SPACE 

   “         ‘ 
       IN 

  (          ) 
    OUT 

[top left  
character] 

[top right character] Function Keys 

[bottom 
row   
character] I           J 

       4 
K          L 
       5 

M         N 
       6 

O          P 
  CLEAR     

  #         $ 
      YES 

  :          ; 
       NO 

Q        R 
       1 

S          T 
       2 

U          V 
       3 

W          X 
BACKSPACE 

 =         @   *          ? 

 
      S1 

Y          Z 
       0 

 
      S2 

   ,          . 
  ENTER 

  -          +  \         / 
CANCEL 

[shift keys]

 
 
 
The shift keys ("S1" & "S2") are used to expand the number of ASCII characters that 
can be generated by the keypad. Holding down a shift key and pressing one of the other 
22 keys generates an alternate ASCII character. For example, holding down "S2" and 
pressing the "7" key generates the ASCII "B" code. In addition, holding down both shift 
keys and pressing a function key results in a special local terminal function. The 
following table shows the assigned local terminal functions. 
 
Key Combination Local Function 
Pressing Bottom Row 
Character 

Enters the bottom character. For example, pressing “7” 
enters the number “7” on the keypad. 

S1 & [top left character] Enters the top left character. For example, pressing “S1” 
& “A” enters the letter “A” on the keypad.  

S2 & [top right character] Enters the top left character. For example, pressing “S2” 
& “B” enters the letter “B” on the keypad.  

S1 & S2 + IN Enter Network Configuration Mode 
S1 & S2 + OUT Enter Configuration Mode 
S1 & S2 + Cancel Reboot Terminal –  Reboot requires reconnecting 

through the TC Remote program 
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Setup & Configuration 
It is strongly recommended that you read these instructions on setting up and 
configuring the Time Clock Remote terminal BEFORE attempting to install it.  
 
The Time Clock Remote terminal must be configured for Optima Time Clock BEFORE 
it can be installed and used on the network. Configuration parameters can be modified 
through the operator console and are saved in non-volatile memory. Network 
communication parameters are entered with the “Network Configuration Mode” and the 
console parameters are modified with the “Console Configuration Mode”. 
 
Configuring the Time Clock Remote terminal is done in three steps: 
1. Configuring the Network Configuration. 
2. Configuring the Console Configuration. 
3. Setting Up the TC Remote program. 
 
Network Configuration Mode 
The Network Configuration Mode is used to configure the Time Clock Remote 
communications parameters. These parameters must be set BEFORE the terminal is 
installed on the network. Holding down the “S1” & “S2” shift keys and pressing the 
“IN” key will start this mode. A menu will be displayed and pressing the “2” key will 
allow access to the network parameters. The display will present a series of configuration 
parameters and their current values. A value can be changed using the keypad and 
pressing the “Enter” key. After the last parameter is entered the values are saved in 
memory and the menu is display again. Exit from the “Network Configuration Mode” is 
accomplished by pressing the “Enter” key at the menu.  
 
The following table summarizes the “Network Configuration Mode” parameters and the 
VTC command names used to change them. NOTE: Only the MYIP, NETMASK, and 
MODE parameters need to be configured to work with Optima Time Clock. 
 
Name Default Value Description 
MYIP 192.168.168.50 Defines the unique network address of this 

terminal. This value must be set BEFORE 
installing the device on a network. The default 
value may NOT be appropriate and a new 
address should be obtained from the network 
administrator. 

NETMASK 255.255.255.0 Defines the network mask for the IP address. 
This value must be set BEFORE installing the 
device on a network. The default value may 
NOT be appropriate and a new value should be 
obtained from the network administrator. 
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Name Default Value Description 
GATEWAY 0.0.0.0 Can be set to the address of a router or gateway 

if the network extends to multiple segments. 
This value must be set BEFORE installing the 
device on a network. The default value may 
NOT be appropriate and a new address should 
be obtained from the network administrator. 

TCPPORT 1070 Defines the primary TCP/IP port number used 
for this terminal. This value must be set 
BEFORE installing the device on a network. In 
most cases, the default value will be acceptable. 
However, it may NOT be appropriate and a new 
port number should be obtained from the 
network administrator. It should be set to 23 for 
a “telnet terminal” application. 

SERVER 0.0.0.0 Defines a TCP/IP address for a server 
application. This value must be set BEFORE 
installing the device on a network. Normally, 
this value is set to 0.0.0.0 which causes the 
terminal operate as a “server” and connects with 
a host computer running a “client” application. 
If this value is set to any other IP address the 
terminal will operate as a “client” and will 
attempt to automatically connect to a host 
computer “server” application. 

AUXPORT 9600,0,8,1,1 Defines the communications format for the aux 
serial port. The parameter string consists of five 
(5) integer value fields and has the following 
format: 
Baud, parity, data bits, stop bits, xoff  Where: 
Baud = standard baud rates in the range of 110 
– 57600 
Parity = 0 (none), 1 (even), 2 (odd) 
Data bits = 7 or 8 
Stop bits = 1 or 2 
Xoff = xon/xoff protocol (0=disable, 1=enable) 

MODE 1 Defines terminal emulation mode. The two (2) 
valid emulation modes are as follows: 
1 = VTC Mode (default) 
2 = ANSI Mode (Optima setting) 

MYMAC 0050C2163007 This command will return a 12 character 
hexadecimal string representing the Ethernet 
hardware address. It is read only and can not be 
used to change the hardware address. 
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Chapter 3: 

Getting Started 
 
 

This chapter will help you to get started quickly and provide references for other 
chapters.  
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Before You Begin..................................................................................................... 
You should have the following information available: 
¾ Location and Department names 
¾ User Information (managers, supervisors, administrative assistants and others who 

will have access to the data) 
¾ Employee Data (Employee Name, Hire Date, Work Status (full or part time), Active 

Status (Active, Inactive, or Terminated), Location and Department, Day Work 
Hours and Week Hours). You will need additional information about employee 
schedules, overtime and rounding rules, payroll categories and codes, etc., to fully 
set up Optima Time Clock. 

 
Navigating the Management Windows 
Optima Time Clock is now easier to navigate than ever before. Even better, if you have 
other Optima software installed, such as Optima Confidential Employee Record and 
Attendance Controller, you have access to all programs and features from one 
convenient interface.  
 
The main parts of the Optima user interface are the Menu Bar, Program Bar, Feature 
Column, Employee Select Column, Selected Feature Pane and the Recent Features Pane. 
  
 

 
 
 
 
 
 

Program Bar 

Recent Features 
Pane 

Status bar 

Feature Column Employee Select 
Column

Selected Feature 
Pane

Menu bar 
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Menu Bar 
The menu bar includes the following options: 
Menu Description 
 

File  
Maintenance - Backup Database – Backs up the Optima database. 
Export Time Clock Data -  
Import Data – Imports basic data into the database. 
Export Data – Exports basic data from the database. 
Delete – Deletes current employee record. 
Exit – Closes program. 
[Employee Name(s)] – The last seven employees that have been 
entered or edited will show here for quick navigation back to their 
record. 

 

View  
Filter Page – This option allows you to filter by Active, Inactive, 
Terminated, Full and Part Time Status. 
Open Reminders – Shows open reminders that have not been 
resolved and whose date has not passed.  
Checklist – Shows the Checklist for getting started.  
Welcome – Shows the Welcome Screen.  

 

Settings  
 
 
 
 

User Security – This screen allows you to set up user access. 
Global Preferences – This feature allows you to set up settings that 
affect features within the program.  
Guest Users – This option is for users who want to set up access to 
the database using a third party tool, such as Crystal Reports.  
Reason Codes – This allows you to set specific reasons when 
entering paid time for an employee.  
Locations Departments – This feature allows you to create your 
locations and departments. 
Messages – These messages will be seen when employees clock in 
and out.  
Work Schedules – Work Schedules allows you to set rounding rules 
(grace period) for employees clocking in/out.  
Time Difference – If you have multiple sites in different time zones, 
this option will allow you to set the difference in time for each 
computer connected to the database. 

Reports There are 12 different reports from basic employee information to 
viewing time cards and tracking deleted time clock entries (See 
Chapter 10 – Using Reports). You may also customize a report to fit 
most needs through Custom Reports. 
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Menu Description 
 

Help  
Contents – This brings up the Help File for Optima Time Clock. 
Note: Internet Explorer 4.x and above needs to be installed for this 
option to work. 
System Information – This gives you information about your 
computer, database path, and other information that is needed when 
speaking to G.Neil’s Technical Support team. 
About – This shows the version number, type of license (Single User, 
five user, 10 user or Unlimited), and User Login Name. A link to the 
G.Neil Tech Support site is also located here. 
Alter Current Product License – This allows you to enter a new 
Product Key Code.  

 
Feature Column 
The Feature Column includes the following options:  
Button Description 

Employee Detail 

Employee Detail allows you to add new employees and edit 
employee information. This screen is shared between Optima 
Attendance Controller, Confidential Employee Record and 
Time Clock.  

In / Out Board In/Out Board allows you to view the clock in/out status of 
employees at a glance.  

Reminders Reminders allows you to view, edit and create reminders. 

Time Clock 
Access 

Time Clock Access allows you to set up employee access to 
clock in/out. You may give employee access to create, edit 
and/or delete their own time entries. 

Time Clock 
Entries 

Time Clock Entries allow you to maintain employee time 
entries. You may view, add, delete and edit time entries as 
needed.   

Time Card Runs Time Card Runs allow you to view, print or export time 
cards  

 
Toolbar 
The Toolbar contains buttons that allow navigation between feature records and allows 
editing of employee information.    
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Go to Launch 

Feature 
Help 

Create New Save Changes

Cancel ChangesEdit Record

Delete Record 

Print Report 



 

Starting Optima Time Clock ................................................................................... 
Optima Time Clock consists of two applications: the main application - Optima Time 
Clock Admin - where administrative work is done, such as setting up logins, editing 
time cards and printing time card runs; and a separate application called the Optima 
Time Station, where your employees clock in and out. 
 
NOTE: Separating the Admin and Time Station applications is new to Version 8. In the 
previous version of Time Clock you had to go through the clock in/out screen to log 
into the Admin application. 
 
To start the Time Station, click Start > Programs > GNeil > Optima Time Station or 
double-click the program icon on the computer where your employees will clock in/out. 
 
The Time Station is where your employees will clock in and out. Employees may clock in 
and out using the keyboard or swipe card with magnetic stripe reader or TC Remote 
Terminal.  
 
 

 
 
 
 
 
 
 
 

When installed on a 
Server, for security 
purposes, the date and 
time is pulled from the 
Server, and not from the 
Workstation. 

Clock- in and -out using 
the keyboard at the 
employee’s desk or by 
magnetic stripe card 
reader.  

In Out Board – Shows 
who is clocked in and out 
at a glance. 

My Time Clock – 
Employees may login to 
view their time sheets. 

Time Station
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Opening The Management Screen .......................................................................... 
The Management screen allows you to view and edit employee time entries, run reports, 
and set program options. If you have the Optima Time Clock (full program) installed on 
the same computer where user can clock in / out, you will have the option to log into 
the management screen by clicking Management > Management Login. Or you may 
get to it by clicking Start > Programs > G.Neil > Optima Time Clock.  
 
NOTE: A Management (Administrator) Login is different from an Employee Login. A 
Management Login allows access to set up screens, time card entries and reports; 
Employee Login only allows employees to clock in/out and manage their individual time 
entries. 
 
The Welcome Screen 
If you’re going into the Management screen for the first time, the Welcome screen will 
appear. The Welcome screen gives you tips on getting started and the new features. 
 
If you do not want this window to appear the next time you start Optima Time Clock, 
click Don’t show this message again in the bottom left. To show this message at 
startup from within Optima Time Clock, choose View > Welcome. Click Continue to 
open the Management screen.  
 
Logging into the Management screen 
A user login is different from an employee login. An employee login (set under Time 
Clock Acess) will only have access to the My Time Clock feature and to clock in and 
out. A user login (set under User Security) will allow managers, supervisors, and other 
administrators access to setup and maintain Optima Time Clock.  
 
Login and Password 
If you’re logging in for the first time, the default user login is Admin, and the default 
password is Admin. For security purposes, we highly recommend changing this 
password after you log into the Management screen.  
 

Optima Time Clock Checklist .................................................................................  
For first time users, the Optima Time Clock Checklist will appear. If you do not want 
this window to appear at startup, click I am finished with the checklist. To show this 
window from within Optima Time Clock, choose View > Checklist.  
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The Checklist shows in order the sections that you should complete to get up and 
running quickly.  
  
� Change the Admin password by going to Settings > User Security.  We highly 

recommend changing the Admin password even if there aren’t other users. If 
needed, set up access for others who will need to help you set up the program.  If 
you need to give access to specific locations and departments, or individual 
employees, set these up first and then come back to User Security and complete 
security access.  (See Chapter 5 – Setting Security Rights.) 

� Create Locations and Departments (See Chapter 3 – Creating Locations & 
Departments .)  

� Set up Global Preferences.  (See Chapter 3 – Setting Up Global Preferences .) 
� Set up preferences (See Chapter 3 - Setting Up Time Clock Preferences .) 
� Set up Reason Codes (See Chapter 3 - Setting Up Reason Codes  
� Create Work Schedules (See Chapter 8 - Creating and Editing Work Schedules.) 
� Add Employees (See Chapter 7 - Adding a New Employee .) 
� Assign Time Clock Access (See Chapter 3 - Assigning Time Clock Access .) 
� (Optional) Setting Up Optima for Time Zone Differences (See Chapter 3 - Dealing 

with Time Zone Differences .) 

 
Changing the Admin Password ............................................................................... 

The Admin login and password allows access to all features within Optima. Changing the 
Admin password is quick and easy, and allows for greater security.   
 
NOTE: The password should be one that you will easily remember but not easily 
guessed by those who know you. A combination of letters and numbers (no spaces or 
special characters) at least 8 characters long will make a good password. 
 
To change the Admin password, follow these steps: 
1. From within Optima, go to Settings > User Security. 
2. Enter a new password in the Password block. Then enter the password once more 

in the Verify Password block.  
3. Click Save. 
The next time you log in, you may use the new password.  
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User Security 
Screen 

Detail, Attendance, Records and Time 
Clock – set access to specific program 
features.

Location/Department – set 
access to location/department or 
employees. 

Feature/Access Rights – 
allows you to set access to each 
feature. 

Save As – allows you 
to copy access rights 
from one user to 
another.

Search For - allows 
searches by user 

 
Creating Locations & Departments ......................................................................... 

Locations and Departments are required and must be assigned to each of your 
Employees (See Chapter 7 - Adding New Employees to assign Location/Department 
to employees).  Locations and departments allow you to sort your employees within a 
designated group. A location is considered a geographic place or group name, such as a 
Chicago or East Coast. A department is considered a specialized division or group 
name under the location, such as Sales or Merchandising.  
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Assign departments to each location. Only those 
departments selected will show up under that 
location on the drop down menu. 

Location and 
Department set up 

Location / Department 
screen

NOTE: Departments are assigned to Locations. When setting up Locations and 
Departments for the first time, a Location must be set up FIRST, and then you may 
assign a Department to that Location.   
 
Setting up Locations and Departments 
To create your Locations and Departments, follow these steps: 
1. Click on Locations and Departments from the Settings menu.  
2. Click Locations, then click New.  
3. Enter the Location name.  
4. Click Save.  
5. Click New again to create other Locations as needed.  
6. Click the Departments, then click New.  
7. Enter the Department name.   
8. Click Save.   
9. Click New again to create other Departments as needed.  
10. After all locations and departments are created, click the + sign next to Location in 

the right pane.   
11. Assign departments to a location by clicking in the box next to the department.   
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NOTE: As you add more locations and departments, you’ll see that each location has 
ALL of the departments that you’ve created.  However, only those departments that you 
assign to a location will show up when selecting them on other screens.   You may not 
remove a Department from a Location if an Employee is still assigned to that 
Location/Department combination.  
 

Setting Up Global Preferences ................................................................................  
Global Preferences allows you to control your default program settings, such as 
Company Info, Report Options, and specific program options.   
 
Before editing any of the Global Settings, you must first click the EDIT button.  See 
below for detailed information on each tab. 
 
Company Info Tab 

Global Preferences  
- Company Info Tab 

 

 
 

The Company Information screen allows you to enter your company name, address and 
logo.  We recommend entering the company name and logo as these will print out on 
Reports.   
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Feature Description 

Company Name (Recommended) This will display on the report 
heading.  

Address, City, State, Zip 
and County 

(Optional)  

Remove Current Logo This allows you to unselect the current logo. 
Assign New Logo This allows you to select a new logo. This logo will 

display on the top left of reports. 
Save Logo to disk This allows you to save the current logo to disk or 

to your hard drive.  
 
Editing Company Info 
Follow these instructions to edit the company info: 
1. After clicking on Settings, Global Preferences click Edit.  
2. Enter Information as needed.  
3. Click Save.  
 
Adding a Company Logo 
If you have your company logo available in a bitmap (. bmp) or jpeg (.jpg) file format, 
you can have this logo appear on reports. Optima supports .bmp and .jpg file formats 
not to exceed 200x200 pixels in size. The logo will appear in the top left when you print 
a report. 
 
To add a company logo, follow these steps: 
1. Click Assign New Logo.  
2. Navigate to the directory where the company logo is located. It can be in a .bmp or 

.jpg format no bigger than 200x200 pixels in size.  
3. Click on the logo and then click on Open to select it.  
4. Click the Save button.  
 
Saving Logo to Disk 
You may save the logo to a directory on a disk or hard drive. When you add a logo 
within Optima, the logo is actually saved within the database file.  
 
General Settings Tab 
The General Settings screen allows you to enter the default hours in a day that employees 
will be assigned and allows use of the Forgotten Password Utility. This screen also allows 
settings for Forced Writes to Interbase and prompting to backup on exit.  
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Feature  Description 

Epoch Setting We strongly recommend keeping the default settings. This 
setting will allow the Optima program to appropriately interpret 
any two-digit year entered that is between 1920 and 2019. For 
example, with the default Epoch  setting of 1920: 
1. If you enter a date (such as in the Hire Date field) of 

03/05/01, the program will interpret this as 03/05/2001. 
2. If you enter a date of 03/05/18, the program will interpret 

this as 03/05/1918.  
Note: If you need to enter a year prior to 1920 or after 2019 in 
a date field within the program, you may enter the year as a 
four-digit number.  

Default Hours in 
a Day  

These are the default hours that will be assigned when creating 
a new employee. The Day Hours on the Employee Detail 
screen will be filled in automatically with these default hours 
when a new employee is created.   

National ID 
Number Format 
/Label 

Selecting one of these options will allow you to set the mask for 
the National ID Number Format. The default mask is set to the 
USA SSN format. With this selected, whenever you enter a new 
employee, the dashes will automatically come up in the xxx-xx-
xxxx format. The label is the title that will appear on the 
Employee Detail screen. 

 
 Global Preferences – 

General Settings Tab 
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Feature Description 

Allow use of Forgotten 
Password Utility  

This option allows access to a utility that can be 
used, only with assistance from G.Neil Tech 
Support, to gain access into the Optima program. 
In order to use this feature, we require that a 
statement on a company letterhead and signed by a 
supervisor, be sent by fax or mail stating that the 
user is allowed full access into the program. We 
keep statements on file. Call G.Neil Tech Support 
if you have forgotten or lost your Optima 
password. 

 
Forced Writes for Interbase  

• If running the Optima database on a 
Standalone computer, this option will help to 
keep the database more stable. A Workstation 
is more prone to lock up or crash than a 
Server. If the Optima database is installed on a 
Workstation and the program is open at the 
time the computer locks up or crashes, the 
database is prone to becoming corrupt and 
possibly unrepairable.  A computer lockup or 
crash can be attributed to several things, 
including having too many programs open at 
the same time than what your computer 
memory can handle.  

• If the database is installed on a Workstation or 
Standalone computer, we recommend keeping 
this option checked. The performance may lag 
a little, but unless you have more than 800 
employees, you may not even notice it.  We 
also recommend having a current backup, 
created within Optima or DB Monitor, 
available. If the database is installed on a 
Server, normally a backup of the whole Server 
is created on a daily or regular basis. We still 
recommend setting up Scheduled backups 
within DB Monitor, but having this option 
checked is not as important on a Server. 

 
Prompt for backup on Exit  

This option allows you to turn on or off the 
message prompting for backup when you close out 
of the program. Backups are very important. We 
recommend that you turn this feature off only if 
you have scheduled backups within the DB 
Monitor.  
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Report Options Tab 
The Report Options settings affect how reports will appear by default.  

 

Global Preferences – 
Report Options Tab 

 
Feature Description 

Print Preview  Toggles (turns on and off) showing preview first 
g. before printin

Header Bold  Toggles bolding for Header Title 
Header Line  Toggles putting a line under the Header Title 
Header Shade  Toggles shading for Location or Department title 

row 
Data Line  Toggles lines to separate data information 
Print SSN  Toggles ability to show Social Security Numbers  
Print Picture  Toggles ability to print Picture on printout 
Print Totals  Toggles whether or not Totals show up on reports 

 
Editing Report Options 
To Edit Report Options, follow these steps: 
1. Click EDIT.  
2. Choose an option by clicking in the box.  
3. Click Save.  
 
Attendance Controller Tab 
The Attendance Controller Tab will only show if Attendance Controller is installed. 
Please see the Optima Attendance Controller manual for more details on this feature. 
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Setting Up Time Clock Preferences    

 

Global Preferences 
– Time Clock Tab 

 
The Time Clock Tab allows you to set global settings for Optima Time Clock. This will 
also allow you to enable Attendance Controller and Time Clock code sharing.  
 
Feature Description 

Time Format  This allows you to set the time to display in military 
style or 12-hour style.  

In/Out Board Settings  a. Enabled – This allows the user to view the 
In/Out Board from the main screen. 

b. Display Time – This will show the clock 
in/out time for the employee. 

c. Require Login – This causes the In/Out 
Board to require a login and password. 

Time Display Rate  This causes the main clock to be viewed in seconds 
or minutes. 

Attendance Controller 
Code Sharing   
(See Chapter 4: Setting Up 
Attendance Controller Code 
Sharing for detailed 
information.) 
 
 
 

If you have Optima Attendance Controller 
installed, the following options will be available:  
a. Enable Code Sharing - This will allow hours 

worked and paid time off codes to be shared 
between Optima Attendance Controller and 
Time Clock.  For example, if a code “V” for 
Paid Vacation of 8 hours is entered on the 
Calendar in Optima Attendance Controller, 
this time will also be entered into Optima 
Time Clock as a manual time entry of 8 hours.  

 

39 Ch 3:  Getting Started 



 

Feature Description 

Attendance Controller 
Code Sharing  (Cont.) 

b. Enable Hours Worked Transactions 
Relation - (Enable Code Sharing must be 
checked for this option to be available.) This 
allows the “W” code (Hours Worked) entry in 
Optima Attendance Controller to be entered 
as a manual time entry in Optima Time Clock.  

c. Reported Payroll Description Columns - 
Reason Code  = Payroll Code Description = 
Related Attendance Controller Absence Code.  

Note: Reason Codes and Payroll Code 
Descriptions must be set up before assigning the 
Reported Payroll Description Columns. (See 
Chapter 3 - Setting Up Reason Codes .) 

Sync with the server every 
120 second(s)  

This is how often the client will synchronize the 
main clock with the server.  

User must login/punch 
within 30 second(s)  

Once a user enters the first character into the login 
screen, a countdown timer starts. If a user doesn’t 
finish entering his or her login and password 
within the allotted time, the screen will reset the 
main clock screen.  

Enable Swipe Card Usage  This allows you to enable the use of swipe cards. 
(Swipe cards and swipe card reader required.) 

Require Password when 
Swiping  

Users will be required to enter a password when 
swiping in. 

Enable “Auto Clocking”  This enables the “smart” clocking feature. When 
users clock in the first time, the program clocks 
them in. The next time the user will be clocked 
out and so on. If 13 or more hours pass between 
punches, this feature will be reset and will take the 
next punch as an In punch.  

Require Password for 
manual Employee Login  

Users will be required to enter a password when 
clocking in/out.  

Require Password for 
access to My Time Clock  

Users will be required to enter a password when 
going into the My Time Clock feature.  

Request confirmation if 
user is double clocking  

Double clocking is defined as two In punches or 
two Out punches in a row. If a user tries to clock 
in/out twice in a row (within a 13-hour period), a 
message box will pop up asking for confirmation. 
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Setting Up Reason Codes ........................................................................................   
You may get to Reason codes by going to Settings > Reason Codes. 
 
When you make a change to a punch entry, you are required to enter a reason for the 
change. All changes, such as deleting or editing a punch entry, are tracked and recorded. 
Reason Codes allow you to create these reasons customized for your company.  There 
are different types of reasons:  
 
Feature Description 

Use for Punch Changes Reasons you would use when making a change to 
a punch. For example, you might enter a punch 
time for an employee because he or she forgot to 
punch in. (The reason would be Forgot to Punch.)  

Use For Deleted Entries Reasons you would use when deleting a punch or 
time entry. For example, you would delete a punch 
or time entry because someone punched in twice. 
(The reason would be User Error.)  

Use For Time Entries 
(Manual Time Entries) 

Reasons you would use when entering a manual 
time entry. For example, you may want to enter 8 
hours of Paid Vacation for an employee. (The 
reason would be Paid Vacation.) This reason is also 
associated to Optima Attendance Controller, if 
code sharing is checked. 

 
Typical reason codes could be Forgot a Punch, User Error, or Computer Down. For 
example, if the new employee, Josh, came in at 8:30 AM and forgot to clock in, Josh’s 
supervisor would need to create a punch entry for 8:30 AM so that Josh gets credit for 
that time.  
 

 

Reason Codes 
Screen 
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Feature  Description 

Reason Code  This is the name of the reason (PTO, Sick, Personal, 
User Error, etc). 

Enabled When checked, this allows the reason code to show up 
when editing time on the Time Clock Entries screen. 

Use for Punch Changes 

ow). 

These are Reason Codes that you want to see when 
you're doing a manual punch (Clock In or Out) 
change. A punch change changes or adds a specific 
punch in/out time entry. This is different from giving 
a full or partial day (see Use for Time Entries bel

Use for Delete
Changes  

d Whenever you delete an entry, you'll need to enter a 
reason. These are the Reason Codes that you want to 
show up when DELETING an entry. 

Use for Time Entries   

artial day. For example, you 

These are reasons that you only want to see when
entering a manual time entry, such as Vacation, 
Personal, Sick, etc. A manual time entry is normally 
entered to give a full or p
might enter 4 or 8 hours of time for an employee that 
is on Vacation. This reason is different from giving a 
single entry for punching in or out for a specific time 
(see Use for Punch Changes above).  

Count Towards 
Overtime Calculations  

When checked, this setting tells Time Clock to count 
time under this Reason Code towards overtime.   

Payroll Code 
Description  

time will be shown in the “Other” column on reports. 

(Optional) Enter a Payroll Code Description. This 
description will show up on the Time Card Runs 
report. If a Payroll Code Description is not entered, 

Payroll Code Number  (Optional) Enter your company’s Payroll Code 
Number. This payroll code number will show up when 
exporting time card runs. 

Related Attendance 
Controller Absence 
Code -This option will 
only be available if the 
Enable Code Sharing is 
checked (under Global 
Preferences > Time 
Clock Tab).  

This allows an Absence Code from Optima 
Attendance Controller to be directly related to a 
Reason Code in Optima Time Clock. When an absence 
or time worked code is entered on the Attendance 
Controller Calendar, this entry will be entered in Time 
Clock according to the related Reason Code. Similarly, 
when you create a manual entry with a Reason Code in 
Time Clock, an Absence Code appears on the 
Attendance Controller calendar screen. 
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Creating a New Reason Code 
To create a new reason, follow these steps:  
1. Go to Settings > Reason Codes. 
2. Click New. 
3. Enter a reason for the following: 
a. Reasons you would use when making a change to a punch.  
b. Reasons you would use when deleting a punch or time entry.  
c. Reasons you would use when entering a manual time entry.  
NOTE: You can select multiple uses for a reason code. For example, when using the 
reason code “Off Site,” you may want to be able to select this when entering a punch 
change or when entering a full or partial amount of time.  
4. Select Enabled. This will allow the reason to be selected when making changes. 
5. Click Save.  
 

Work Schedules ...................................................................................................... 
You may get to Work Schedules by going to Settings > Work Schedules. 
 
There are some things in life that nobody has control over that may make an employee 
late for work. Many companies give a grace period to employees when punching in or 
out to cover these occasional events. Setting up a Work Schedule allows you to give a 
grace period from 2 to 60 minutes. You may run an Exceptions report to show if 
employees are abusing this right.   
 
NOTE: If a Work Schedule is not set up or assigned, employees will be clocked in/out 
with no rounding or overtime rules. You will also not be able to run the Punch 
Exceptions Report.  
 
Under Work Schedules, you may also set up overtime and punch schedules and rules that 
govern how to handle shifts that go over midnight into another day. You will need to set 
up your rounding rule (Work Schedule) and assign that rule to each employee. The most 
common rounding rules of 6, 10, and 15 minutes have already been set up for you.  
 
To set up your rounding rules, go to the Settings menu, then Work Schedules. (See 
Chapter 8 – Create and Edit Work Schedules for detailed instructions on setting up 
Work Schedules.) 
 
To assign a Work Schedule to an employee, go to the Time Clock Access Feature, then 
Current Work Schedule. (See Assigning Time Clock Access below.) 
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Printing Work Schedules 
You may print all current Work Schedules by going to Settings > Work Schedules and 
clicking on the Printer icon.  
 
Printing Employee Assigned Worked Schedules 
To print the work schedules are assigned to employees, go to Reports > Work 
Schedule Assignments. 
 

Adding Employees .................................................................................................. 
You may get to the Employee Detail Feature by selecting Employee Detail under the 
Feature Column. 
 
All employees are entered through the Employee Detail screen. From here, you can enter 
their names, Social Security Numbers (optional), Hire Dates, Job Titles, and other 
pertinent information. This information is shared between Optima Attendance 
Controller, Confidential Employee Record and Time Clock. This means that when you 
enter this information in one program, you’ll be able to see it in the other Optima 
programs. 
 
Required Fields 
The following fields are required: First Name, Last Name, Hire Date, Work Status, 
Employment Status, Location, Department, and Day Hours. SSN is not required in 
Optima, but may be required when exporting Time Card Runs for certain payroll 
programs. 
 

 

Employee Detail 
screen 

 
To add a new employee, click New.  (See Required Fields above.) Click Save after 
entering employee information.   



 

NOTE: Locations and departments must be set up before entering new employees. (See 
Settings > Locations/Departments to set these up.) 
 

Assigning Time Clock Access .................................................................................. 
In order to allow employees to clock in and out, Enable Employee Time Clock 
Access will need to be checked under the Time Clock Access button.  You may also 
give employees access rights to create, edit and/or delete their own time entries.  
 
To assign access to an employee, follow these steps: 
1. Select the employee that you want to allow to clock in/out by clicking on his or her 

name in the browse window.  
2. Select the Time Clock Access button. 
3. Enter a login name. The employee will use this to login to clock in/out and to gain 

access to the My Time Clock feature. My Time Clock allows employees to see 
their time entries.  

4. Enter a password, and enter it again in the Verify Password block.  
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Employee Login and 
Password. This is what 
they will use to clock in 
and out with. 

Time Clock Access -
These settings allow 
employees to clock 
in/out, and to edit 
their time entries. 

The Time Clock 
Access Feature 

In Out Board Access 
allows access to see 
all, none, or loc/dept 
on board.

Current Work 
Schedule assigned for 
rounding rules. 

Swipe Card ID 
allows use of 
magnetic stripe 
card with 
reader. 
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Creating Time Clock Messages ............................................................................... 
To get to the Time Clock Messages screen, go to Settings > Messages. 
 
This screen allows you to enter messages that employees will see when they clock in or 
out. You may even set how long the message will stay on the screen.  
 
To display a message, type your message in the message block for either Clock In or 
Clock Out Message, then click Save.  
 
 
 

 

Time Clock Messages 
Screen 

Message Block 

Enabled  – This 
will show message 
when Clocking 
In/Out.

Display message for __ 
second(s) – how long the 
message will stay on the 
screen. 
 Displays employee 
photo and balances 
when clocking in/out. 

 
NOTE: The Clock In message will display whenever an employee clocks 
in, and the Clock Out message will display whenever an employee clocks 
out.  For example, when an employee clocks in to begin the workday, the 
Clock In message will display. This same message will display when the 
employee clocks in from lunch.   
 

Setting a Reminder ................................................................................................. 
Go to Time Clock > Reminders Feature.  
 
The Reminders feature will show you all open (unresolved) reminders and allow you to 
create, delete and resolve reminders. If you have created a reminder it will show up when 
you first open the program, starting on the reminder date. Reminders will continue to 
display until you click Resolve. 
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Reminder Screen 

 
Reminders Tool Bar and Pane Layout 

� Tool Bar 
First-Prior-Next-Last arrows – navigates through selected reminders 
New – Creates a new reminder 
Edit – Allows you to make changes to a reminder 
Save – Saves reminder 
Cancel – Cancels current changes 
Delete – Deletes selected reminder 
Print – Lets you print the Reminders report for selected employees 
Help – Brings up help for this screen 

 
� Pane Layout 

Reminder Date – Date reminder should first display 
Title – Heading of reminder 
Resolved – Checkbox displays checked for resolved or unchecked for 
open (unresolved) 
Employee Name – Displays name of employee that reminder is 
associated with 
User – Displays name of user that reminder will display for 
Description – The purpose of the reminder shows here 

 
� Filters 

User – Allows you to view reminders associated with specific users (must 
have access to Reminders, Assign Users under User Security) 
Show Resolved – Displays Resolved reminders only 
Show Unresolved – Displays Unresolved (open) reminders only 
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Creating a New Reminder 
There are two types of reminders in Optima:  
One Time Reminders – These are reminders that are only meant to remind you of a 
one-time event, such as filing an Absence Report at the end of the year.  
Recurring Reminders – These remind you of the following recurring events:  
Anniversaries (Optima Attendance Controller) 
Birthdays, Performance Reviews, and I-9 Renewals (available if Optima Confidential 
Employee Record is also installed) 
 
Setting a Reminder 
One Time Reminder 

1. Click on Reminders from the Features Column.  
2. Click New.  
3. Select (check) One Time Reminder.  
4. Enter a Title and Reminder Date 
5. If you want the reminder to be associated with specific employees, select the 

checkbox “Assign to all selected (checked) employees.” This is optional and will 
create a separate reminder that is associated with each employee.  

6. If you selected the checkbox in Step 5, you will need to select (check) any employees 
that this reminder is about in the Employee Select Column. Otherwise, skip to the 
next step.  

7. By default, the User’s name will default to the login that was used to enter the 
program. Change this if you want the reminder to come up for another user, or you 
may select Global which allows the reminder to come up for all users logging in. 
Note: You must have access to Reminders, Assign Users and Reminders, Assign 
Global under User Security to be able to change this option.  

8. Enter a description of the reminder, if needed. 
9. Click Save. 

 
Recurring Reminder 
1. To create a recurring reminder, follow these steps: 
2. Select Reminders from the feature list. 
3. Click New. 
4. Select (check) Recurring Reminder. 
5. Select the type of reminder: Anniversary, Birthday, Performance Review, or I-9 

Renewal. 
6. Select a Through Date (when do you want to stop the reminder from occurring). 
7. Select how many days you want to be reminded before the event. 
8. By default, the User’s name will default to the login that was used to enter the 

program. Change this if you want the reminder to come up for another user, or you 
may select Global, which allows the reminder to come up for all users logging in. 
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Note: You must have access to Reminders, Assign Users and Reminders, Assign 
Global under User Security to be able to change this option. 

9. Enter a description of the reminder, if needed. 
10. Click Save. 

 
Deleting Reminders 
Reminders are deleted from the Main Reminders screen by clicking on the Delete icon.  

 
Editing Reminders 
There are two ways to edit reminders:  

 
Main Reminders screen 
From the main Reminders screen you can edit the following columns just by clicking in 
the field: Reminder Date, Title, Resolved and Description. 
 
Edit Reminders screen 
Clicking on Edit from the main Reminders screen will bring up the Edit Reminder 
screen. You may also double-click on the title of a reminder. The Edit Reminders screen 
allows you to change the Title, Reminder Date, User and Description.  

 
Note: If you need to change the Employee Name that this reminder is about, you’ll need 
to delete the reminder and then re-add it. 
 
Open Reminders 
Open reminders will appear for the user they are assigned unless the Global option is 
checked. If a reminder is marked with Global, then it will show for all users. You may 
view open reminders by opening the program or selecting Reminders from the feature 
list.  

 
Note: If you have security access to “Reminders, Assign Users” (See Setting Security 
Rights, Chapter 5), you may view reminders set up by other users. You may also resolve 
reminders from the Open Reminders screen. 
 
Features Description 
Topic Brief Description of Reminder.  
User The reminder is assigned to the listed person.  All users who have 

access to the program will appear on the list.  Unless Global is 
checked, the reminder will only appear for the User the reminder is 
assigned to.   

Reminder Date This is the date the message will appear on the Open Reminders 
pop-up window upon entering the Manager’s Login. 
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Features Description 
Employee 
drop-down box 

This allows you to select the employee that the reminder is in 
reference to.   

Status This will automatically show the Status of the selected employee.  
Global 
checkbox  

This allows the reminder to be seen by anyone logging in.  

Resolved 
Checkbox  

This option should be selected when the reminder does not 
need to appear any longer on the Open Reminders window.  

Sort Options  This allows you to sort the reminders by Date, Name, Topic, or 
User.  

Filters a. User – This allows you to view reminders of selected user. 
b. Display All Users – This allows you to view all reminders 
c. Show Resolved – This allows you to view only resolved 

reminders. 
d. Show Unresolved – This allows you to view only open 

reminders. 
e. Show Global Only – This allows you to view only 

reminders marked Global.  
Comments This allows you to view any comments relating to this reminder. 

 
Printing Reminders 
You may print reminders by going to Reports > Reminders.  

 
Dealing with Time Zone Differences ...................................................................... 

If you have departments in different time zones that are connected to the same Optima 
database, you can set up Optima to account for the time differences. Without this 
feature, all punch times, whether in different time zones or not, will have the time of the 
Server where the database resides.  
 
An example of using Time Difference: If the main server is in Florida, and someone 
clocks in from Utah (2 hours behind), the punch time would be recorded at Utah’s time, 
like it should.  
 
To get to Time Difference, go to Settings > Time Difference. 
 
To set up computer time differences, follow these steps: 
1. Have each computer open Optima Time Clock (and then exit) at least once before 

continuing. Each computer should be connected to the same database. They do not 
have to sign into the Manager’s Section; just open Optima Time Clock to the first 
screen with the clock.  

2. Setting the time difference should be done from the main server where the database 
resides. From Settings > Time Difference, you should see the name of each 
computer.  
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3. Enter a Difference Reason for each computer. The reason could be the department 
name, state or anything else to remind you where that computer is located. 
Computer names will not always be descriptive. 

4. Enter the time difference. Enter time zones behind you with a number to include 
the minus sign.  

5. Click Save. 
 

 
 
Any punches from the different time zones will be clocked in at their respective times. 
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Chapter 4: 
Time Clock & 
Attendance Controller 
Code Sharing 
 
 
This chapter explains code sharing between Optima Attendance Controller and Time 
Clock. This will also walk you through setting up code sharing between the two 
programs.  
 

Chapter Contents: 

Overview ......................................................................................... 54 

Setting Up Attendance Controller Code Sharing ................... 54 
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Overview ................................................................................................................ 
Optima Time Clock and Optima Attendance Controller can be fully integrated. This 
means that absence codes (paid time off) entered in Attendance Controller are also 
automatically entered into Time Clock, such as Vacation.  
 
Example: Linda takes a vacation day; her supervisor enters this time as a Vacation 
(Reason Code) in Optima Time Clock so that she is paid for that day. With Optima 
integration set up, this time will also show on the calendar in Attendance Controller as a 
V – Paid Vacation day. 
 

Setting Up Attendance Controller Code Sharing ..................................................... 
In order to set up Optima Time Clock and Optima Attendance Controller Code Sharing 
the following steps will need to be completed in the order listed:  
1. Enable Attendance Controller Code Sharing 
2. Set up Reason Codes 
3. Set up Payroll Code Descriptions 
4. Set up Related Attendance Controller Absence Codes 
 
Enable Attendance Controller Code Sharing  
The first step is to enable (turn on) the Attendance Controller integration. You would do 
this from Settings > Global Preferences > Time Clock Tab.  
 
1. Under Attendance Controller Code Sharing on the Time Clock Tab, click 

Enable Code Sharing. 
2. You may also select Enable Hours Worked Transactions Relation if you are 

going to enter Hours Worked (W Code) on the calendar in Attendance Controller. 
With this option selected, when a W Code is entered on the calendar screen the time 
will also be automatically entered in Time Clock.  
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Attendance Controller 
Code Sharing 

 
Set Up Reason Codes (See Setting Up Reasons Codes in 
Chapter 3 for detailed information) 
After turning on the Attendance Controller Code Sharing, the next step is to set up 
Reason Codes. You may already have Reason Codes set up; if so, go to the next step of 
setting up payroll code descriptions. Reason Codes allow you to select specific reasons 
when entering a manual time entry. Some examples of Reason Codes are: Vacation, Sick, 
Personal, Computer Down, Corrected Time Entry, etc.  
 
Example: Using the example above where Linda takes a vacation day, when the 
supervisor enters a manual entry in Time Clock to record the time off, the time is 
entered as 8 hours and the reason code is Vacation.  

 
Feature Description 
Reason Codes Reason Codes are required reasons when 

changing a punch entry or entering a manual entry.  
Payroll Codes Payroll Codes are descriptions that will show on 

reports and are related to Reason Codes and 
Absence Codes. 

Related Attendance 
Controller Absence Codes 

Related Absence Codes will allow absences that 
are entered on the Calendar screen to also be 
reported in Time Clock.  
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To set up Reason Codes, go to Settings > Reason Codes. 
 
When entering a manual time entry, whether correcting an entry, or entering time for 
someone out on vacation, requires a reason. The three types of reasons are: Punch 
Changes (making a change to a punch time entry), Manual time entries (entering a time 
entry for 8 hours Vacation, etc.), and Deleted time entries.  
 
The Reason Code window can be broken down into 3 parts: Reason Code, Payroll 
Code Description, and Related Attendance Controller Absence Code.  
 

 

Reason Codes  
Screen 

Payroll Code 
Description 

Related 
Attendance 
Controller 

Reason Codes 

 
Set Up Payroll Code Descriptions and Numbers 
(See Chapter 4 – Set Up Payroll Code Descriptions for detailed information.) 
A Payroll Code Description is related to a Reason Code and Absence Code.  The Payroll 
Code is the description that will show up on reports (such as the Time Card Runs 
report).  
 
Example: A Reason Code of Vacation is set up. When someone takes a vacation day, a 
manual entry (from the Time Clock Entries screen) is created and given the Reason of 
Vacation. A Payroll Code Description of Paid Vacation is set up relating it to the 
Reason Code (Vacation). When a time card report is run it will show the Payroll Code 
Description of Paid Vacation (the Payroll Code is what will appear on reports). When 
that manual entry with the Vacation Reason Code is created, it will also create an entry 
on the Calendar in Optima Attendance Controller under the V- Paid Vacation absence 
code.   
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Set Up Payroll Description Columns for Reports 
When running a report, such as the Time Card Runs report, only two payroll 
descriptions will show, along with Regular Hours and Overtime hours, due to space 
constraints. If there are any other payroll code descriptions, they will show up in the 
Other Column. The Time Card Runs (Extended) report will show all payroll descriptions 
in a column format.  
 
After setting up the Payroll Code Descriptions, you’ll be able to set up which two payroll 
codes you’ll want to see, in addition to Regular Hours and Overtime Hours; time for all 
other payroll codes will be combined into the Other Column.   
 
To set up the two Payroll Description Columns, follow these steps: 
1. Go to Settings > Global Preferences > Time Clock Tab. Payroll Description 

Columns for Reports, locate First Column and Second Column. 
2. Click on the drop-down arrow for First Column and select which payroll code 

you’ll like to show up on the Time Card Runs report.  
3. Then click on the drop-down arrow for Second Column and select another payroll 

code. 
4. Click Save. 
5. Close all the way out of the program and open it back up to refresh the data.  
 
Set Up Attendance Controller Absence Codes 
Once the Attendance Controller Integration is enabled, you’ll be able to relate Reason 
Codes in Time Clock to Absence Codes in Attendance Controller.  When you enter an 
Absence Code onto the Calendar that is related to a Reason Code, this will create an 
entry in Time Clock.  
 
Example: We have a Reason Code of Vacation = Payroll Code Description of Paid 
Vacation = Related Attendance Controller Absence Code of V – Paid Vacation; 
when entering a V Code on the Calendar of 8 hours, this time will automatically be 
entered in Time Clock as 8 hours of Vacation (Reason Code). And this time will be 
shown on the Time Card Run report as 8 hours of Paid Vacation (Payroll Code 
Description). 
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With code sharing set up, this is how it will work: 
 
From the Calendar screen, we enter a V – Paid Vacation day (Related Absence Code)  
on June 5, 2002. 

 

Related 
Absence Codes 
set up under 
Settings > 
Reason 
Codes. 

 
From the Time Clock Entries screen, we can see it reports the 7 hours as Paid Vacation 
(Payroll Code Description).   
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If we double-click on the Changed By Date at the bottom of the Time Clock Entries 
screen, we can see Vacation as the Reason for Change (Reason Code). 

 
 
And we can see that it shows our columns of Paid Vacation (First Column) and Paid 
Personal (Second Column) with 16 hours Paid Vacation showing for Neil Adams.  

 
 
And it will work the opposite way if we enter a manual entry in Time Clock, it will 
display in Attendance Controller.  
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Chapter 5: 
Setting Security Rights 
 
 
Due to the confidential nature of information stored in Optima Time Clock, security is 
always turned on.  This will help prevent unauthorized persons from accessing critical 
employee data.  The use of security is required, and setting up access to Time Clock and 
any other G.Neil programs you have should be the second thing you do.  The first thing 
you should do is set up Locations and Departments.   
 
You may set up access for managers to view only their departments and/or view specific 
employees from other departments.  You may also set up employees to have read-only 
access to their records.  
 
Managers Access (User) Vs. Employee Access 
There are two main levels of security to Optima Time Clock: Employee Level and 
Manager (or Administrator Level). An employee can be given access to clock in/out and 
even to create, edit, or delete his or her own time entries. Access for employees are given 
from Time Clock Access. Managers, Supervisors or Administrative Assistants are given 
user access through User Security. This allows managers to be given access to select 
features within the Time Clock management screens.  
 

 
Chapter Contents:  

 
Program Access .............................................................................. 62 

User Security .................................................................................. 62 

Setting Up a User for Security Access ....................................... 64 
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Program Access ......................................................................................................  
Go to Settings > User Security. 
 
The program is set up with a default Login of: Admin and Password of: Admin.  We 
strongly recommend changing the password for the Admin Login and set up other logins 
as necessary.  
 
Setting up security access is necessary to allow other managers or supervisors access to 
the program.  It is recommended that you do not give out the Login and Password to the 
Admin login but instead set up other user logins to access only those features that they 
will need.  The Detail screen is the first screen that comes up when going into User 
Security.  You’ll need to set up access to the common Optima features (Detail Tab), the 
specific program features and locations and departments.   
 

User Security .......................................................................................................... 
User Security for the Detail Tab  
The Detail Tab has features that are common to the Optima programs. Common 
Features refer to features that are shared among Optima Attendance Controller, 
Confidential Employee Record and Time Clock. For example, the Detail Tab and 
Locations/Departments are common to all three programs.  Even if you only have one 
of the listed programs you will need to follow these instructions to set up user access 
rights.  
 
Search For This allows searches by User Name. 
Save As This allows you to create new user log ins based on 

access rights of another user.  
 

 

User Security 
Screen 
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The User Security window has the following features: 
Feature* Description 

Employee Record 
Access  

This allows access to view, add or delete employee 
records.  

Detail This allows access to the Detail Tab on the main 
screen.  

View SSN  This allows access to view Social Security Numbers.  
Run Reports  This allows access to run reports.  
Reminders This allows access to add and delete reminders.  
Reminders, Assign 
Global  

This allows access to assign reminders as Global.  

Reminders, Assign 
Users  

This allows access to assign reminders to other users.  

User Security  This allows access to add, edit, and delete users and 
user access.  

Location/Department 
Maint  

This allows access to assign location/department 
access for users.  

Global Preferences  This allows access to edit global preferences.  
Database Monitor  This allows access to the DB Monitor.  
Database Backup  This allows access to Backup from the DB Monitor.  
Database Restore  This allows access to Restore from the DB Monitor.  
Alter Product License  This allows access to change the Product License.  
Conversion This allows access to run the Conversion Utility.  
Custom Reports  This allows access to create/edit customized reports.  
Import This allows access to import data. 
Export This allows access to export data.  
Guest Users  This allows access to set up Guest Users to manipulate 

the data from another program, such as Crystal 
Reports.  

* The above features are shared between Optima Attendance Controller, Confidential 
Employee Record and Time Clock. This means that the Detail screen under User 
Security is the same screen in all three programs.  
 
Time Clock Tab   
Feature  Description 

Time Clock Entries  This allows access to the Time Clock Entries screen. 
Time Clock Access  This allows access to the Time Clock Access screen. 
Work Schedules  This allows access to the Work Schedules screen. (See 

Settings > Work Schedules.) 
Time Card Runs  This allows access to the Time Card Runs screen.  
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Feature  Description 

Time Clock Settings  This allows access to the Time Clock Settings screen. 
Messages This allows access to the Time Clock Messages screen.  
Time Codes  This allows access to the Time Codes screen.  
In/Out Board  This allows access to the In/Out Board. 
Export Data  This allows access to Export Data from the reports.   

 

 

User Security – 
Time Clock Screen 

 
Setting Up a User for Security Access ..................................................................... 

When setting up a new user, you’ll need to make sure you set access rights under the 
User Security Detail Tab, Location/Department Tab and the appropriate program tab.  
 
Setting up access to common features (Detail tab).  
1. Click New from User Security > Detail screen.  
2. Enter Log In and Password (letters and numbers only) and user’s Full Name.  
3. Select options for Displaying Reminder Alarms and Hints for this login.  
4. Select Yes to allow the user to begin logging in after giving access.  Setting this 

option to NO is a good security measure when users are out of the office for a 
number of days.   

5. Select what type of Feature Access users will have by clicking in the Feature Access 
Rights block.   

6. Clicking on the arrow will allow you to select from the following:  
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NO ACCESS – No access to selected feature 
READ ONLY – This allows user to view only, he or she cannot make any changes 
READ WRITE – This allows user to view, add, and edit; no deleting allowed 
READ WRITE DELETE – This allows user full editing rights  
YES – This allows access  
NO – No access to feature 

7.     Click Save.  
 
User Security Access for Locations/Departments   
To set up access rights to Locations/Departments, follow these steps: 
1. Select or create a Login following the steps under Setting Up Access Rights. 
2. Click on Locations/Departments (Your Locations and Departments should already 

be set up at this point. If not, then please see Locations & Departments on setting 
them up before going any further). 

3. If you want to give this Login full access to all locations, click in the box next to 
Locations/Departments so that the box is checked. This will allow a user with this 
Login to see all employees in all Locations and Departments. 

4. If you want to give this Login access to only specific Locations, Departments or 
even down to employee level access, click on the + sign next to 
Locations/Departments to expand the view. 

5. Click on the + sign next to the location and then on the + sign next to the 
department name. From here you may select specific employee’s or click on the 
department name to choose all of the employees under that department. 

6. Click Save.  
 
You may click on a + sign at any time to collapse the view. 
 
User Security for the Attendance Controller Tab   
The Attendance Controller Tab will only be shown if Optima Attendance Controller is 
installed. Please see the Optima Attendance Controller manual’s User Security section 
for more information. 
 
User Security for the Confidential Employee Record tab   
The Confidential Employee Record Tab will only be shown if Optima Confidential 
Employee Record is installed. Please see the Optima Confidential Employee Record 
manual’s User Security section for more information. 
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User Security for the Locations/Departments Tab   
You should have already created your Location and Department names (see Locations 
and Departments).  Now you will want to set up users’ access to the Locations and 
Departments by following these steps:  
1. Click on Location/Department Tab from Settings, User Security, Detail.   
2. Click on the “+” (plus sign) next to Locations/Departments and next to the 

location and department name to expand the list.   
3. Click in the box next to the location and department name to select access to these 

areas.  This will put a checkmark in the box.  Click in the box again to unselect an 
area.   

4. If you have already entered your employees in the program and assigned location 
and departments to them, when you expand a department, you will see all the 
employees assigned to that location/department combination.  You may then select 
access to individual employees at this point by clicking in the box next to the 
employee.   

NOTE: If you haven’t entered your employees (see Employee Detail) into the program, 
you will still be able to assign access to a location/department combination, but not 
down to the employee level.  You may later assign access down to the employee level 
after you enter your employees and assign a location/department to them.   
5.   Click Save.  
 
Once you have followed the above steps, the user can log in with their login and 
password with their assigned access rights.  
 
Tip: You may click Save As from the User Security screen if you already have a user 
with access rights you want to copy and give to another user. The selected user must be 
highlighted first. 
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Chapter 6: 
Clocking In/Out 
 
 
There are two ways to clock in and out of Optima Time Clock, and both are described 
below. You can use a keyboard or a magnetic swipe card using a card reader. Optima 
Time Clock may be installed on one or two central computers or on all of your 
employees’ computers so they may clock in/out from their desk.  
 
Note: Employees use the Optima Time Station to clock in/out while managers and 
supervisors use the Optima Time Clock Admin portion of the program to manage 
employee time.  
 

Chapter Contents: 

Overview ......................................................................................... 68 

Clocking In Using the Keyboard ................................................ 68 

Clocking In Using a Swipe Card and Reader ........................... 69 

My Time Clock ............................................................................... 69 
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Overview ................................................................................................................ 
We have made clocking in/out as easy as possible. Employees clock in and out from the 
Optima Time Station application. Employees may clock in using the keyboard or using a 
magnetic stripe card (swipe card) and card reader.  
 
Using a swipe card and card reader allows for faster clocking in/out, but may not always 
be cost effective. You may install Optima Time Station on your employee’s computers 
and allow them to clock in/out from their desks. (See the Software License Agreement at 
the front of the manual.) 
 

 

Time Station 
Clock In/Out Screen 

 
Clocking In Using the Keyboard ............................................................................. 

Before being able to clock in and out, an employee must have Time Clock access. (See 
Assigning Time Clock Access in Chapter 3.) To clock in using the keyboard, employees 
would enter their logins and passwords and click on Clock In (F5) or Clock Out (F8).  
 
Employees that are given time clock access also have access to the My Time Clock 
feature. My Time Clock allows employees to see their own time cards. If given the 
proper rights, employees may also create, edit and delete their own time entries within 
My Time Clock.  
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Clocking In Using Swipe Card and Card Reader ..................................................... 
If you have a magnetic stripe card reader and cards, purchased separately, it will log 
employees in/out and allow them to get into My Time Clock without having to enter a 
login and password. (See page 11 for specifications on card and card reader.) As an 
added security feature, you may require that an employee enter a password, even while 
using a swipe card. This may cut down on an employee clocking in/out for another 
employee. 

 
My Time Clock ....................................................................................................... 

My Time Clock allows employees to view their time card history, and, if given rights, can 
create, edit and delete their time card entries. An employee can log into My Time Clock 
by clicking on the My Time Clock button, or pressing the F9 key). The password for 
My Time Clock is the same one used when clocking in/out. (See Time Clock Access 
for setting up employee’s login and password.)  
 
Tip: Employees may log into My Time Clock using their swipe card at the My Time 
Clock login screen. 
 

My Time Clock  - 
Edit Screen 

 

Date Range 

Time Entries 
Sort Order 

Asterisk (*) 
shows double 
entries of IN 
or OUT 
Punches 

Plus (+) sign 
denotes c
has been ma

hange 
de 

Show Changes 
made to time 
entries 

Toolbar 

Punch Entries – 
Must have an IN 
and OUT Punch 
for total hours 

 
Employee Review/Edit toolbar 
If given the proper rights, an employee may have access to New, Edit, and Delete. This 
will allow them to manage their own time cards. All changes and deletions are tracked  
and managers may run reports against these changes.  
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 Shows Help File for 
this screen.  

 

 

Exits My Time 
Clock. 

Deletes currently 
selected entry. 

Creates a new 
time entry. 

Prints Time Card for 
selected Date Range. 

Edits existing 
time entry. 

Changes Employee 
Password. 

 
 
 
Creating a New Time Entry 
You must be given rights to this feature. Clicking New, from the Time Clock Entries 
screen, will give you the New Entry window with the following options:  
 

 
 
After clicking on New, you’ll be given the choice of Clock In / Clock Out or Enter 
Hours.   
 
Selecting Clock In/Clock Out will allow you to enter a manual punch entry just as if an 
employee had clocked in or out. For example, you may enter a manual punch entry of 
05:15 PM for a specific date.  
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Feature Description 

Reason for Change A Reason is required for Creating a Manual Time Clock 
Entry or Entering Hours for a Date. (See Settings > 
Reason Codes in Administration screen.) 

Date This is the date of the punch entry. 
Punched This designates In or Out of the punch. 
Time This is the time of the punch entry. 
Work Date This is the Work Date that the punch refers to. (See Date 

Vs Work Date below for more info.) 
Comments Comments are not required but may be helpful when 

reading a reason at a later date. 
 
Selecting Enter Hours will allow you to give a set amount of hours for a given date. For 
example, you may enter a manual time entry of 8 hours Vacation.  
 

 
 
Feature Description 

Reason for Change A Reason is required for Creating a Manual Time Clock 
Entry or Entering Hours for a Date. (See Settings > 
Reason Codes in Administration screen.) 
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Feature Description 

Date This is the date the employee will get credit for.  
Work Date This is the Work Date that the punch refers to. (See 

Date Vs Work Date below for more info.) 
Hours   This allows you to enter specific hours for a date, such 

as 8 hours for a Vacation day. The Date, Hours and 
Reason for New Entry fields are required. 

Count towards 
overtime calculations 

Designates entry to count towards overtime. 

Comments Comments are not required but may be helpful when 
reading a reason at a later date. 

 
Date Versus Work Date 
When creating a new time entry, there are two date fields: Date and Work Date. The 
Work Date represents the date the entry is counted towards. Normally, you won’t need 
to change the Work Date unless you have work shifts that cross over midnight. For 
example, Josh starts work and clocks in at 8 PM on Monday night. He gets off work at 4 
AM on Tuesday morning, but forgets to clock out.  A manual time entry is created for 
him punching him out at 4 AM; the Work Date is of the previous date (the actual date 
Josh started work). The program knew that Josh had clocked in at 8 PM the previous day 
and since he had not gone over 13 hours between punches it counted the OUT punch to 
the previous date. 
 
Editing a Time Entry  
Edit allows you to change an existing entry. You must be given rights to have this 
feature. Remember that the Reason for Change block is required and tracked.  Editing 
a time entry is similar to creating a new entry except you only have the choice to change 
a punch time entry. 
 
Deleting a Time Entry 
Delete will erase the selected time entry and record the deletion. All changes and 
deletions are recorded and tracked. To view deleted time entries, go to Reports > 
Deleted Time Clock Entries.  
 
Printing an Employee Time Card 
Print allows you to print an employee time card for the selected date range.  
 
Getting Help 
Help allows you to bring up the help file for this screen. 
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Time Card Entries 
The time card entries have the following coding: 
Feature Description 

Blue band  A blue band designates the selected entry. 
White band  A white band designates an IN punch. 
Teal band (bluish green) A teal band designates an OUT punch. 
Gray band  A gray band designates a manual entry was given for 

a set amount of hours (see Enter Hours for a Date 
under New above). For example, Josh took 8 hours 
of Vacation on 3/15/2002 and a manual entry was 
entered for his time.  

Plus (+) Sign  A plus (+) sign designates a punch was changed or 
manual entry was entered. 

Asterisk (*)  An asterisk (*) designates that there is a double-
punch; either two IN punches or two OUT punches 
together. Action should be taken on this type of 
entry of either adding a new entry or correcting an 
existing entry. Hours cannot be calculated for a 
double-punch entry.  

 
CAUTION: If you see an asterisk (*) next to a time entry this means that some type of 
action should be taken, such as correcting a punch.  
 

 

Time Card Entries 

Asterisks (*) 
denote double 
entries Plus sign (+) 

denotes manual 
entry was made 

 
Tip: Right-clicking on an entry will show you the rounding rules (Work Schedule Rules) 
for that entry. 
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IN/OUT BOARD .................................................................................................... 
The In/Out Board allows you to see, at a glance, employees who are in and out. The 
In/Out Board will refresh itself if the Auto Update feature is checked, otherwise, clicking 
the Refresh button will update the board.  
 

In/Out Board Screen 

 

In/Out Board 
Toolbar 

Who’s In, 
Who’s Out 

Status Bar 

 
Feature Description 

Auto update every __ 
minute(s)  

This allows you to set how often this board should 
update for you. Note: This is not a “live” board and 
will only be updated by the Auto Update or pressing 
Refresh. 

In/Out Employees  This allows you to see employees who are In or Out 
at a glance. 

Refresh Clicking this button will refresh the list. 
Help This gives you help regarding the current screen. 
Color-coding: a. Green – denotes employees who are clocked IN. 

b. Teal (bluish-green) – denotes employees who are 
clocked OUT.  

 
Administrators can have access to view all locations and departments or only specific 
locations and departments depending on their security access rights. Employees may be 
given access to all locations and departments or their specific location and/or 
department or no access to the In/Out Board. (See In/Out Board Access under Time 
Clock Access. 
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Chapter 7: 
Managing Employee 
Records 
 
This chapter covers using Optima Time Clock for day-to-day operations.   
 
 

Chapter Contents:  
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In/Out Board .................................................................................. 81 
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Deleting an Employee .................................................................. 83 

Giving Employees Access to Clock In ....................................... 83 

Employees Not Rounding On the Correct Work Schedule .. 85 
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Overview ................................................................................................................ 
There are two main levels of security to Optima Time Clock: Employee Level and 
Manager (or Administrator Level).  
 
Employee Level Access – This only allows access to Clock In/Out and access to the 
My Time Clock feature, which will allow individuals access to their time card histories. 
This also will allow them to create new time entries, edit existing entries, and/or delete 
their existing entries. Access to the In/Out Board may also be given. (See Chapter 3 - 
Employee’s Time Clock Access for setting up access rights on page 45.) Setting up 
employee level access consists of setting up access on the Time Clock Access screen 
 
Manager Level Access – This will allow managers access to selected employee time 
card entries. They may create, edit, and delete entries for these employees. They’ll also 
have access to the In/Out Board. Managers at least may have access to everything or 
only a few Administration screens. Having one Manager Login that has access to 
everything is required. You may create other Manager Logins that have partial access to 
the Administration screens they need. For example, a payroll administrator may only 
need access to View/Edit Employee’s Time Card Entries, Create & Edit Work Schedules 
and to Time Card Runs. The other screens would be set for No Access. (See User 
Security.) 
 

Feature Column ...................................................................................................... 
The Feature Column allow you to navigate from screen to screen.  

 
Feature Description 

Employee Detail  This screen allows you to enter and edit employee 
data. 

In/Out Board  The In/Out Board allows you to see, at a glance, 
employees who are in and out.  

Reminders  
Reports  
 
Time Clock Entries  

This allows you to view, create, edit and delete time 
card entries. If you have access to view and edit 
entries, you have access to all records. 

Time Clock Access  This allows you to set employee logins and 
passwords, work Schedules, and access to the 
In/Out board. 

Time Card Runs  This allows you to run time card reports and lock 
down time cards so that no other editing can be 
done. 
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Time Clock Entries .................................................................................................. 
The Time Clock Entries feature allows you to maintain employee time entries. You may 
create new entries, as well as edit or delete time entries. You may also print out employee 
time cards from here.  
 
All changes (edits or deletions) are recorded and tracked. Selecting Show Changes will 
allow you to view entries that have been edited. A plus sign (+) to the right-side of an 
entry denotes a entry has been modified.    
 

 

Time Clock 
Entries Feature 

Date Range 

Time Entries Sort 
Order 

 
Tip: Double-clicking on an entry in the changed window (at the bottom) will bring up 
details of the entry. 
 
Time Clock Entries Toolbar 
From the Time Clock Entries screen Managers have access rights to create, edit, or 
delete employee time entries.    
 
 
 

Creates a new 
time entry 

Deletes currently 
selected entry 

Shows Help File for 
this screen 

Plus (+) sign 
denotes change 
has been made 

Show Changes 
made to time 
entries 

Asterisk (*) 
shows double 
entries of IN or 
OUT Punches 

Time Entries – 
Must have an IN 
and OUT Punch 
for total hours 

 

Edits existing 
time entry 

 
Prints Time Card for 
selected Date Range 
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Creating a New Time Entry 
You must be given rights to this feature. Clicking New, from the Time Clock Entries 
feature, will give you the New Entry window with the following options:  
 

 
 
After clicking on New from the Time Clock Entries screen, you’ll be given the choice of 
Clock In / Clock Out or Enter Hours.   
 
Selecting Clock In/Clock Out will allow you to enter a manual punch entry just as if an 
employee had clocked in or out. For example, you may enter a manual punch entry of 
05:15 PM for a specific date.  
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Feature Description 

Reason for Change A Reason is required for Creating a Manual Time Clock 
Entry or Entering Hours for a Date. (See Settings > 
Reason Codes in Administration screen.) 

Date This is the date of the punch entry. 
Punched This designates In or Out of the punch. 
Time This is the time of the punch entry. 
Work Date This is the Work Date that the punch refers to. (See Date 

Vs Work Date below for more info.) 
Comments Comments are not required but may be helpful when 

reading a reason at a later date. 
 
Selecting Enter Hours will allow you to give a set amount of hours for a given date. For 
example, you may enter a manual time entry of 8 hours Vacation.  
 

 

Reason Code – 
Required when 
manually entering an 
entry 

Enter how many hours 
employee is getting 
credit for 

 
Feature Description 

Reason for Change A Reason is required for Creating a Manual Time Clock 
Entry or Entering Hours for a Date. (See Settings > 
Reason Codes in Administration screen.) 
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Feature Description 

Date This is the date the employee will get credit for.  
Work Date This is the Work Date that the punch refers to. (See 

Date Vs Work Date below for more info.) 
Hours   This allows you to enter specific hours for a date, such 

as 8 hours for a Vacation day. The Date, Hours and 
Reason for New Entry fields are required. 

Count towards 
overtime calculations 

Designates entry to count towards overtime. 

Comments Comments are not required but may be helpful when 
reading a reason at a later date. 

 
Date Versus Work Date 
When creating a new time entry, there are two date fields: Date and Work Date. The 
Work Date represents the date the entry is counted towards. Normally, you won’t need 
to change the Work Date unless you have work shifts that cross over midnight. For 
example, Josh starts work and clocks in at 8 PM on Monday night. He gets off work at 4 
AM on Tuesday morning, but forgets to clock out.  A manual time entry is created for 
him punching him out at 4 AM; the Work Date is of the previous date (the actual date 
Josh started work). The program knew that Josh had clocked in at 8 PM the previous day 
and since he had not gone over 13 hours between punches it counted the OUT punch to 
the previous date. 
 
Editing a Time Entry  
Edit allows you to change an existing entry. You must be given rights to have this 
feature. Remember that the Reason for Change block is required and tracked.  Editing 
a time entry is similar to creating a new entry except you only have the choice to change 
a punch time entry. 
 
Deleting a Time Entry 
Delete will erase the selected time entry and record the deletion. All changes and 
deletions are recorded and tracked. To view deleted time entries, go to Reports > 
Deleted Time Clock Entries.  
 
Printing an Employee Time Card 
Print allows you to print an employee time card for the selected date range.  
 
Getting Help 
Help allows you to bring up the help file for this screen. 
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Time Card Entries 
The time card entries have the following coding: 
Feature Description 

Blue band  A blue band designates the selected entry. 
White band  A white band designates an IN punch. 
Teal band (bluish green) A teal band designates an OUT punch. 
Gray band  A gray band designates a manual entry was given for 

a set amount of hours (see Enter Hours for a Date 
under New above). For example, Josh took 8 hours 
of Vacation on 3/15/2002 and a manual entry was 
entered for his time.  

Plus (+) Sign  A plus (+) sign designates a punch was changed or 
manual entry was entered. 

Asterisk (*)  An asterisk (*) designates that there is a double-
punch; either two IN punches or two OUT punches 
together. Action should be taken on this type of 
entry of either adding a new entry or correcting an 
existing entry. Hours cannot be calculated for a 
double-punch entry.  

 
CAUTION: If you see an asterisk (*) next to a time entry this means that some type of 
action should be taken, such as correcting a punch.  
 

 

Time Card Entries 

Asterisks (*) 
denote double 
entries Plus sign (+) 

denotes manual 
entry was made 

 
Tip: Right-clicking on an entry will show you the rounding rules (Work Schedule Rules) 
for that entry. 
 

IN/OUT BOARD .................................................................................................... 
The In/Out Board allows you to see, at a glance, employees who are in and out. The 
In/Out Board will refresh itself if the Auto Update feature is checked, otherwise, clicking 
the Refresh button will update the board.  
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In/Out Board Screen 

In/Out Board 
Toolbar 

Who’s In, 
Who’s Out 

Status Bar  
 
Feature Description 

Auto update every __ 
minute(s)  

This allows you to set how often this board should 
update for you. Note: This is not a “live” board and 
will only be updated by the Auto Update or pressing 
Refresh. 

Feature Description 

In/Out Employees  This allows you to see employees who are In or Out 
at a glance. 

Refresh Clicking this button will refresh the list. 
Help This gives you help regarding the current screen. 
Color-coding: c. Green – denotes employees who are clocked IN. 

d. Teal (bluish-green) – denotes employees who are 
clocked OUT.  

 
Administrators can have access to view all locations and departments or only specific 
locations and departments depending on their security access rights. Employees may be 
given access to all locations and departments or their specific location and/or 
department or no access to the In/Out Board. (See In/Out Board Access under Time 
Clock Access.) 
 

Adding a New Employee ........................................................................................ 
Click Employee Detail Feature column. 
 
The Employee Detail screen allows you to add, edit, and delete employees, and, if 
installed, shares common screens with Attendance Controller (Category Assignments) 
and Confidential Employee Record (EEO and Personal Contacts).  
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To add a new employee, follow these steps: 

1. Click  from the Employee Browse or Employee Detail screen. 
As a minimum, enter First Name, Last Name, Hire Date, Employment Status, Work 

ocation and Department. These fields are required. (To set up lo
2. 

cations 
ents, see Locations and Departments under Administration.)  

. Click Save.  

Status, and L
and departm

3
 
NOTE:  The SSN is not required when entering an employee in Optima. However, 
when exporting time card entries, if one of the selected payroll formats requires the SSN, 
you will need to enter it before exporting. 
 
 

Deleting an Employee ............................................................................................. 
 
CAUTION: This will delete ALL information on the current employee including any 
records in Optima Attendance Controller and Optima Confidential Employee Record. 
 
To delete an employee, and all associated records, follow these steps: 
1. From Employee Detail, select an employee 
2. Select File > Delete Employee. 

by clicking on his or her name. 

. Click Yes to the “Are You Sure?” message.  

Giving Employee ....................................... 
 Time Clock Access

 administrator will 
always have access to the In/Out Board screen.  

3
 
s Access to Clock In ..............................
Click  from the Feature Column. 
 
The Time Clock Access screen allows you to set up employee logins/passwords, swipe 
card access, individual access to create, edit and delete their time card entries, assign 
Work Schedules, and employee In/Out Board access. A manager or
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Time Clock Access Feature 

 
Feature  Description 

Employee, Location, 
Department  

This is shown to make it easier when assigning 
access. 

Search By  This allows you to search by Last Name, First 
Name, SSN or ID. 

Search For  Entering one character at a time will do an 
incremental search. For example, entering the 
letter “K” will bring up the names which start 
with K. Adding an L will search out names with 
KL and so on.   

Time Clock 
Identification (Changing 
Employee Password) 

Time Clock Identification allows you to change 
the selected employee’s Login and Password. Just 
enter the new Login and password and click on 
Save to change. 

Swipe Card ID  For the Swipe Card ID option, you’ll need a 
magnetic swipe card or bar code reader and pre-
encoded cards. To assign a pre-encoded swipe 
card, click on Update/Change, then swipe the 
card through the swipe card reader. If an 
employee has an assigned swipe card ID number, 
you will also have the option to Clear/Delete.  

Time Clock Access  
 
 

Time Clock Access assigns employee options for: 
a. Enable Employee Time Clock Access – 

This allows the selected employee to clock in 
and out. This is required to be selected if the 
employee is allowed to clock in/out.  
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Feature  Description 

Time Clock Access 
(cont.) 

b. Can create their own Time Clock Entries 
– gives employee the ability to create Time 
Clock entries. 

c. Can Edit their own Time Clock Entries – 
gives employee the ability to edit Time Clock 
entries. 

d. Can Delete their own Time Clock Entries – 
gives employee the ability to delete existing 
entries. 

Current Work Schedule 
Note: To create a Work 
Schedule, see Chapter 8 
- Creating and Editing 
Work Schedules. 

Current Work Schedule allows you to assign a 
Work Schedule for rounding and reporting 
purposes.  
a. Clear allows you to remove this work 

schedule from an employee.  
b. History allows you to view changes to an 

employees work schedule. This also allows 
you to edit the Start Date.  

In/Out Board Access  In/Out Board Access allows you to assign an 
employee access to see None, All employees, or 
employees by Location or department. (See 
In/Out Board on page 81.) 

 
Employees Not Rounding on the Correct Work Schedule .......................................  

Employees may be assigned different rounding rules over the course of their 
employment. Every time an employee is given a new work schedule, he or she gets a new 
Start Date from which the current work schedule begins. A new work schedule will only 
round from the Start Date going forward. Any punches before this date will not be 
rounded on this schedule.  
 
There are times when you may need to change the start date for rounding calculations. 
For example, if an employee was accidentally assigned the wrong work schedule for a 
week where the work schedule assigned was rounding him/her at 10-minutes instead of 
at 6-minutes, you would want to change to the new work schedule and have the program 
calculate all past punch entries.  
 
The work schedule start date is edited through the History Tab on the Time Clock 
Access screen.  For example, if the start date is 11/5/01, rounding will only occur from 
this date forward. Any punches before this date will not be rounded on this schedule.  
 
CAUTION: Editing the Work Schedule date may affect punches for the current 
employee that have already been paid for.   
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Changing an Employee’s Work Schedule Date 
Changing an employee’s work schedule date and having the program re-calculate 
according to the new work schedule is a two-step process: 
 
First Step (Change the Work Schedule Start Date) 
1. From Time Clock Access, click on History (Current Work Schedule). 
2. On the Work Schedule History screen, double-click on the Start Date you want to 

change. For example, if you want to change the Start Date of 04/18/2002 to 
05/01/2002, double clicking directly on the 04/18/2002 date will bring up an edit 
box. 

3. Enter the Start Date of the new work schedule. 
4. Leave the Ending Date blank if this is the most current Start Date.  
5. Click Save. 
6. If you need to have time punches recalculated according to the new work schedule, 

go to the Second Step below; otherwise, punches may not have their time calculated 
correctly. 

 
Second Step (Recalculate the Punch Time Entries)  
You’ll need to edit any punch time entries that need to be recalculated and click Save. 
The act of clicking the Save button will recalculate the selected punch time entry 
according to the new work schedule.   
1. From Time Clock Entries, select the employee and the punch time you wish to re-

calculate.  
2. You may select the punch time entry either by double clicking on the punch entry or 

by highlighting it (by clicking once on the entry) and selecting the Edit icon.  
3. Do not change the date or time. Select a Reason for Change. (You cannot save an 

entry without selecting a reason.) 
4. Click Save.  
5. Repeat the above steps for any punches that need to be re-calculated.  
 
Clicking Save will re-calculate the punch time entry according to the work schedule. For 
example, if you changed this employee’s work schedule from 10-minute rounding to 6-
minute rounding, then saved any punch entries that fell within the Start Date, their 
punch entries would be recalculated. 
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Double clicking on a 
Start Date will allow 
you to edit the date. 

Work 
Schedule 
History 
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Chapter 8: 
Creating and Editing 
Work Schedules 
 
 
This chapter will allow you to set up your work schedule rules and define your daily work 
hours for reporting purposes. 
 
As a rule, many businesses allow a grace period for employees when clocking in or out. 
This allows for time variations on clocks, watches and time devices throughout a 
company. Rounding time also makes calculating payable time easier.  
 

Chapter Contents: 

Rounding Explained....................................................................... 90 

Work Schedule Rounding Rules ................................................. 90 

Shifts Crossing Midnight ............................................................. 93 

More About Rounding ................................................................. 94 

Setting Up a Work Schedule ....................................................... 94 

Setting Up the Daily Schedule .................................................... 95 
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Rounding Explained ................................................................................................  
Optima Time Clock can automatically round off in 2, 3, 4, 5, 6, 10, 12, 15, 20, 30 and 60-
minute time slices, and it will calculate the time in decimals, unlike many mechanical 
Time Clocks. This saves time by not having to convert the minutes to decimals. Note: If 
you don’t round, then select the Generic – No Rounding rule. 
 
Time Clock rules can be assigned to individuals or groups. Rules are usually defined for 
punching IN early or late, and OUT early or late. 
 
EXAMPLE 
Here is an example of rounding using the 15-minute rule: 
 
Richard comes in a few minutes early and clocks in at 07:55. 
Tanya is running late and clocks in at 08:04. 
 
Using the 15-minute rule, both Richard and Tanya’s payable time would be clocked in at 
08:00. Their time was rounded to the nearest 15-minute mark. The next 15-minute mark 
would be 08:15, then 08:30, and so on.  
 
However, using the 6-minute rule and the above clock-in times, Richard’s payable time 
would be clocked in at 07:54. The next 6-minute mark for Richard would be 08:00. 
Tanya’s payable time would be clocked in at 08:06. The next 6-minute mark would be 
08:12, 08:18, and so on. Their time was rounded to the nearest 6-minute mark. 
 
Optima Time Clock comes with three commonly used rounding rules: 6-minute, 10- 
minute and 15-minute generic rules that are set up to round to the nearest mark. You 
may choose one of these and rename it or set up your own.  
 

Work Schedule Rounding Rules ..............................................................................  
Go to Settings > Work Schedules. 
 
The program comes with three commonly used rounding rules. You may 
use one of these and rename it or create your own.  
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.  

Work Schedule –  
Rounding Rules Tab 

 
The Rounding Rules Tab has the following features: 
Rounding Rules  Description 

Work Schedule Name  Name the Work Schedule here.  
Time Credited in __ Minute 
Increments  

This allows you to select rules for increments up 
to 60 minutes (increments must be divisible by 
60).  

Rounding When the Time Credited in __ Minute 
Increments is selected, the default rounding is set 
to round to the nearest credited increment. You 
may change this setting to fit your needs. Use the 
Rounding Example to test your changes. 

Rounding Example  This allows you to see how your rounding will 
affect true clocking in/out punches. Set the Hour 
and Minute to test how rounding will affect punch 
times. 
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Work Schedules – 
Overtime and Punch 
Schedules Tab 

 
The Overtime and Punch Schedule Tab has the following features: 
Overtime and Punch 
Schedules 

Description 

Payroll work week starts 
on… 

This determines the day that your work week begins 
on, which is defined as the start of the pay week.  

This Schedule Qualifies 
for DAILY Overtime after 
__ Hours  

Select this option if your policy is to give overtime 
after working so many hours on a DAILY basis. (For 
example, anything over 10 hours daily is considered 
overtime.) 

This Schedule Qualifies 
for WEEKLY overtime 
after __ Hours  

Select this option if your policy is to give overtime on 
a WEEKLY basis. (For example, anything over 40 
hours weekly is considered overtime.)  

Daily Schedule  This allows you to set up daily schedules that can be 
reported on. (For example, if you wanted to know 
who was 15 minutes or more late on Mondays, you 
could run an Exceptions report.)  

This is a Workday This designates the selected day as a regular workday. 
This is an Overtime Day This designates the selected day as an overtime day. 
Quick Copy Schedule 
From 

After you set up the first workday, this allows you to 
copy it to the next workday so you don’t have to re-
enter the same hours. 

New Time Entry This allows you to enter a new entry for your 
employees daily work schedule.  

Delete Time Entry This allows you to erase an entry.  
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Shifts Crossing Midnight ......................................................................................... 
You only need to set up the rules for Shifts Crossing Midnight if you have employees 
that work past midnight. This allows the Work Day to be defined. 
 

 

Work Schedules – 
Shifts Crossing 
Midnight Tab 

 
Feature  Description 

Report time to NEXT DAY 
on or after _____. 

This allows you to set the time punches’ Work 
Date to the next day. For example, if the night 
shift starts work at 10 PM on Monday night, but 
the entire shift (10PM – 6 AM) is counted for 
working on Tuesday, then you would select this 
option.  

Report time to PRIOR DAY 
on or before ____. 

This allows you to set the time punches’ Work 
Date to the previous day. For example, if the night 
shift starts at 2 AM on Tuesday but the entire shift 
is counted for working on Monday, then you 
would select this option.  

Maximum expected hours for 
lunch break ____.  

We recommend leaving this option at the default 
3.5 hours. This option is for punches that cross 
midnight and allows for employee’s to be counted 
on the correct work day when working long or 
double shifts.    
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More About Rounding ............................................................................................ 
Optima Time Clock rounding is based on three points: 
1. What you select for Time Credited in Minute Increments 
2. What you set for Clocking In and Out rounding 
3. Assigning the Work Schedule to an employee through Time Clock Access.   

 
Optima Time Clock automatically rounds to the nearest mark based on your choice of 
minute increments. Optima Time Clock will round up or down at about the halfway 
mark. For example, if you’re using Optima Time Clock to credit in 6-minute increments, 
then the program will round up AFTER 3 minutes and round down before this time. 
The key word is After. The program will ROUND UP AFTER however many minutes 
you select.  
 
Optima Time Clock allows you to select rounding up to the designated credited amount, 
minus one minute. If you choose to credit in 6-minute increments then you could choose 
from 1 to 5 minutes for rounding. If you choose to credit in 10-minute increments then 
you could choose from 1 to 9 minutes for rounding and so on. 
 

TIP: If in doubt, use the Round Test to see how the time will be rounded. 
 

Setting Up a Work Schedule ................................................................................... 
Setting up a Work Schedule allows your employee’s punch times to be rounded and 
allows you to report on various settings according to the Work Schedule. For example, if 
you wanted to know who was clocking in late on Mondays for the month of June, you 
could run an Exceptions Report. All employees that clock in/out must be assigned a 
Work Schedule for rounding and reporting purposes.  
 
To set up your work schedule, follow these steps: 
1. Click New. 
2. Enter a descriptive work schedule name. 
3. Select how your time is credited for rounding purposes. 
4. If you round to the nearest mark, you may leave the defaults in the Rounding block 

as they are. If, however, you round nearer or farther from the nearest mark, then 
you may change the rounding to suit your needs. 

5. Check how the program will round for you by entering a clock in/out time in the 
Rounding Example block. If the time isn’t rounding the way you want, then change 
the Rounding time and check it again. 

6. Select whether this work schedule qualifies for DAILY overtime and after how 
many hours.  

7. Select whether this work schedule qualifies for WEEKLY overtime and after how 
many hours. 
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Setting up the Daily Schedule ................................................................................. 
To define the daily schedule, follow these steps: 

 
1. Select a day of the workweek and specify if it is a Workday and/or an Overtime 

Day. An Overtime Day is any day that is automatically counted as overtime such as 
Saturday or Sunday.  

2. Click New Time Entry:  
a) Enter what time employees on this work schedule would normally start work. 

Press the TAB key or click New Time Entry to go to the next row. 
b) Enter what time the employees would normally break for lunch. Press the 

TAB key to go to the next row. 
c) Enter what time the employees would normally come back from lunch. Press 

the TAB key to go to the next row. 
d) Enter what time the employees would normally leave for the day. 

3. Click on the next day and enter their start and end time for this day. You may also 
use the Quick Copy Schedule feature to copy the previous day’s entry. Click Save 
to save this work schedule. 

 
Rember to assign a work schedule to each employee under Time Clock Access; without 
an assignment, employee entries and overtime will not follow the work schedule rules. 
This can result in payroll errors. 
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Chapter 9: 
Preparing Time Card 
Runs  
 
Time cards are prepared by the Payroll Administrator or other designated person who 
can run time card reports or export this data to your payroll program. The person who 
has access to Time Card Runs can lock out employees and other managers from making 
any changes to specific date ranges and save this information so that changes cannot be 
made to time that has already been paid for.  
 

Chapter Contents: 

Time Cards Runs ............................................................................ 98 

Viewing Time Card Data ............................................................ 101 

Exporting Time Clock Data ......................................................... 102 
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Time Card Runs ...................................................................................................... 
To go to Time Card Runs click on the Time Card Runs Feature.  
 
The Time Card Runs screen allows you to create time card reports for a specific date 
range for employees. This data may also be exported to your payroll program. You may 
break down the report by location, department or specific employees. The Time Card 
Run report will show you regular time, overtime, the payroll code description for First 
and Second column (from the Time Clock Tab under Global Preferences), and Other 
time (anything that is not covered under regular, overtime and payroll code descriptions), 
along with the total hours.  
  
Creating a New Time Card Run 
To create a new time card run, follow these steps: 
1. After clicking on Time Card Runs, click NEW RUN. 
2. Enter a name in the Run Name block (for example: Week of Apr 7 2002). Special 

characters are not allowed.   
3. Select a date range for this run. 
4. Select either Manager Lock or Total Lock for Lock Mode (see below for more 

information).  
5. Select Batch State of either In-Process or Completed. 
6. Select which Locations/Departments you want processed by clicking on Expand 

Window (see Selecting Locations/Departments). 
7. Click Save, then OK. 
8. Click on PRINT to preview the selected run. 
 
 Time Card Runs Screen 

 

Click title to Sort  
by column 

Action Icons

Run Information 

Status Bar 
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Feature Description 
Sort   Click on column title to sort by that column. 
Action Icons  a. New Run – This allows you to create a new 

time card run. 
b. Edit Run – This allows you to edit existing 

runs until the Batch State status “Completed” 
is selected.  

c. Delete – This deletes an existing run. 
d. Cancel – This cancels changes to the current 

run. 
e. Print – This allows you to print the selected 

time card run. 
Run Information a. Run Date – This is the date of the run. 

b. Run Name – This is the specified name. 
c. Created By – This is the name of the 

individual logged in when creating the run.  
d. Batch State – This is the specified state from 

the Edit Screen. 
e. From/To – These are the dates specified. 
f. Locked – This is the specified Lock type 

from the Edit Screen. 
 

 

The Time Card Run 
Edit Screen 
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The Time Card Run Edit window has the following features: 
Feature Description 
Run Date  This is the date the run was created. 
Run Name  This allows you to enter a name for the run. 
Print This allows you to print a Detailed or Summary report.  
Date Range  This allows you to select the date range for this batch.  
Lock Mode  This allows you to select from three different modes. 

a. Unlocked – This allows anybody with access to create, edit 
or delete entries. 

b. Manager Lock – locks anybody with Manager and 
Employee access from creating, editing, or deleting within 
the selected date range. This allows the Payroll Personnel 
to pay employees without having the time card entries 
changed at the last moment. 

c. Total Lock – locks everyone, regardless of access level, 
from making any changes with the selected date range. 
Administrators with Time Card Run Access are also 
locked out from making any changes. If changes need to 
be made, the selection would need to be changed to 
Unlocked or Manager Lock mode.  

Batch State  a. In-Process – for the current card run you’re working with. 
b. Completed – select when Time Card Run has been paid. 

Locations and 
Departments  

Clicking on Expand Window or the plus (+) sign next to 
Locations and Departments will expand this window to choose 
specific locations and departments. Those employees from the 
chosen locations and departments will show up in the 
employee window. 

Employee window a. Checkbox – This allows you to select specific employees 
by clicking in the checkbox. 

b. Ct – This shows a count of time entries. 
c. Name – First and Last name of  employee(s). 
d. SSN – Social Security Number of employee(s). 
e. Reg Hrs – This shows regular hours. 
f. OT Hrs – This shows overtime hours, if applicable. 
g. Column 1 – (shown as Paid Vacation in screenshot above) 

Payroll Description Column 
h. Column 2 – (shown as Paid Personal in screenshot above) 

Payroll Description Column 
i. Other – This shows time not counted in e – h.  
j. Total Hrs – This shows total of regular plus overtime 

hours. 
Radio Buttons: a. Display Totals for All Employees – Select this option to 

show totals for all employees. 
b. Display Totals for Selected Employees – Select this option 

to show totals for only the selected employees. 
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Viewing Time Card Data ........................................................................................ 
When viewing time card data, keep in mind that overtime will only show if you have set 
up a Work Schedule and assigned it to your employees. The Work Schedule will have 
rules regarding overtime and what day your Work Week starts on. See Chapter 8 for 
detailed information about Work Schedules.  
 
Frequently Asked Questions 
Q: I’ve created a time card run covering 8 days. For one employee it shows 59 
hours of worked time, but 0 hours of overtime. Why is this? 
A: The start of your Workweek (set in the Work Schedule) determines the week for 
overtime. Check to make sure you have a Work Schedule assigned for this employee by 
going to Time Clock Access > Current Work Schedule. If there is one, go to 
Settings > Work Schedules and make sure the assigned Work Schedule has the 
appropriate Overtime settings. If the overtime settings aren’t set up, then go to Work 
Schedules and create one before assigning it. (See Chapter 8 Creating Work Schedules 
for detailed information.)  
 
For Example: If a time card run is created to include Randy from (Wed) May 8, 2002 
through (Thur) May 16, 2002 and it shows that he worked 59 hours during this time, this 
doesn’t necessarily mean he has overtime. Weekly overtime, if any, is calculated on the 
last day worked of the workweek. Daily overtime, if any, will be calculated on the same 
day worked. 
 
 
 

May 2002 

Sun Mon Tue Wed Thur Fri Sat 

   1 2 3 4 
5 6 7 8 9 10 11 

12 13 14 15 16 17 18 

19 20 21 22 23 24 25 
26 27 28 29 30 31  

 
 
 

Workweek 1 

Workweek 2 

Weekly Overtime will be 
calculated on the last day worked
for that workweek. 

Daily Overtime will be calculated on 
the same day worked. 

Work Weeks 
Overlapping 

 
Assuming our Workweek starts on Sunday, the date range of May 8 – May 16 covers two 
separate Workweeks. (Workweek1: May 5 – May 11 and Workweek2: May 12 – May 
18.) If Randy does not work overtime on a daily basis or for the whole workweek, he 
won’t have any overtime. But, if he does work overtime for Workweek1, it will be 
calculated for that Friday (May 10) and be included on the report. Overtime worked for 
Workweek2 will not be reported unless Friday, May 17 is included.    
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Factors involved in calculating overtime: 
1. What is the Workweek Start Day? (Sunday? If the workweek starts on Sunday, this 

would mean the workweek is from Sunday through Saturday every week.) 
2. Do your employee’s receive overtime based on time worked on a daily basis? 

(Example: Daily time worked over 10 hours receive overtime.) 
3. Do your employee’s receive overtime based on time worked on a weekly basis? 

(Example: Weekly time worked over 40 hours receive overtime.) 
4. When was the Work Schedule assigned to the employee? 
 
Overtime Description 

Daily 
Overtime 

Overtime will be posted on the day the employee goes over the 
amount of hours set for Daily Overtime on the Work Schedule. 
(Example: if > 10 hours daily is considered overtime; if employee 
works more than 10 hours on Tue, overtime will be shown same 
day.) 

Weekly 
Overtime 

Overtime will be posted on the last day worked on the workweek. 
(Example: if > 40 hours a week is considered overtime; if employee 
works Mon – Fri, overtime will be shown on Fri.) 

 
Exporting Time Clock Data ..................................................................................... 

You may export time entry data two different ways in Optima Time Clock. The first way 
is from the Export feature under Time Card Runs. The other way is from Export Time 
Clock Data under the File menu.  
 
Export Type Description 

Export Time Clock Data Exports hours worked and general employee 
information to a .csv file. This is a general export 
found under the File menu. 

Time Card Runs Export This is a specific export feature that exports to 
several different payroll formats (See Time Card 
Runs Export above.) 

 
 
 

 

Time Card Runs 
Export 
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Time Card Runs Export 
From Time Card Runs Export you may export to a text file into the following Payroll 
formats: 
¾ ADP/PC Payroll for Windows 
¾ Paychex 
¾ PaycomOnline 
¾ PayAmerica 
¾ QuickBooks® Pro and Premier Editions 2003/2004 
¾ RDE (Summit Payroll Express) 
¾ Rapid Payroll 
¾ UltiPro 
Please call or email Tech Support for other formats. 
 
* - Optima Time Clock is integrated with QuickBooks. When you click on Export, the 
time data is automatically transferred into QuickBooks. (See QuickBooks Integration 
below.) 
 
QuickBooks Integration 
Optima Time Clock can import time data directly into QuickBooks Pro and Premier 
Editions 2003 and/or 2004. To import from Optima Time Clock you will need to set up 
QuickBooks for the following: 
¾ to view Weekly TimeSheets 
¾ appropriate Payroll Items that correspond with Optima Time Clock 
 
NOTE: Optima Time Clock and QuickBooks should be set up prior to peforming the 
following steps. 
 
The following steps will set up Optima Time Clock to import directly into QuickBooks: 
1. Open Quickbooks. 
2. Open Optima Time Clock. Check your version number by going to Help > About. 

You should have at least v1.4.1.1 or higher before continuing.  
3. From within Optima Time Clock go to Time Card Runs and select Export. 
4. If Quickbooks isn’t an option in the left column, hold down Ctrl-Alt-Q to display it. 
5. Click Open Quickbooks. This will bring up a QuickBooks message asking: Do you 

want this application to access your Quickbooks Company File?  
6. Select “Yes, Always” or “Yes, This Time” to allow access. Click Yes if you receive 

the Confirm to Proceed message. Note: if you select “Yes, This Time”, the next 
time you open Quickbooks from Optima Time Clock it will ask you again for 
access. 

7. Click back on Optima Time Clock. You should see two columns which may be 
filled in with data already. The Payroll Code column are codes related to Optima. 
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The Payroll Item codes are related to Quickbooks. You’ll need to relate the 
appropriate Payroll Code from Optima to the Payroll Item code in Quickbooks. The 
Optima Payroll Codes should be displaying. Clicking in the corresponding row for 
the Quickbooks Item code will bring up a drop down box. 

8. Click Save after making any changes. 
9. Click Export. 
 
Exporting Time Clock Data 
From File > Export Time Clock Data, you may export hours worked and general 
employee information to a .csv file which can be opened in MS Excel or other 
spreadsheet programs.  
 

 

Export Time Clock 
Data Screen 

 
The Time Clock Export feature allows you to export the following data: 
¾ Last Name ¾ Location 
¾ First Name ¾ Department 
¾ Middle Name ¾ Punch Hours 
¾ SSN ¾ Punch Changes 
¾ Date of Birth  
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Features Description 

Export Type a. Single File – Exports Employee Data and 
Hours Worked to a single file. If Export Punch 
Changes is selected, it will export to a separate 
file in addition to the Hours Worked.  

b. Relational File – Exports Employee Data and 
Hours Worked to two separate files. If Export 
Punch Changes is selected, it will export to 
another separate file.  

Export This exports the data once you have settings 
complete. 

Select Employee to Export  This allows you to select specific employees, 
locations and/or departments to export. 

Hire Range Filter  This allows you to filter on a specific hire date range.  
Job Status Filter  This allows you to filter on full and part time. 
Employee Status Filter  This allows you to filter on Active, Inactive or 

Terminated employees.  
Select Employee Data 
Fields to Export 

a. Available Fields - This is the list of fields to 
choose from. 

b. Fields to Export (In Export Order) – These are 
the fields chosen. 

Export Time Clock Data  a. Export Hours Worked for Period – This allows 
you to select a date range for time card data for 
the selected employee(s). 

b. Export Punch Changes – This allows you to 
export punch changes. 

 
To export this data, follow these steps: 
1. From the File menu, select Export Time Clock Data. 
2. Select the export type: Single File or Relational. 
3. Expand the tree, if necessary, and select the employees to export. 
4. Select the data fields to export by either double-clicking on the file or selecting the 

file and clicking on the arrow pointing to the right. 
5. If needed, select the Export Hours Worked option with a date range. 
6. If Export Hours Worked is selected you can select to Export Punch Changes 

option. 
7. Click Export.  
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Chapter 10:  
Using Reports 
 
Optima Time Clock includes several powerful reports to help you manage employees 
and prepare for payroll.  For additional reports, please try Optima Confidential 
Employee Record, which offers you the power of additional employee information 
tracking.  
 

 
Chapter Contents: 

Report List ..................................................................................... 108 
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Report List .............................................................................................................. 
Here is a list of the reports you can run: 
¾ Employee Summary Report 
¾ Employee Anniversary Report 
¾ Hours Worked Report 
¾ Deleted Time Entries Report 
¾ Work Schedule Assignments Report 
¾ Exceptions Report  
¾ Time Cards Report 
¾ Time Card Runs Report 
¾ Time Card Runs Extended Report 
¾ Reminders Report 
¾ ID Badges 
¾ Table Listings 
 

Report Interface Features ....................................................................................... 
The following features are available on each report interface: 
Feature Description 

Preview This allows you to see how the report will show 
when printed. 

Print This prints the report.  
Printer Setup  This allows you to set printer options. 
Help This will allow you to view help regarding this 

screen. 
Close This exits the report interface. 
Grouping Options  This allows you to group on Location and 

Department. 
Display Options  This allows you to display SSN. 
Export Options  This allows you to not export headers.  
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Employee Summary Report ..................................................................................... 
 
The mployee Summary Report is a 
quick overview of your employees 
showing SSN, date of hire, title, ac

E

tive 
status, and full/part time status. 

 
 

Employee Anniversary Report ................................................................................. 
 
The Employee Anniversary Report 
shows the anniversary date of employees 
according to the selected date range.   

 
 

Hours Worked Report ............................................................................................ 
 
The Hours Worked Report shows 
regular hours, overtime hours and total 
hours. You may select specific employees 
by date range. 
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Deleted Time Cl

The Deleted Time Clock Entries 

ents and 
login name of the person deleting the 
record. 

ock Entries Report ......................................................................... 
 

 

Report shows entries that were deleted 
along with the reason, comm

 
Work Schedules Assignments Report ...................................................................... 

 
The Work Schedules Assignments 
Report shows which work schedule each 
employee is on and when it was assigned.  

 
Exceptions (Punch) ................................................................................................. 

rate reports: Punch Exceptions and Hours 
E . The Punch Excep
a ay ev unded 
t
 

Exceptions are broken down into two sepa
xceptions tions report allows you to report on early or late clock in 

en report on actual clock in/out time or on the rond out punches. You m
ime.  

N  mus et OTE: Your employees t be assigned to a Work Schedule with the daily hours s
u view this reportp to properly .  
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Punch Exceptions Rep
Pane 

ort 

 
The following are other options that are available on the Punch Exceptions Report. For 
a list of features not listed here, please see Report Interface Features above. 
 
Feature Description 

Report Date Range  This allows you to set a date range for the report. 
Time Used For Report  This allows you to report on Reported (actual punch 

tim  time.  e) or Rounded
Punch Exceptions in Th  

o Minutes  t
is allows you to view how early or late, in minutes
report on.   

Work Schedule(s)  This allows you to filter on a selected work schedule. 
Week Day(s)  Th lter on specific days. is allows you to fi

 
Exceptions – (Hours) .............................................................................................. 

he Hours Exceptions Report allow you to report on hours over or under by day, week 
r month. This report can be used to monitor which employees may be near overtime.  

T
o
 
N  Work Schedule with th aily hours set up to OTE: Employees must be assigned to a e d
properly view this report.  
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The following are other options that are available on the Punch Exceptions Report. For 
a list of features not listed here, please see Report Interface Features above. 
 
Feature Description 

Report Date Range  This allows you to set a date range for the report. 
Time Exceptions in hours  This allows you to report on tot

under by day, week, or month, a
al hours over or 
nd to filter on a 

work schedule.  
Work Sche  This allows you to filter on a selecdules ted work schedule. 

 
 
 

Hour Exceptions 
Report Pane 
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Time Cards Report .................................................................................................. 
The Time Cards Report shows punch 
times and manual punch entries for each 
employee according to th

 

e selected work 
date range. Changes made to an entry can 
be printed along with employee and 
supervisor signature blocks.  

 
NOTE: Punch entries with an asterisk (*) to the right of the entry require attention. It 
m n made and need corr ted.  eans that double in or out punches have bee ec
 

Time Card Runs R .................................................. 
d Runs Report shows 

regular time, overtime, and the 
Second Column des

” format.   

eport ........................................
The Time Car

 

totals of 
First and criptions for 
Reported Payroll Description Columns 
under Settings > Global Preferences > 
Time Clock Tab in a “column

 
NOTE: The Time Card Runs Report will only report regular time, overtime, and the 
payroll descriptions for First and Second Columns under the Global Preferences > 
Time Clock Tab. All other reasons will fall under the “Other” column. See the Time 
Card Runs (Extended) report to view all payroll descriptions. 
 
To print a report, follow these steps: 
1. From the Reports menu, select the appropriate report. 
2 Select any options necessary from the filter and options settings. 
. Under Select a Time Card Run, select a run. Note: Runs must be created through 

the Time Card Runs Tab. 
4. Click Preview to see the report on the screen before printing.  

. 
3
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Time Card Runs ................................................................................... 

“row” format. If you have more than two 
payroll code descriptions (for example, 
Vacation, Sick, and Personal), this report 
will allow you to view all payroll code 
descriptions set up under Settings > 
Reason Codes – Payroll Code 
Description.  

(Extended) .
The Time Card Runs (Extended) 
Report will print regular time, overtime, 
and all Payroll Code Descriptions in a 

 
 

Reminders .............................................................................................................. 
The Reminders Report allows you to view 

 reminders for a 

 

resolved and unresolved
specific date range.  

 
ID Badges ................................................

You may create ID Badges for 
Clock or 

identification. There are 4 type
Badges: Employee, Temporary, 

............................................................... 
use with 

Optima Time company 
s of ID 
Guest or 

without a title.   
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Layout 
T ect what features will be on the ID Badge. For 
e  read Guest instead of Employee, you can select 
G
  

he Layout Tab allows you to sel
xample, if you want the badge title to
uest under the Badge Title. 

 
 
Barcode 
The Barcode Tab allows you to select the type of Barcode that will be printed. If you’re 
not sure which type to use, we recommend keeping the default barcode type of Code 39. 
Optima uses the Employee ID as the Barcode number. If an employee doesn’t have an 
Employee ID number (see Employee Detail), a barcode will not print out on the label.   
 

 
 
Print Stock 
The Print Stock Tab allows you to select the label type. The G.Neil ID Badge type can 
be requested through our sales team and is specifically designed to work with Optima 
Time Clock and Optima Confidential Employee Record.  
 

 
 
 
 

ID Badges 
Layout Tab 

ID Badges 
Barcode Tab 

ID Badges Print 
Stock Tab 
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Chapter 11: 
Database Maintenance 
 
This chapter discusses how to maintain the Optima database through backups and 
regular maintenance. A Backup is essentially a “copy” of your employee records.  
Backing up ensures that you can recover from a power failure or emergency.  You may 
also install Optima Time Clock on another computer (even as a demo) and restore from 
your backup.   

 
Chapter Contents:  

Backing Up..................................................................................... 118 

Creating a Manual Backup from Within Optima ................... 119 

Creating a Manual Backup from Within DB Monitor ........... 119 

Scheduling Automatic Backups ................................................ 119 

Restoring from a Backup ............................................................ 120 

DB Monitor ................................................................................... 120 

Clearing Connections ................................................................. 121 

Performing Maintenance and Repairing the Database ........ 121 

DB Maint ....................................................................................... 121 
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Backing Up ............................................................................................................. 
How often should you backup? 
Every company is different regarding their backup needs. One thing to remember is, “it’s 
not if your computer is going to crash, but when.” They have made great strides in 
making computers more reliable, but that just makes the time longer before something 
may happen to your computer.  
 
The following pertains to any data on your computer and not just your Optima program. 
Ask yourself this question, “If my computer were to crash right now, how long would it 
take to re-create (reenter) all of my data without a backup?” Then ask yourself, “If I had 
to restore from a backup, would I be okay with last week’s backup, where I have to 
reenter a week’s worth of data? Would I be okay with restoring a backup from 3 days 
ago? 
 
When restoring your data, the information will only be as current as your last backup. So, 
if you did a backup two weeks ago and had to restore this backup, you would need to 
reenter the data that didn’t get backed up.     
 
Back up after you make changes to your employee records.  
It is recommended that you back up your database after making any significant changes 
to records.  For example, any time you enter several employees or input many changes to 
absence information would be a good time to back up.  You may also set up the DB 
Monitor to automatically back up at assigned times.  
 
Rotate backups and store backup copies offsite.  
A good backup routine is to have at least three sets of backups covering different days of 
the week.   This practice is called rotation and reduces your risk of data loss.  It is also a 
good practice to always keep one copy offsite in case of a fire or flood.   Consult your 
system administrator for your company policy regarding data storage.  

 
A Restore is when you recover from a backup.  There are three different uses for the 
restore feature. A Restore may only be done through the DB Monitor.   
1. To overwrite the current data with archived data 
2. To recover from a hardware crash 
3. To move information onto a new computer 

 
Please keep in mind that when you restore data, your information will only be as current 
as the backup you are restoring from.   
 

IMPORTANT NOTE 
The backup file may only be saved to the Server or Standalone Computer where the 
database resides.  The backup creates a zipped file with an extension of .gbk.  
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Creating a manual backup from within Optima 
To perform a manual backup from within the Optima program, follow these steps: 
1. From within Optima, go to File > Maintenance > Backup > Backup Database. 
2. If you are running the backup utility from the Server or at a local PC where the 

database resides (Standalone), you will have the option to select where you want to 
backup to. If you are running the backup utility from a Client (Optima client intall), 
it will automatically run the backup, saving the data where the database resides.  

 
Creating a manual backup from within DB Monitor 
To perform a manual backup from within DB Monitor, follow these steps: 
1. Open the DB Monitor program by going to Start, Programs, G.Neil Optima, and 

clicking on DB Monitor.  
2. Enter your login and password.  If you do not have access to the DB Monitor 

Backup feature, you will need to see your Administrator.  
3. Click the Backup Tab.  
4. Click Yes to the message, “Do you want to perform a sweep after the backup 

completes?” Note: A Sweep is a maintenance feature that keeps the database 
working at peak performance.  

5. Click OK at the Select Directory screen.  It is highly recommended that you keep 
the default location.  Note: You may only back up to the Server or standalone 
computer where the database resides.  

6. Click Close when the backup is complete.  
 
Scheduling Automatic Backups 
To create a scheduled backup, follow these steps: 
1. Open the DB Monitor program by going to Start, Programs, G.Neil Optima, and 

clicking on DB Monitor.  
2. Enter your login and password.  If you do not have access to the DB Monitor 

Backup feature, you will need to see your Administrator.  
3. Click the Backup Tab.  
4. Click New Backup.  
5. Enter the Backup Type by selecting Daily, Weekly or Monthly.  
6. Enter the military time when you would like the backup to take place.   
7. It is recommended to keep the other default settings of Performing Sweep and the 

path of the backup.  A different backup will be created for each scheduled backup.  
Note: The name of the backup will be: [Type]_Backup_[mm-dd-yyyy]_[time] to 
distinguish it from other backups.  For example, Weekly_Backup_08-02-2001_2300, 
or Monthly_Backup_09_01_2001_1700.  

8. Click Save.  The backup will be performed within a minute of the scheduled time.  
Note: The Server or standalone computer where the database is located must be 
turned on for the backup to complete.  If the computer is not on at the scheduled 
time, the DB monitor will try to create the backup the next time it is opened.   
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Restoring from a Backup 
Remember, restoring a backup will overwrite all data in the current database.   Restore 
may only be run from the DB Monitor on the Server or standalone computer.  To 
restore, follow these steps: 
1. Go to the Server where the database files are located.  (Restore cannot be done 

from a Workstation.) 
2. Open the DB Monitor program by going to Start, Programs, GNeil Optima, and 

clicking on DB Monitor.  
3. Enter your login and password.  If you do not have access to the DB Monitor 

Restore feature, you will need to see your Administrator.  
4. Click the Restore Tab.  
5. Click the database to restore.  
6. Click Browse and double-click the backup you wish to restore.  
7. Click Start, Restore.  
8. After Restore is complete, click Hide to minimize the DB Monitor.   
You may open the program to see your restored data.  
 

DB Monitor ............................................................................................................ 
Go to Start > Programs > GNeil Optima > DB Monitor. 
 
The DB Monitor allows you to change the Server Name and Database Path, Backup and 
Restore your database, view database information and clear inactive connections. It will 
also show you what Optima version each client computer is running. This is good to 
make sure everyone is on the same program versions.  
 
Feature Description 
Settings This allows you to change the Server Name and Database Path.  
Backup This allows you to set up a backup schedule or backup now. 

See above for creating a backup. 
Backup History  This shows all backups completed. You will need to manually 

delete old backups from within Windows Explorer. 
Restore This can only be done from the same drive where the database 

resides. For example, if the database was located on a Server, 
the restore could only be done FROM the Server, not from the 
Client Workstation. See above for steps on restoring. 

Information This allows you to view how many users are connected to the 
database and where the current database is located. The Server 
Version information is the version of Interbase (database).  

Statistics This gives information on the database. Normally, you will not 
need this information.  

 

120 Ch 11:  Database  Maintenance 



 

Feature Description 
Connections This allows you to view who is connected and any 

inactive connections that need to be cleared.  
 
Clearing Connections 
Go to Start > Program Files > GNeil Optima and select DB Monitor.  
 
To clear a connection, follow these steps: 
1. Make sure that all users are out of all Optima programs. 
2. From the Connections Tab of the DB Monitor, click on the Refresh button and 

make sure that all Computer Names have a “N” under Active Connections. 
3. Click Clear Inactive Connections.  This will clear all connections listed with an 

“N” under Active Connections. 
 
Performing Maintenance and Repairing the Database ............................................ 

The DB Maint is different from the DB Monitor. The DB Monitor utility allows you to 
view current connections, backup and restore, and view backup history. The DB Maint 
utility allows you to perform maintenance and attempt to repair a corrupted database.  
 
DB Maintenance Utility    
To run the DB Maint utility, go to Start > Programs > Gneil Optima > Maintenance 
> DB Maint. 
 
The DB Maint utility allows you to perform the following:  
1. Perform periodic maintenance on the database to keep it at top performance. 
2. Attempt to repair the database when corrupted. 
 
Maintenance 
We recommend that you periodically perform maintenance on the Optima database 
(about once a month) by running the Optima maintenance utility called DB Maint. DB 
Maint will perform some maintenance procedures on the Optima database to keep it 
running at top speed.  
 
CAUTION: The DB Maint should not be used as a replacement for a good backup 
schedule. The database may become corrupted beyond repair that can be quickly 
recovered by a current backup. We strongly encourage running backups within Optima 
or DB Monitor, even if the database is on a Server that gets the whole drive backed up 
daily or on a Standalone computer.  
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Database Repair 
If you can’t open the Optima program, we recommend running the DB Maint utility. It 
will attempt to repair a corrupted database. If the utility does not repair the database, 
please save screenshots of  the error messages and contact G.Neil Tech Support.  
 
Running the DB Maint Utility 
Whether performing monthly maintenance or attempting to repair the database, you 
would follow the same steps to run the DB Maint utility. 
 
1. Go to Start > Programs > Gneil Optima > Maintenance > DB Maint. 
2. After clicking on DB Maint, click on Start to run the utility program.  
3. After the utility finishes, click Close to exit. 
4. Open the Optima program.  
 
NOTE: The DB Maint may take several minutes to run, especially on large databases. 
Please be patient. 
 
CAUTION: Running the DB Maint utility requires exclusive use; everyone must be out 
of any Optima programs. Any changes made to system during the running of the DB 
Maint utility will be lost.  
 

 
 

DB Maint Screen 

Status Bar 

Progress Bars 

Status of Errors 

Status Window 
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DB Maint Features 
The DB Maint utility has the following features: 
Features Description 

Start Begins the maintenance or repair. 
Cancel Stops the maintenance or repair process.  
Print Prints the error message(s). The Print button will 

not appear unless there are errors. 
Copy Copies the error message(s) to the clipboard. This 

will allow you to paste it into an email. The Copy 
button will not appear unless there are errors.  

Close Exits the DB Maint utility. 
 
NOTE: The DB Maint utility will attempt to repair the database that the hrware.ini file 
points to. (Go to Start > Run, and enter: hrware.ini. Locate [HRWARE] in brackets 
and see the Server name and Path for the directory of the Optima database.) 
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Chapter 12: 
Using Custom Reports  
 
 
This chapter will introduce you to all the tools for creating and editing custom reports. 
See Appendix C for tutorials on Modifying a Custom Report (page 175) and Creating a 
Custom Report from Scratch (page 181).  
 

Chapter Contents: 
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Script Language Guide ............................................................... 147 

Creating Reports Through Other Software ............................ 155 

Setting Up a Guest User ............................................................. 155 
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Overview ................................................................................................................ 
Optima Time Clock includes an enhanced custom-reporting tool called Report Runner.  
Report Runner allows you to customize most of the reports that are currently included 
with Optima Time Clock and lets you create your own reports from scratch. Note: See 
Appendix C for a tutorial that will walk you through editing and creating reports. 

 
You may access Custom Reports by following these steps: 
1. Click the report you would like to customize. For example, from the Reports menu, 

select Employee Summary. 
2. From the report interface window select Custom Reports. This will bring up the 

custom report interface.   
 

 

Custom Report 
Interface 

Above is the custom report interface.  Each portion of this screen is described below. 
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Feature Description 

Report Name  Shows the name of the template.  The type of 
report that is currently in effect is “Employee 
Summary.”  All custom reports created and/or 
modified will have access to data specifically 
designed for the selected report.  

Master Filter This shows the settings carried over from the 
main report screen. All filters EXCEPT the Show 
Social Security Number on Report and 
Disable Headers on Export will come over.  

Action Buttons a. New – This creates a new report; the “create 
new report” wizard will start. 

b. Edit – The selected report will be loaded into 
the report designer screen. 

c. Preview – This allows you to view the report 
before printing. 

d. Print – This allows you to print the selected 
report. 

e. Printer Setup – This allows you to change 
your printer settings. 

f. Help – This displays the help for this screen. 
g. Close – This exits Custom Reports and 

returns to Optima Time Clock. 
Other Buttons a. Delete – This deletes custom reports that 

have been created. You may not delete the 
master template.  

b. Rename – This allows you to rename custom 
reports that have been created. You may not 
rename the master template. 

c. Make this report available to everyone – If 
this box is checked, this will allow the report 
to be available to other users logging into the 
program. Otherwise, only the person creating 
the report will see it.  

d. View Data – This will show the data that you 
have selected according to the filter and sort 
settings.  
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Sort and Filters ....................................................................................................... 
From the custom report interface, you have the option to select which fields you want to 
sort and filter on.   
 
Sorting allows you to group by a specific field. Fields are referred to as data, such as Last 
Name, First Name, Date of Birth, Location, Department, etc. You may create a sort by 
Last Name, First Name or any other available fields.  
 
Filters allow you to separate out specific fields on the report. For example, if you only 
wanted to view employees from a specific department, you could create a filter for this 
and only those employees from the department you specified will show up on the report.  
 
Custom Sort Fields 
 

 
 

Create New Sort 

Edit Selected Sort 

Delete Selected Sort 

Sort Name

Sort by Fields

To create a new custo t, follow these steps: m sor

2. ports.  

4. 

1. Select a report from the Reports menu. 
Click Custom Re

3. Select the appropriate report or click New to create your own. 

Click the NEW  button under the Custom Sort Fields. 
Enter a name that will designate what type of sort this will be, such as Last Name or 
SSN. Click OK. 
Select which field(s) you want to sort on by eithe

5. 

ed by which field is at the top. For example, if you have selected to sort on 
me and EESSN fields, with the Last Name field at the top, it will sort 

the report. You may change the order of the 
DOWN buttons. 

ted 

 
ee Ap ndix C for a tutorial that will walk you through editing and creating reports. 

6. r double clicking on the field or 
clicking once on it and clicking the right arrow button. The sort order will be 
designat
the Last Na
first by Last Name and then by SSN on 
fields by clicking on the UP and 

7. Click MAKE DEFAULT. This keeps the sort settings assigned to the selec
report. 

8. Click OK. 
9. See below for setting up custom filters. 
0. Click EDIT or PREVIEW.  1

S pe
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Custom Filters 
This feature allows you to filter on one or more fields. The filter drop-down box allows 
you to select saved filter settings. 
 

 
 

 
 
Feature Description 

Field ield to filter on. This allows you to select the f
NOTE: These are the only fields allowed. 

Operator qual to 

n 

a. = e
b. > greater than 
c. >= greater than or equal to 
d. < less tha
e. <= less than or equal to 
f. <>  not equal to 

Value This allows you to enter a field name to filter on. 
AND This enters the statement. Click “AND” or “OR” 

after each statement you create.  
OR This allows you to set an OR statement (this OR 

that). 
(  ) This allows statements that need to be done first 

 calculations (a+b)-c. such as in Math

Create New Filte

Edit Selected Filter 

Delete Selected Filter 

Custom Filter 
Screen 

Filter 

Filter Namer 
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Feature Description 

Edit This allows you to edit a line. 
D l  This allows you to delete a line.  e

Test  This will check for correct syntax. NOTE: This only 

check to see if the syntax will work correctly.  
checks to see if the syntax is correct. It does not 

Make Default  This makes this filter the default filter for the selected 
report.  

 
To create a new custom filter, follow these steps: 
1. Select a report from the main menu. 
2. Click Custom Reports. 
3. Select the appropriate report or click New to create your own. 
4. Click the NEW button next to Custom Filter. 

ll designate what type of filter this will be, such as SSN. Click 

nd select a field to filter on. 
. Click the drop-down arrow for Operator and select the type of filter. 

5. Enter a name that wi
OK. 

6. Click the drop-down arrow for Field a
7
8. Click the drop-down arrow for Value and enter a value. 
Example: Select “LastName” for the Field, select “=” for the Operator, and enter “A*” 
for the Value. After clicking “Make Default” and OK, when the report is previewed, it 
will show all names that start with the letter “A”. 
9. Click “AND” to set the query. This will bring it into the window. 
0. Set any other queries as needed. 
1. Click Make Default. 
2. Click OK.  
3. Click Preview to show your settings. 

1
1
1
1
 

TIP: If you have several lines in a query and you delete the first one, make sure the top 
one doesn’t begin with AND.  
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Edit/Design Scre

ing on the New button from the Custom Reports main window.  When the 
esign screen appears, you are presented with the Report Wizard.  The report wizard 

in Appendix C (Custom Report Tutorial # 2). 
 

en ................................................................................................. 
You can create your own customized report from the data provided for each report type 
by click
d
walks you through the process of creating a basic report.  If you wish to learn how to 
create your own report, a step-by-step guide to creating a report from scratch is provided 

 

Custom Reports Design
Screen 

 

 
The above picture shows Custom Reports’ main design screen.   This is the screen where 
you will be modifying or creating custom reports.  The toolbars are described in detail 

elow: 

Toolbars ..........

b
 
....................................................................................................... 
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Y
nt’s property dialog. Additionally, you can use it to modify multiple elements at 

once. 

ou can change many report element properties directly with the toolbar instead of using 
the eleme

 

 These buttons are for creating a new report and saving a report. 
 

 Use these buttons to print the report or to view print preview. 
 

 With these buttons, report elements can be cut to, copied to or pasted 
om the report designer’s clipboard. fr

 

 These buttons are used to set a report element to the background or bring it 
 front of all other report elements, in case of overlapping elements. in

 

 Report elements can b
 these buttons. Some of the buttons are only enabled when multiple el

e arranged 
with ements are 
selected (for example to align the left edges). 
 
 

 Here you can set font and font 
s of the selectestyle d report elements (font name, font size, bold, underline, italic). 

 

 These buttons are for aligning text within a report element. Text can be 
aligned left, right or centered. Of course this only makes sense if the report element’s 

its text and if “autosize” is deactivated. size is bigger than 
 

 With this button, you can open a dialog to set the frame options for the selected 

 
ons run down the left side of the design screen. 

element. 

These butt
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Report Elements 
Each button is used for adding report elements to the report. To add an element to the 

u want the 
her position 

Standard Report Bands 

selec  property dialog. 

ach report page. 
 Column header: The column header is used with reports that have multiple 

ns (can be set with “Report|Options”). 

¾ Group footer: The group footer is printed at the end of a group, before a new 
. You can find more information on groups at the chapter describing the 

report, you must click its button and then click on the report where yo
telement to be inserted. Of course you can still move a report element to ano

later.  
 

........................................................................................... 
All standard report bands are added with the same button (see above). The band type is 

ted with the band’s
 
The following band types are available: 
¾ Title: The title band will be printed on the first page of the report as a report title. 
¾ Page header: The page header is printed at the top of e
¾

colum
¾ Detail: The detail band is the most important report band. It is printed once for 

each data record from the main report table. 

group starts
group band. 

¾ Summary: The summary band is printed at the end of the report, after all data 
records have been printed. 

¾ Page footer: The page footer is printed at the bottom of each report page. 

Report Band
 

 
The band properties for these bands are all set with the same property dialog. The 

 
rint: 

on the last report page 
n-page numbers only: only prints the band on even-page numbers 

ting it 

following options are available: 
 
Type: Band type (See above.) 
 
Color:  
This defines the background color of the report band. 

P
¾ not on first page: prints the band only on the second page and following 
¾ not on last page: suppresses printing of the band 
¾ eve
¾ odd-page numbers only: only prints the band on odd-page numbers 

in¾ at bottom of page: moves the band to the bottom of the page before pr
¾ force new page: starts a new page before printing the band 
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¾ force new column: starts a new column before printing when using reports with 

 
Only print band if expression is true: 
An expression

multiple columns 

 can be used to determine whether the band should be printed or not. The 
expression must have a logical result of “true” or “false.” Press the button on the right 
side of the expression edit line to use the expression expert. 

. 

 
Frame: 
A frame or single frame line can be drawn around the report band. You can select which 
lines should be drawn, in which color, style and width

 
Child Band 
A child band is a band which is attached to another report band and which will always be 
printed below its parent band. This way you can print an additional band after each detail 
band, for example.  The advantage of using child bands instead of just resizing the parent 
band to make room for more report elements is that there can be a page break between a 

and and its child, if needed, and the child band can be printed independently from its 

t use child bands if you have report elements with “Autostretch” set to true and 
 fields. In this case, place all the 

because of autostretching elements 
efore them on a child band. 

arent Band: The band to which the child band is attached. 

lor of the report band. 
 

 not on first page: prints the band only on the second page and following 
en-page numbers only: only print

 
 
 

b
parent band, even if the parent band is not printed.  
 
You mus
you want to print element below such auto-resizing
elements that should be moved down automatically 
b
 
The following options are available: 
P
 
Color:  

his defines the background coT

Print: 
¾
¾ ev s the band on even-page numbers 
¾ odd-page numbers only: only prints the band on odd-page numbers 
¾ at bottom of page: moves the band to the bottom of the page before printing it 
¾ force new page: starts a new page before printing the band 
¾ force new column: starts a new column before printing when using reports with 

multiple columns 
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Only print band if expression is true: 
An expression can be used to determine whether the band should be printed or not. The 

ght side of 
dit line to use the expression expert. 

 
ubdetail Band

expression must have a result of “true” or “false.” Press the button on the ri
the expression e

S  
detail band, but it is subordinate to the real detail band. For 

ant to print a list of audio CDs, and for each CD a title list should be 

the subdetail table. For each record in the master 
ble a subdetail list is printed. 

A subdetail band is a sort of 
example, if you w
printed, you would use a detail band for printing the CD names and connect a subdetail 
band to the titles dataset, so separate lists of titles are printed below each CD name.  
 

he following options are available for the subdetail band: T
 
Table:  
This is the dataset that is used by the subdetail band. 
 
Color:  
This defines the background color of the report band. 
 
Master:  
The master is the table superior to 
ta
 
Only print if expression is true: see  Standard bands. 
 
Print 

prints the subdetail records before printing their master 

 At bottom of page: moves the band to the bottom of the page before printing it 
 Print header/footer even if dataset is empty: header and footer bands of the 

band will be printed even if there are no subdetail data records to print 

 printing the band (when using 
reports with multiple columns) 

 

are printed. 

This footer after the subdetail data records have been printed. 

rame: see Standard bands

¾ Before master-detailband: 
record from the detail band 

¾
¾

subdetail 
¾ Force new page: starts a new page before printing the band 
¾ Force new column: starts a new column before

Headerband:  
This band is printed as a header before the subdetail data records 
Footerband:  

 band is printed as a 
 
F . 
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Group Band 
you 

ant to print a list of addresses, you can add some space before each new first letter 
or you can group addresses by city or state. 

 

 
ally, groups are handled the following way: Before printing a data record, the 

report engine checks if the expression

A group band is used to structure data into groups of data records. For example, if 
w
starts and insert some caption, 

Example 

Intern
 result of the group band is different from the last 

data record’s expression result. If this is the case, the group band will be printed, or else 
it won’t. This way data can be grouped with great flexibility, because you can use the 

aster:  
r the group. This can be either the detail band or a 
 each time the master band is printed. 

his defines the background color of the report band. 

pression

expression for nearly any kind of calculation. 
 
The following options are available: 
 
M
Defines which is the master band fo

. The group is checkedsubdetail band
 
Color:  
T
 
 
Expression: 
This ex  determines whether a group band is printed or not. The band will be 

ssion changes. 

age: starts a new page before printing the band 
w column: starts a new column before printing when using reports with 

 the next group band is printed. 

ndard bands

printed each time the result of the expre
 
Print 
¾ at bottom of page: moves the band to the bottom of the page before printing it 
¾ force new p
¾ force ne

multiple columns 
 
 
Footerband:  
This band is printed at the end of each group, before
 
Frame: see Sta . 
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The following picture shows a report with a group band (the bold printed single 
d on the group band) and a report without a group band on the right 

 

character is locate
side.  

 
 
Elements and Fie ........................................................ lds ........................................

Label 
A label is for printing static text, i.e., text that is printed exactly like it is displayed during 
report design. 
 
The following options are available: 

d be printed. You can only type in one line of text. Memos
Text: 
This is the text that shoul  can 

otation: 
your text. Rotation can be set to anything between 0 and 360 degrees. 

elects the font for the report element. 

be used for multi-line text. 
 
R
Use this to rotate 
90 degrees means displaying the text vertically, for example. 
Font: 
S
 
Color:  
Defines the background color for the report element (the font color can be set with the 
“Font” button). 
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Alignment: 
 element’s text can be aligned left, right or centered. 

utomatic word-wrap: 

he report element’s background will not be printed if this option is activated. This way 
e text on top of an image, for example, without hiding the image under a 

e report element to make room for its complete text. If “Autosize” 
 not set and the text is larger than the element size, text will be clipped off. 

tretched to make room for all lines. If needed, the report band will 

The report
 
A
Set this option if you want the text to wrap to the next line if it does not fit into the 
given width (similar to a word processor software).  
 
Transparent: 
T
you can plac
white box with text. 
 
Autosize width: 
This option resizes th
is
 
Autostretch height: 
This option is for report elements with multiple lines, e.g., memo fields. The height of 
the elements will be s
be stretched too. 
 
Memo 
A memo is used to print text that has more than one line. Just like a label a memo 

isplays text in one color and font. If you want to use formatted text, you can use a d
Richtext field. 

he following options are available: 

xt that will be printed. 

efines the background color for the report element (the font color can be set with the 
utton). 

The report element's text can be aligned left, right or centered. 
atic word-wrap: 

 
T
 
Text: 
This is the te
 
 
Font: 
Selects the font for the report element. 
Color:  
D
“Font” b
 
Alignment: 

Autom
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Set this option if you want the text to wrap to the next line if it does not fit into the 
ssor software).  

Autosize width: 
 the report element to make room for its complete text. If “Autosize” 

utostretch height: 
report elements with multiple lines, e.g., memo fields. The height of 

to make room for all lines. If needed, the report band will 
tched too. 

given width (similar to a word proce
 

This option resizes
is not set and the text is larger than the element size, text will be clipped off. 
 
A
This option is for 

e elements will be stretched th
be stre
 
Image 
An image element is a bitmap from a BMP file that is inserted into the report. 

u can use this report 
. 

 in this field, nothing will be 
type "bitmap," 
the data field's 

ontent and load it. 

element’s size, 
r else the picture will be cut off if there is not enough room, or space will be left empty 
 there is too much. 

: 

ent: 

 
While a datafield is for displaying text from a database record, yo
element to display images that are stored in a database
 
The following options are available: 
 
Datafield: 
The field that contains the image (if there is no bitmap
printed). If the datafield property is set to a database field which is not of 
the report engine will try to find a bitmap file whose name equals that of 
c
 
Stretch picture automatically: 
Activate this option to stretch the picture so it fits exactly into the report 
o
if
Center picture
If the report element is bigger than the picture and the “Stretch” option is not activated, 
the picture will be centered in the report element instead of being placed in the top left 
corner. 
 
Alignm
Aligns the image on the report band. 
 
Shape 
This report element can be used to draw (horizontal or vertical) lines, circles and 
rectangles.  
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The following options are available: 

ich can be a circle, rectangle, horizontal line, vertical line or 
p/bottom and left/right lines. 

rush: 
fferent styles to fill a circle or rectangle 

the shape 
 

ode:  
d, dotted or dashed lines 

 
System Field

 
Type: 
Selects the shape, wh
to
 
B
¾ Style: di
¾ Color: the color that is used to fill 

Pen: 
Width: line width of the shape 

various line drawing modesM
Style: soli

 
port element is used to display various system data like current time or date, page 

 options: 

d before the actual system data. For example you can use the 

ype: 
tem data to print. The following types are available: 

current date and time 

tle which can be set via “Report|Options” 

s the report element to make room for its complete text. If “Autosize” 
 not set and the text is larger than the element size, it will be clipped off. 

 

This re
number, etc. 
 
Available
 
Text: 
This text will be displaye
text “Report printed on:” when printing the current date. 
 
T
The type of sys
¾ Date: the current date when printing the report 
¾ Time: the current time when printing the report 
¾ Date/Time: the 
¾ Detail count: total number of data records 
¾ Detail number: number of the current data record 

Page number: current page number of the printout ¾ 
¾ Report title: the report ti
 
Autosize width: 
This option resize
is
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Transparent: 
The report element’s background will not be printed if this option is activated. This way 
you can place text on top of an image, for example, without hiding the image under a 

hite box with text. 

elects the font for the report element. 

). 

w
 
Font: 
S
 
Color:  
Defines the background color for the report element (the font color can be set with the 
“Font” button
 
Data Field 
A datafield displays data from the report table. This can be numerical data, characters or 
multiple lines of text. 

ata field: 
t. 

umerical data fields can be formatted by setting a format definition

 
The following options are available: 
 
D
Select the data field you want to prin
 
Alignment: 
The report element's text can be aligned left, right or centered. 
 
Format: 
N . 

 

olor:  
round color for the report element (the font color can be set with the 

option if you want the text to wrap to the next line if it does not fit into the 
iven width (similar to a word processor software).  

he report element’s background will not be printed if this option is activated. This way 
you can place text on top of an image; for example, without hiding the image under a 
white box with text. 

Font: 
Selects the font for the report element. 
 
C
Defines the backg
“Font” button). 
Automatic word-wrap: 
Set this 
g
 
Transparent: 
T
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Autosize width: 
This option resizes the report element to make room for its complete text. If “Autosize” 
is not set and the text is larger than the element size then text will be clipped off. 
 
Autostretch height: 

 for report elements with multiple lines, e.g., memo fields. The height of 

 printing of repeated values: 
with the same values 

data record, and 
ll following prints of this data field empty if the field’s content hasn't changed. 

d is 0: 
ion suppresses printing of numerical fields if their value equals zero. 

ated “Suppress printing of repeated values”, you can use this option to 
d if a new page starts, even if it would be suppressed normally because of 

es. 

 

This option is
the elements will be stretched to make room for all lines. If needed, the report band will 
be stretched too. 
 
Suppress
Activate this option if you do not want  to print data fields 

peatedly. The report engine will only print the data field for the first re
leave a
 
Suppress printing if value of data fiel
This opt
 
Reprint on new page: 

 you have activIf
reprint a fiel
equal valu
 
Reprint on new group: 
ame as “Reprint on new page” but for groups. S

Image from Data Field 
While a data field is for displaying text from a database record, you can use this report 

lay images that are stored in a database. 

ata field: 
tains the image (if there is no bitmap in this field, nothing will be 

 

element to disp
 
The following options are available: 
 
D
The field that con
printed). If the data field property is set to a database field which is not of type “bitmap,” 
the report engine will try to find a bitmap file whose name equals that of the data field’s 
content and load it. 
 
Stretch picture automatically: 
Activate this option to stretch the picture so it fits exactly into the report element's size, 
else the picture will be cut off if there is not enough room, or space will be left empty if 
there is too much.
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Center picture: 
If the report element is bigger than the picture and the “Stretch” option is not activated, 
the picture will be centered in the report element instead of being placed in the top left 
orner. c

 
Alignment: 
Aligns the image on the report band. 
 
Expression Field 
A calculated field (expression field) is used for displaying text or data that is calculated by 
an expression or formula. You can do numerical calculations, string manipulations, 
concatenate data fields and much more. 
 
Expression: 
This expression is evaluated each time the calculated field is going to be printed (see the 
chapter on expression syntax). 
 
Format: 

s can be formatted by setting a Numerical field format definition. 

efines the background color for the report element (the font color can be set with the 

 uses any aggregated functions

 
Font: 
Selects the font for the report element. 
 
Color:  
D
“Font” button). 
 
Master: 
If your expression , you must link the “Master” property 

 the dataset that will be used to update the expression. Each time a new data record 
pression will be recalculated. 

t: 
he report element’s text can be aligned left, right or centered. 

se this to rotate your text. Rotation can be set to anything between 0 and 360 degrees. 
ans displaying the text vertically, for example. 

to
from this dataset is selected, the ex
 
Alignmen
T
 
Rotation: 
U
90 degrees me
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Autosize width: 
s complete text. If “Autosize” 

 not set and the text is larger than the element size, text will be clipped off. 

his option is for report elements with multiple lines, e.g., memo fields. The height of 
retched to make room for all lines. If needed, the report band will 

 
 you are using calculations like sums or counting of data record etc., you can use this 

option if you want the text to wrap to the next line if it does not fit into the 
r software).  

kground will not be printed if this option is activated. This way 
p of an image, for example, without hiding the image under a 

hite box with text. 

This option resizes the report element to make room for it
is
 
Autostretch height: 
T
the elements will be st
be stretched too. 
 
Reset after print:
If
option to reset the value of the calculation to zero after the report element has been 
printed. 
 

utomatic word-wrap: A
Set this 
given width (similar to a word processo
 
Transparent: 
The report elements bac
you can place text on to
w
 
Richtext Field 
The richtext element is a
fonts, colors and formatting

 report element that can display multi-line text with different 
. In the richtext property dialog, press the Edit button to 

how a text editor with richtext editing capabilities. 

ets the text alignment if no alignment has been set with the editor. 

ets the font if no font has been specified with the editor. 

Autostretch height: 
This option is for report elements with multiple lines, e.g., memo fields. The height of 
the elements will be stretched to make room for all lines. If needed, the report band will 
be stretched too. 
 

s
 
Alignment: 
S
Font: 
S
Color: 
Sets the text color if no color has been set with the editor. 
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145 

Richtext from Data Field 
This report element displays richtext from a data field. The following options are 
available: 
 
Data field: 

 Select the data field to use by the report element.

Font: 
 specified with the editor. 

Keyboard and Mouse Shortcuts .............................................................................. 
he report designer can be used with the mouse most of the time. Some functions can 
lso be accessed with the keyboard: 

ursor keys: 

Del: 

 
Alignment: 
Sets the text alignment if no alignment has been set with the editor. 
 

Sets the font if no font has been
 
Color: 
Sets the text color if no color has been set with the editor. 
 
Autostretch height: 
This option is for report elements with multiple lines, e.g., memo fields. The height of 
the elements will be stretched to make room for all lines. If needed, the report band will 
be stretched too. 
 

T
a
 
Enter: 
Show the element’s property form. 
 
C
Move a report element. 
 
Shift + Cursor keys: 
Resize a report element. 

Delete a report element. 
 
Tab and Shift + Tab: 
Select next or previous report element. 
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Using the mouse 
 
Select a report element: 
Report elements are selected by clicking them with the left mouse button. A selection is 
shown with eight small black boxes around the element: 

 
 

elect multiple elements (a): 
t multiple elements by holding down the [Shift] key while selecting them 

 the previous selection will remain when a new 

Change the size of an element: 
You can use the small boxes of a selected element to change its size. If the mouse cursor 
is positioned over such a box, the cursor will change to show in which direction the 
mouse can be moved while the left mouse button is pressed down. The element will be 
resized accordingly. Please note that for report bands only the height can  be changed, 
but the width is set to the report width automatically. 
 
S
You can selec
with the left mouse button. This way
element is selected. 

 
Select multiple elements (b): 

se button, all elements within the frame are 
elected. 

ove elements: 
ements with the left mouse button. Hold down the button, drag 
ed location and release the mouse button. Report bands cannot 

e positioned automatically according to their band type. 

 
 

You can also select multiple elements by using a so-called “rubber band.” Hold down 
[Ctrl] together with the left mouse button and drag a frame around the elements that you 
want to select. After releasing the mou
s
 
M
You can move report el

e element to the desirth
be moved because they ar
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Move and resize elements regardless of the current grid setting: 
If you want to manipulate a report element regardless of the current grid (menu item 
“View|Options”) and move or resize by one pixel, then hold down the [Shift] key while 

oving the mouse. 

dit element properties: 
 element with the left mouse button, or if you select “Edit” 

pup menu (which can be accessed with the right button), a dialog 
element properties can be edited. 

 
Script Language Guide ........................................................................................... 

ed script language for creating “BeforePrint” and 
. You can use it to design reports with various 

mple, let’s say that you have a report printing a list of numbers, some of 

 the report editor (right-click 
n the band after you have selected it and choose “Scripts” from the popup menu): 

ing in the “BeforePrint” window: 
(Amount>=0) 
etFontColor(‘AmountDBText’,Black) 

SetFontColor(‘AmountDBText’,Red) 

 
’ is the 

ent which is linked to the Amount field in the dataset.  It is 
portant to note that each component on the report must be given a name if you wish 

mponent a name, right-click on the component 
tions.”  The first field displayed is Name.  This 

er a name for the component.  The name that is entered here is 
what you must use to access the component in script code. 

les

m
 
E
If you double-click a report
from the element’s po

own where all will be sh

Custom Reports comes with an integrat
AfterPrint” event handlers at runtime“

special features and advanced calculations. 
 
As a simple exa
which may be positive and some negative. Suppose you would like the positive numbers 
to appear in Black and the negative numbers to appear in Red.  For this you can write a 
script for the detail band’s “BeforePrint” event from within
o
You would enter the follow
if 
  S
Else 
  
Endif 

The above script will be executed before each line is printed.  ‘AmountDBText
name of the text compon
im
to access it through a script.  To give a co
after you have selected it and choose “op
is where you would ent

 
Variab  

riable in Script Language 
red, set and get with functions. Variables are global, i.e., you can set a 

event handler script and use it in another. You can even set a variable in 
e report and use it in a second report executed afterwards. Variables are not initialized 

 value when a report is generated.  
 
 

Using Va
Variables are decla
variable in one 
on
to some
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SETVAR 

 

ist, or else it will 
verwrite the value of the given variable. 

p’,’This is a test string’) 

ETVAR('Flag1',TRUE) 
 

GETVAR 

 
iable name as parameter. 

t type of GETVAR depends on what kind of variable (string, number, boolean) 
as been created/set with SETVAR. 

>0) 
N(FALSE) 

 
R('Num',GETVAR('Num')+1) 

('QRLabel1',GETVAR('Temp')+' !!!') 
 

ST function with the variable name as parameter.  

XISTS('Flag1')) 

 

e from memory, use the DELETEVAR function with the variable 
rameter. VAREXISTS will return FALSE for this variable afterwards. 

To set a variable, use the SETVAR function with variable name and variable value as 
parameter. SETVAR automatically creates a new variable if it doesn't ex
o
 
SETVAR(‘Tem
 
SETVAR('Num',1000) 
 
S

To get a variable value, use the GETVAR function with the var
The resul
h
 
GETVAR('Temp') 
 
IF (GETVAR('NUM')
  RETUR
  EXIT 
ENDIF 

SETVA
 
SetStringProp

VAREXISTS 
To check if a variable exists (i.e., has been created with a first call of SETVAR), use the 
VAREXI
 
IF (VARE
: 
: 
ENDIF
 
DELETEVAR 
To delete a variabl
name as pa
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DELETEVAR('Temp1') 

anguage Syntax Guide
 
Script L  
F...ELSE...ENDIF: 

 

NDIF 
 

the same line as the IF statement, but only on new lines. 

t code expression returning TRUE or FALSE, e.g., "IF 

amples:  
 

IF (Amount*1.16>800) 
  OKBox('Warning: Amount including VAT is larger than 800') 
ENDIF 
 
IF (YesNoBox('Print report now?')) 
  RETURN(TRUE) 
ELSE 
  RETURN(FALSE) 
ENDIF 

 
LOOP...ENDLOOP 

 
LOOP 
: 

I

IF (Condition) 
: 

NDIF E
 

 (Condition) IF
: 
ELSE 
: 
E

Note that between the "IF" and "(Condition)" there MUST be a blank. Do not place 
commands on 
 
"Condition" can be any scrip
(Weight>10)". 
 
The lines below the IF statement until ENDIF or ELSE are the commands to be 
executed if "Condition" evaluates to TRUE. 
 
Ex

149 Ch 12:  Using Custom Reports 



 

ENDLOOP 
ou can place expression commands between LOOP and ENDLOOP, and when 

OP statement, the script will start again at the line below LOOP. 
ou can exit the loop only by using the BREAK or BREAKLOOP commands (see 

SetVar('Temp',1); 

  BREAKLOOP 

 

REAK has no parameters; it just exits from the current IF or LOOP block instantly, 
P statement. Note 

nly exit from the IF statement, not from the 

the current loop, no matter if 
REAKLOOP is used from within one or more IF blocks. 

ript execution instantly. 
 

xpression) 

ripts result (a result is needed for the BeforePrint event: 
 confirm printing of the current band, FALSE to skip printing the band). 

Y
reaching the ENDLO
Y
below).  
 
Example: 
 

LOOP 
  SetVar('Temp',GetVar('Temp')+1); 
  IF (GetVar('Temp')>10) 
  
  ENDIF 
ENDLOOP 

BREAK 
 
B
continuing with the commands following the ENDIF or ENDLOO
that in the above example, break would o
loop. 
 
BREAKLOOP 
 

his is the same as BREAK, only that it exits from T
B
EXIT 
 
EXIT has no parameters. It just completely exits the sc

RETURN 
 
RETURN(E
 
RETURN sets the current sc
TRUE to
"Expression" must evaluate to TRUE or FALSE. 
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Example: 
 
RETURN(FALSE) 

 
the band if the WEIGHT data field value is 

reater than 10. 
 

Checks if a report element with the given name exists.  

 
d1','Enabled',False) 

BoolProp('MyShape','Enabled',True) 

ponentName, PropertyName, PropertyValue) 
c property for a component. 

xample: SetIntProp('Band1',Height,200) 

tyValue) 
Sets a floating point property for a component. 

ets a string property for a component. 

tName, PropertyName, PropertyValue): Boolean 

Name): Integer 

 
etailBand','Height')) 

 
RETURN(Weight>10) 

The second example would only print 
g

ElementExists(Name: String): Boolean 

Example: ElementExists('Label1') 
 
SetBoolProp(ComponentName, PropertyName, PropertyValue) 
Sets a boolean property for a component. 

Example: SetBoolProp('Childban
                    Set
 
SetIntProp(Com
Sets a numeri
E
 
SetFloatProp(ComponentName, PropertyName, Proper

 
SetStrProp(ComponentName, PropertyName, PropertyValue) 
S
Example: SetStrProp('Label1','Caption','This is a test') 
 
GetBoolProp(Componen
Reads a boolean property from a component. 
Example:  
IF (GetBoolProp('DBText1','Enabled)) 

SetColor('DBText1',Black)   
ENDIF 
GetIntProp(ComponentName, Property
Reads a numerical property from a component. 

Example: SETVAR('LastBandHeight',GetIntProp('D
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GetFloatProp(ComponentName, PropertyName): Float 
Reads floating point property from a component. 

: String 
eads a string property from a component. 

 
') 

nd an OK button. 
 

e: OkBox('Fasten your seat belts') 
kCancelBox(Text: String): Boolean 

nd both an OK button and a CANCEL 
utton. Returns TRUE if the OK button has been pressed, FALSE otherwise. 

IF (OkCancelBox('Print now?')) 

LSE 

esNoBox(Text: String): Boolean 
. 

 
leName): Boolean 

ser must type in a value that is stored in the given variable. 

a 
e, 

, Lime, Blue, Fuchsia, Aqua, White. You can also 

                    SetColor('Childband2',87123) 

 
GetStrProp(ComponentName, PropertyName,)
R

Example: GetStrProp('Expr1','Caption
 
OkBox(Text: String) 
Shows a message dialog with the given text a

Exampl
O
Shows a message dialog with the given text a
b
Example:  

  Return(True) 
E
  Return(False) 
ENDIF 
 
Y
Same as "OkCancelBox" but with "Yes" and "No" buttons

InputBox(Title, Text, Variab
Shows an input dialog. The u
 
Example: InputBox('Input start date','Start date:','VDate') 
 
SetColor(Name, Color) 
Sets the (background) color of the given report element. The color parameter is 
numerical value, but the following constants are available: Black, Maroon, Green, Oliv
Navy, Purple, Teal, Gray, Silver, Red
use the RGBCOLOR function (see below). 
 
Example:     SetColor('Childband2',Yellow) 

                    SetColor('Childband2', RGBColor(255,0,128)) 
 
RGBColor(Red, Green, Blue): Integer 
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This function creates a color value for use with SETCOLOR and SETFONTCOLOR 
from red, green and blue parts. 

. 

given component. Please see the description of SETCOLOR 

 

 
Example: SetFontSize('TitleLabel',24) 

font style (bold, italic, underline and strikeout) for a given component. Each 

 

 
Example: RGBColor(64,0,0)       (gives a dark red) 
 
SetFont(ComponentName, FontName) 
Sets the font for a given component
 
Example: SetFont('Label1','Arial') 

etFontColor(ComponentName, Color) S
Sets the font color for a 
above. 
 
SetFontSize(ComponentName, Fontsize) 

Sets the font size for a given component. 

 
SetFontStyle(ComponentName, IsBold, IsItalic, IsUnderline, IsStrikeout) 
Sets the 
style is a boolean (true/false) parameter that must be set to TRUE for activating it. 
 
Example: SetFontStyle(DBText1,true,false,false,false) 

Script Code Examples 
Displaying column totals 

se for the script code is to total a column.  To accomplish 

ollowing bands on your report: title or column header band, detail band, 
ummary or group footer band. 

ollowing code to the “BeforePrint” event of the title or column header band: 
ETVAR(‘COLUMNTOTAL’, 0) 

The above line simply creates a variable named COLUMNTOTAL and sets it to 0. 
Add the following code to the “BeforePrint” event of the detail band: 
SETVAR(‘COLUMNTOTAL’, GETVAR(‘COLUMNTOTAL’) + Table1.COST) 

 
The above line does the following:  Sets the variable COLUMNTOTAL equal to itself 
plus the COST field of Table1 (Table1 is the generic name of all Custom Reports 
datasets).  The above line of script code will execute once for every line of data in the 

Probably the most common u
this is quite easy.  Follow these steps to total a column.  This example assumes you have 
at least the f
s
 
Add the f
S
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dataset.  Because of this, it keeps adding the cost to the running total of the 
COLUMNTOTAL variable. 
 
The next step is simply to display the COLUMNTOTAL variable in the summary or 
group footer band.  Add an Expression field component to either the summary or group 
footer band.  Add the following code to the Expression field: 
GETVAR(‘COLUMNTOTAL’) 

 
The above line simply returns the value stored in COLUMNTOTAL and it is displayed 
in the summary or group footer band. 
 
Displaying Row Totals 
Displaying totals across rows is somewhat easier than column totals and requires script 
code to be added to only one event:  the detail band.  Begin by adding the following line 
of code to the “BeforePrint” event of the detail band: 

 
SETVAR(‘ROWTOTAL’, Table1.VALUE1 + Table1.VALUE2 + 
Table1.VALUE3) 

 
Substitute VALUE1, VALUE2, VALUE3 with the names of the fields you wish to add.  
If you want to add more or less than 3 fields, simply continue the same pattern as shown 
above.   

 
The above line declares a variable named ROWTOTAL and sets it equal to the sum of 
VALUE1 + VALUE2 + VALUE3.  The variable now contains the proper total that 
needs to be displayed.  Remember that any code added to the detail band will fire once 
for every record in the dataset.  The above line of code will add the three fields for each 
record.  Add an Expression field component to the detail band.  Add the following code 
to the Expression field: 
GETVAR(‘ROWTOTAL’) 
The above line simply returns the value stored in ROWTOTAL and it is displayed in the 
detail band. 
 
See Appendix C for tutorials on editing a template, and creating a report from 
scratch. 
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Creating Reports Through Other Software ............................................................. 
 
You may create reports through other report writer software, such as Crystal Reports 
(sold separately.) In order to do so, you will need to set up a guest user account. A guest 
user account will allow access to specific tables within the database. 
  

 

Guest User 
Account 

 
Setting up a Guest User 
To set up a Guest User account, follow these steps: 
 From within the program, click Settings, Guest Users. 
1. Click New. 
2. Enter a Login Name. 
3. Enter the users Full Name. 
4. Enter a Password. Then enter it again to verify the password. 
5. Select the Table Name for the user to have access to and click in the Access block 

where it has “No Access”. For example, to give Read, Write, Delete access to 
AbsenceClasses, click on “No Access”, then click on the down arrow and select 
Read, Write Delete. 

6. Follow step 5 to set up access to each table with the appropriate access. 
7. Click Save.  
8. Clicking Edit will allow you to make changes to the record. 
 
Once guest user access is set up, the user may connect to the Optima database through 
other report writer programs. The report writer must have an ODBC driver that is 
compatible with Interbase 6 Dialect 3. (We recommend EasySoft’s ODBC-Interbase 6 
Driver, available at www.easysoft.com.) 
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Chapter 13: 
Importing and 
Exporting Data 
 
 
The Optima programs allow you to import and export basic employee data. Optima 
Time Clock also allows you to export data from within the program.  
 

Chapter Contents: 

 
Overview ....................................................................................... 158 

Features ......................................................................................... 158 

Required Fields ............................................................................ 159 

Importing ...................................................................................... 159 

Exporting ....................................................................................... 160 

Export Time Clock Data .............................................................. 161 
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Overview ................................................................................................................ 
The import function allows you to add new data from a text file into the Optima 
program. Conversely, the export function allows you to export data from the Optima 
program. 
 
The software that you export your data from must be able to export the required 
information to a Tab delimited or fixed length text file. See Appendix D for the required 
import fields. Please note that we cannot provide support for other software program(s). 
Please contact the software vendor or manufacturer for more information on how to 
export data from your other software. 
 

 

Import Screen 

Features .................................................................................................................. 
Feature Description 

Load File  Loads the selected file into the data window. 
Test  This tab will not highlight until a file is loaded. This 

checks for blank records and ensures that the 
department and location names that are being 
imported are already in the database.  

Import This tab imports the file into the database.  
Help This brings up the Help file pertaining to Importing. 
Close This closes the Import screen and takes you back to 

the main screen. 
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Feature Description 

Import File  This allows you to enter the path or navigate to the 
file you will be importing.  

File Type  This allows you to select the file type.  
a. Tab Delimited – We recommend exporting 

or importing as this type of file.  
b. Fixed Length – Optima may export or 

import fields with a fixed length. See 
Appendix D on the field lengths.  

Skip First Line  This will take out the first row, in case you have 
headers. 

Check Duplicates  This allows you to check for duplicates against the 
import file and the files already in the database. 

 

Required Fields ....................................................................................................... 
The following are required fields for importing: 
¾ Last Name 
¾ First Name 
¾ Location – name must be in the Optima database prior to importing 
¾ Department - name must be in the database prior to importing 
¾ Date of Hire 
¾ Full/Part Time 
¾ Active Status (Active, Inactive, or Terminated) 
NOTE: Location and Department names must be created within the Optima program 
BEFORE importing! 
 

Importing ............................................................................................................... 
To import your information, follow these steps: 
 
From within the program click File > Import. 

1. Enter the path of the file or click on the  to navigate to it.  
2. Select Tab Delimited or Fixed Length. This should correspond with the way the 

import file was saved.  
3. Select Skip First Line if you have title headings.  Do not select Yes if you don’t 

have title headings or you may lose the first line of data.  
4. Click Load File to preview the file. At this point you should check that all column 

headings match the fields that will be imported.    
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Import (After Loading 
File) 

Note the column titles above: SSN, Lastname, Firstname, and Middlename;  check each 
column to make sure the appropriate data is in the correct column. For example, the 
SSN number should have an 11-digit number, plus two hyphens. 
5. Select which fields to check for duplicates in the Check Duplicates box. Duplicates 

will be checked during the Test File phase. 
6. Click Test File. This checks for blank required fields, and in the case of Location 

and Department, it checks to make sure that the name of the Location and 
Department has already been set up within the program.  

CAUTION:  If duplicates are detected and you click on Import, these fields will be 
imported into the program.  
7. Once it passes the Test portion, you will be able to click on Import File.  
 

Exporting ................................................................................................................ 
The export feature is used to transfer basic employee information into a text file that 
you can open in any word processor or spreadsheet application. Only the basic 
information (see Field Layout in Appendix D) will be exported.  
To export your information, follow these steps: 
1. Click File > Export. 
2. Select Tab Limited or Fixed Length for the Export File Type. 
3. Enter a path and file name or keep the default name. 
4. Click Export.  
 
Your export file will be created as the file designated in the file block. You may rename 
the file, but we recommend keeping the file extension of .txt. After exporting, you may 
open the file from within any other spreadsheet or word processor program.  
 
NOTE: Only the information in the Field Layout  (Appendix D) will be available for 
export.  
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Export Screen 

 
Export Time Clock Data ......................................................................................... 

 

Export Time Clock 
Data Screen 

 
The Time Clock Export feature allows you to export the following data: 
¾ Last Name ¾ Location 
¾ First Name ¾ Department 
¾ Middle Name ¾ Punch Hours 
¾ SSN ¾ Punch Changes 
¾ Date of Birth  
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Feature Description 

Export Type Single File – Exports Employee Data and Hours 
Worked to a single file. If Export Punch Changes is 
selected, it will export to a separate file.  
Relational File – Exports Employee Data and 
Hours Worked to two separate files. If Export 
Punch Changes is selected, it will export to another 
separate file.  

Export This allows you to export the data. 
Select Employee to Export  This allows you to select specific employees, 

locations and/or departments to export. 
Hire Range Filter  This allows you to filter on a specific hire date range.  
Job Status Filter  This allows you to filter on full and part time. 
Employee Status Filter  This allows you to filter on Active, Inactive or 

Terminated employees.  
Select Employee Data Fields 
to Export 

Available Fields – This is the list of fields to 
choose from. 
Fields to Export (In Export Order) – This is the 
chosen field. 

Export Time Clock Data  Export Hours Worked for Period – This allows 
you to select a date range for time card data for the 
selected employee(s). 
Export Punch Changes – This allows you to 
export punch changes. 

 
To export data, follow these steps: 
1. From the File menu, select Export Time Clock Data. 
2. Select the export type: Single File or Relational. 
3. Expand the tree, if necessary, and select the employees to export. 
4. Select the data fields to export by either double-clicking on the file, or selecting the 

file and clicking on the arrow pointing to the right. 
5. If needed, select the Export Hours Worked option with a date range. 
6. If Export Hours Worked is selected you can select to Export Punch Changes 

option. 
7. Click Export.  
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Chapter 14: 
Getting Help 
 
 
This chapter shows you how to get help throughout the program and contact 
information if you need to email or phone G.Neil Technical Support.  
 

Chapter Contents: 

Overview ....................................................................................... 164 

Before Contacting Technical Support ..................................... 165 

Contact Technical Support ........................................................ 165 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

163 Ch 14:  Getting Help 



 

Overview ................................................................................................................ 
There are several ways to get help throughout the program.  
 
Sample Database  
A sample company (called a tutorial database) is provided so that you may view the 
different screens with sample data already filled in. It is recommended that you use the 
program with the tutorial database in order to get a feel for the program without having 
to worry about altering live data. When you are in the tutorial database, no changes are 
made to your live database. To open the tutorial database select Start, Programs, 
G.Neil, Sample Database. 
 
The Help Menu 
From the Help menu, select Contents. A listing of help topics is displayed.   Select the 
Book that interests you (using a double-click) and then double-click the topic you wish to 
display.  
 
The F1 Key 
Pressing the F1 key is another way to obtain help within the program.   From most areas 
of the program, pressing F1 will display the topic associated for that screen.  
 
Searching for Help 
You can search for Help two different ways using the Help File.  
Method 1 – From the Help menu, select Search for Help on.   The Help Topics Index 
will appear.  Select the Topic that interests you.  
 
Method 2 – From the Help menu, select Contents.  Click the Find Tab.  If you have not 
used this feature before, the Find Setup Wizard will walk you through setting up the 
search index.  Once the search index has been created, type in the Keywords you would 
like to search for and the results will be displayed.  
 
A list of typical errors or messages that were known at the time of publication are listed 
in Appendix B - Troubleshooting.  
 
For more complete information, please refer to one of the following: 
¾ Readme. txt file located in the c:\program files\gneil optima\time8 program 

directory.  
¾ Help File located in c:\program files\gneil optima\time8 or accessible from the 

Start Menu.  
¾ Internet Site www.gneiltechsupport.com 
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Before Contacting Technical Support ..................................................................... 
Please follow these guidelines before contacting Technical Support: 
¾ Remember G.Neil does not support setting up networks or computer 

configurations.  
¾ If you are having problems with your computer, try rebooting first to see if that 

corrects the issue.  
¾ If you are getting an error message, please write down the whole message or take a 

screenshot of it.  Pressing the PrintScrn button on your keyboard will copy the 
screen to the clipboard; you may then open MS Word or Wordpad and paste it to 
the document.  From here you may print it out.   

¾ If you are having problems with our program (getting error messages, program 
locking up, other strange things happening), please write down the steps to recreate 
the issue.  This will speed things up when talking with a support representative.  

¾ To get help in a timely manner, check the manual (Troubleshooting section), help 
files within the program, and our Web site at www.gneiltechsupport.com for 
known issues, and help on using the program.   

¾ If you do have to call, be near the PC and have the following available: 
 G.Neil Account Number 
 Program Name 

Program Version Number (you may find this by going to Help > About from 
within the program) 

 Full error message and steps to recreate, if possible.  
  

Contacting Technical Support ................................................................................ 
 

Technical Support for Optima Time Clock is available as follows: 
Internet  http://www.gneiltechsupport.com
E Mail Requests techsupport@gneil.com
Phone Requests (888) 925-7740  (8:30 AM to 6:00 PM, EST, M-F) 
Fax Requests  (954) 851-1214 
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Appendix A: 
Rounding Examples 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

30 min = .5 

12

6

39 15 min = .25 

8 min 

12 

6 

39 

6 minute mark = .1 

Marks in minutes with decimal equivalent 

3 min 

The 6-minute rule rounds 
up or down to the nearest 

6-minute mark. 

45 min = .75 

54 min = .9 

12 min = .2 

18 min = .3 

24 min = .4 30 min = .5 
36 min = .6 

42 min = .7 

48 min = .8 

15-Minute Rule 

6-Minute Rule

The 15-minute rule rounds 
up or down to the nearest 

15-minute mark. 
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Decimal Conversion Table 
 
 
 
 

1 2 3 4 5 6 7 8 9 10 
.0166 .0333 .05 .0666 .0833 .1 .1166 .1333 .15 .1666 

Minutes

 
11 12 13 14 15 16 17 18 19 20 

.1833 .2 .2166 .2333 .25 .2666 .2833 .3 .3166 .3333 
 

21 22 23 24 25 26 27 28 29 30 
.35 .3666 .3833 .4 .4166 .4333 .45 .4666 .4833 .5 

 
31 32 33 34 35 36 37 38 39 40 

.5166 .5333 .55 .5666 .5833 .6 .6166 .6333 .65 .6666 
 

41 42 43 44 45 46 47 48 49 50 
.6833 .7 .7166 .7333 .75 .7666 .7833 .8 .8166 .8333 

 
51 52 53 54 55 56 57 58 59 60 
.85 .8666 .8833 .9 .9166 .9333 .9166 .9666 .9833 1.0 

 
 
 
 
The above marks in gray designate minutes with the decimal equivalent below them. Semi-gray designate 
minutes that are equally divisible by 60.  
 
The formula for getting the decimal number is minutes divided by 60.  
 
Optima Time Controller automatically converts the time entry minutes to decimals. For example, if Joe had 
worked 8 hrs and 30 minutes, Optima Time Clock would show this as 8.5 hrs. This makes it easier for payroll 
purposes. 
 

 
 

Decimals

167 Appendix A 



 

Appendix B: 
Troubleshooting 
 

 
Here are the most common issues that you may experience when using Optima.  

 
¾ Unable to connect to Interbase Server 
¾ Getting SQL Parse Error: EOF in String Detected message when logging in 
¾ Unable to install on a Win NT or 2000 system 
¾ Exceeded the authorized user count 
¾ Moving database from one location to another 
¾ Installing Optima files to another drive other than c:\ 
¾ Installing Update from one location 

 
Unable to connect to Interbase Server    
Users affected 
Optima Attendance Controller 
Optima Confidential Employee Record 
Optima Time Clock 
 
Issue 
When launching one of the programs above the following message may be encountered: 
 
"This program was unable to connect to your Interbase Server. This is likely due to the 
fact that the default Interbase User Account has been change. Please provide a 
UserName and Password with Administrative Privileges to Interbase." 
 
Description 
Users may encounter this issue for one of the following reasons: 
If running from a Server: 
1. If you're using an NT server and trying to install the database files to a drive other 

than C:\, permissions to the database folder may be incorrect. 
 
If running from a Standalone Computer: 
2. Interbase Guardian may be shut down 
 
3. If running from a Client Workstation: 
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4. Incorrect Server Name and/or Database Path 
5. Client needs to have TCP/IP installed 
6. Server may be down 
Possible Resolution 
1. If running Optima from a Server and encountering the above issue, try each of these 

solutions: 
 
Check your permissions for the Database folder. Full Control access must be given to 
System for the database folder. You may add to the Permissions by going through 
Windows NT Explorer and going to Properties by right-clicking the database folder. 
 
2. Check to make sure Interbase Guardian (or Interbase Manager) is running. 
On a Win 95/98 system there will be an icon in the system tray (next to the clock). The 
icon graphic appears as a gray tower with a green flag. When you put your mouse over 
the icon it will read, "Interbase Guardian". This icon will not appear on a Win NT/2000 
system. You may check to see if it is running on a Win 95/98/NT/2000 system by 
clicking on Start, Settings, Control Panel and clicking on the Interbase Manager. If it is 
not running click on Start (from within the Interbase Manager), then try to open the 
Optima application again. 
 
3. If encountering the message when running from a Client Workstation, try this: 
Check the Server Name and Database Path by going to the Server, opening the Optima 
application and clicking on Help, System Information and printing out this information 
from the TechSupport Tab. (If you don't have the TechSupport Tab then you have an 
earlier version of Optima and will need to do a screenshot of the System Information 
screen and Current Users screen and print them out.)  
 
Once you have the Server information, go to the Client Workstation that you cannot 
connect to the Server with. From the Workstation, click on Start, Run, and enter: 
HRWARE.INI. Verify that the Server Name and Database path are the same. 
 
NOTE: The printout of the Server Name and Database path you were asked to print or 
write down when installing the Server side must be exactly the same when entering this 
information on the Client Workstation(s)!  
 
4. The Client needs to have TCP/IP installed. 
This is done through the Network Neighborhood Properties. Please see your Network 
Administrator if you need more assistance in setting this up. 
 
If everything is the same on the Client as it is on the Server and you're still unable to 
connect then try this: 
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If your Server has a static IP Address, try entering this for the Server name when 
installing to the Client Workstation. 
 
5. If running from a Client Workstation and you went through the steps above and it 

didn't fix the issue check with your MIS or Network Administrator regarding the 
status of the Server. 

 
Getting SQL Parse Error: EOF in String Detected   
  
Issue: Getting an error message when logging in.  Receive the following error message 
when logging in: SQL Parse Error: EOF in String Detected 
 
Description: This is caused when pressing the comma key ( ‘ ) and Enter key at the 
same  
 
Possible Resolution(s):  
Avoid pressing the comma and Enter key at the same time.   
 
Unable to install on a Win NT or 2000 system    
Issue: Doesn’t finish installation 

 
Description: This usually happens if you do not have full administrator rights on the 
Win NT or 2000 computer. 
 
Possible Resolution(s): 
Make sure you have full administrator rights before installing.  
 
Exceeded the authorized user count    
Issue: 
You have exceeded the authorized user count. Your product license allows up to 
[number of licensed users] simultaneous users. There are # connections at this time. 
 
The # connections is a number greater than one that changes each time you close and 
reenter the program. 
 
Description: 
Users may experience this issue when closing the program by clicking Exit under the File 
menu. Users who exit the program by clicking the close window icon in the top right 
corner will not experience the problem, but we still recommend downloading and 
installing the latest update.  
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Possible Resolution: 
Download and install the latest Optima program from our Updates area on our Web site 
at: www.gneiltechsupport.com. 
 
Please follow the installation instructions. After downloading and installing the update 
follow the steps below to clear the connections. 
 
1. Close Optima and any other G.Neil Programs that are open. 
2. Open DB Monitor and log in, if it is not already running. The DB Monitor resides 

on the computer where the Optima database is installed. 
3. Click the Connections button. 
4. Click the Refresh button to verify all connections are "N" (not active).   
5. If all connections are "N", then Click the Clear Inactive Connections button, this 

will reset the connections.  
6. If you wish to close the DB Monitor (not recommended if you have automatic 

database backups scheduled), right-mouse click on the icon G.Neil Database 
Monitor located in the system tray area, select Shutdown Database Monitor, and 
click OK to close DB Monitor. 

7. Otherwise, click the Hide button. 
 
Moving Database from One Location to Another 
Issue: 
Need to move your Optima database from one computer (or drive) to another.  
 
Description: 
You may need to move the Optima database because of receiving a new computer, new 
operating system, or running out of disk space among other reasons.  
 
Possible Resolution: 
The easiest way to move the database is to make a backup of your current database, 
install Optima on the new computer, and restore the database. Follow the detailed 
instructions below:  
1. From the current database backup your files from within the Optima program by 

going to File > Maintenance > Backup Database or using the DB Monitor (go to 
Start > Programs > GNeil > Maintenance > DB Monitor > Backup). Put this file in 
a location where you can get to it from the new computer. For example, onto a 
shared network drive or Zip Drive.  

2. On the new computer, whether installing to a Standalone Computer or Client-Server 
environment, we recommend installing Optima using Custom as the Setup Type and 
Server as the Install Type. This will put a blank database at that location. Restore the 
database (from Step 1) using the DB Monitor. When restoring, you can only restore 
from the computer where the database resides. You will not have the option in the 
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DB Monitor to restore from a Client Workstation. Note: When going through as a 
Server Install, this will give you the Server Name and Database Path. Write this 
information down or print it out if you have client workstations that need to 
connect to the database.  

3. To point the Client Workstation(s), if applicable, to the new location launch the 
Optima program from the Client and enter the Server Name and Database Path 
(from Step 2) when it asks for it.  

 
Please contact G.Neil Tech Support if you’re having problems installing or connecting to 
the database. Note: G.Neil Tech Support cannot assist you with Network issues, such as 
setting up network access rights or checking your TCP/IP connection, but they may be 
able to give suggestions to common issues. 
 
Installing Optima Files to Another Drive Other than C:\ 
Issue: 
Installing Optima files to another drive other than the C:\ drive 
 
Description: 
Sometimes installing to the C:\ drive is not feasible. It may not have much space left or 
it’s not meant for database files.  
 
Possible Resolution: 
When installing Optima there are three different sets of files that get installed: Program 
Files, Database Files and Database Engine Files (Interbase). When choosing Custom 
Install, you may select the location for the Program and Database Files that get installed 
at the same time. Interbase will automatically install to the c:\ drive after you click on the 
first Finish button. If this is okay, then you only need to follow Step 1 below and click 
on Finish. Otherwise, if you also want to install Interbase to another drive, then follow 
all of the below steps: 

 
1. Run the installation of the selected Optima program (such as Optima Attendance 

Controller, Confidential Employee Record or Time Clock. When going through the 
installation process, choose Custom for the Installation Type. For the next two 
screens (Program Files and Database Files Location), click Browse to choose where 
to install them.  

 
2. Stop at the point where it says FINISH. Do not click on it. Leave the install window 

open at this screen. Open Windows Explorer and go to the Windows Temp 
directory. 

 
3. From the Windows Temp directory locate (or do a search for) IBWin32setup.exe. 
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4. Double-click on this file to start the installation process. This will install the 
database engine files (Interbase) and give you the ability to install these files to 
another drive other than C:\.  

 
Install Update from One Location  
Issue: 
When a new update is released, you must install at each client workstation(s) and at the 
database server. These instructions will show you how to set up the Optima folders to 
only install the new update once from one central location.  
 
Description: 
Setting up one shared directory for the program files will make updates quicker and 
easier.  
 
Possible Resolution: 
These instructions will explain how to set up the Optima program files in one shared 
location to make updating easier: 

 
1. Copy the Optima installation file(s) to a shared directory. The Server and all 

workstations that will have (or already have) Optima installed should have access to 
this shared directory on the network. If you downloaded the Optima update from 
our Web site (www.gneiltechsupport.com), then you will only have one file. If you 
have an Optima CD then you will need to copy the appropriate Optima program 
keeping all of it’s folders intact. For example, while navigating the Optima CD 
through Windows Explorer, under the BIN folder, you would copy the Atcon70 
folder to the shared directory.  

2. From the Server (or computer where the database resides), navigate to the shared 
directory, and run the Server installation (even if the Optima program is already 
installed on the Server) by following these steps: 
a. At the Setup Type, select Server. Click Next. 
b. At the Installation Type, select Custom. Click Next. 
c. At Select Components, leave the defaults. Click Next. 
d. At the Program Files Location, click Browse and navigate to the Shared 

directory. Add   \Optima   to the end of the Path. 
e. At the HRWare Database Files Location, click Next. 
f. Write down or print the Server Name and path. These will be needed for the 

Client installs. Click Close, then Next. This will install the Server files. 
g. If the Interbase install starts up, click Next to install it, otherwise, go to Step 

H. 
h. Go to Client Workstation. 
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3. From the Client Workstation, navigate to the shared directory, and run the Optima 
installation (even if the Optima program is already installed on the Workstation) by 
following these steps:  
a. At the Setup Type, select Client. Click Next. 
b. At the Installation Type, select Custom. Click Next.  
c. At Select Components, leave the defaults. Click Next. 
d. At the Program Files Location, click Browse, and navigate to the \Optima 

shared directory created during the Server install. Click Next. 
e. At the Database Server Information screen, enter the Server name and 

database path exactly as shown from the Server install.  
f. Click Next. This will install the program files. 
g. Follow the above steps for any other Client Workstations that will have 

Optima installed. 
 
When the above steps are completed once, then when you need to install an update, 
only steps 1 & 2 (a-g) need to be completed. All users must exit the Optima program(s) 
before updating. All of the shortcuts on the Client Workstations will be pointed to the 
shared directory that will be updated when the Server install is completed. 
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Appendix C: 
Custom Report 
Tutorials 
 
 
Tutorial #1 Modifying a Custom Report Template  
A step-by-step guide to modify a custom report template. See Tutorial #2 for creating a 
report from scratch. 
 
NOTE:  You may use Optima Time Clock, Attendance Controller or Confidential 
Employee Record for this tutorial.   
 
GOAL OF THIS TUTORIAL: This tutorial will show you how to create a custom 
report by using a provided template to remove a standard report field and add a new 
field. 
 
Specifically, we will be removing Date of Birth and adding Social Security Number to the 
Employee Summary report. 
 
1. TASK: Launch the Optima program. 
 
2. TASK: From the main menu, select Reports > Employee > Summary. 
 
3. TASK: Click on the Custom Icon. 
 
TASK: From the Custom Report main window, click on the Edit Report button. 
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. You are now presented with the report editing screen shown below.  You will notice 
 customizing a 

 
TASK:

4
that the field label says “Your Company Name.”  Your first step in
template should be to replace this label with your company name. 

  Click on the field “Your Company Name.” 

ASK:
 
T   In the label field, type “Tutorial Company” or enter your company’s name. 

 

Custom Report Interface

Custom Report 
Design Screen 
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5. The next step is to remove the Date of Birth from the report. 
 

ASK:T   Click on the top DOB label. 
 
TASK:  Select Edit from the main menu; select Delete as shown below. 

 

 
 

TASK:  Click on the DOB data field. 
 
TASK:  Select Edit from the main menu; select Delete as shown below. 

 

 
 

6. You have now deleted the date of birth heading and data field from the report.  The 
next step will be to add the social security label and field to the report. 

ASK:
 
T   Click on the label button circled below, and click in the “Column Header” band 

 

Selecting Delete 
from
Me

 the Edit 
nu 

as in the arrow below. 
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7. You are presented with the Label Dialog Box shown below. 
 
TASK:  Enter “SSN” in the label field circled below. 
TASK:  Click the FONT button circled below. 

ASK:T   Select BOLD for the font style. 
TASK:  Click OK to close the font window. 
TASK:  Click OK to close the label dialog box. 
 

 
 

8. The next step is to add the DOB data field. 
 
TASK:  Click on the datafield button circled below and click in the “Detail” band as 
shown below. 

 

Selecting the 
Label button 

Label Dialog Box  
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9. You are now presented with the
 

 datafield dialog box shown below. 
 
TASK:  Select “EESSN” from the list of available fields as shown below. 
TASK:  Click the OK button. 

 

 
 
Your completed layout should now look similar to the screen below: 

 

Selecting the 
Datafield button 

Datafield Dialog Box 
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10. You can preview your results. 
TASK:  Select File > Preview from the main menu. 
 
Your preview should look similar to the preview shown below. 
TASK:  Click the Close button to close the print preview window. 

 

 
 

 
TASK:

11. The next step is to save your changes. 

  Select File > Save as from the main menu. 
TASK:  Enter “Custom Tutorial Report” as shown below and click Save. 

 
12. You have now completed this tutorial. To return to the main program, follow these 

steps: 
TASK:  Select File > Exit from the main menu. 
 
TASK:  Click Close on the Custom Report Interface. 

Completed Custom 
Layout 

Print Preview 
Screen 
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Tutorial #2  Creating a Custom Report from Scratch   
 
A step-by-step guide to creating a custom report from scratch. 
 
NOTE: You may use Optima Time Clock, Attendance Controller or Confidential 
Employee Record for this tutorial.   
 
GOAL OF THIS TUTORIAL:  This tutorial will show you how to create a custom 
report from scratch using the Custom Reports, custom-reporting tool provided in the 
Optima programs. 

 
1. TASK: Launch the Optima program. 
2. TASK: From the main menu, Select Reports > Employee Detail. 
3. TASK: Click on the Custom Icon. 
4. TASK: From the Custom Report main window select New Report. 

 

 

Selecting New Report 
from Custom Reports 
Interface 

 

 a report wizard.  The report wizard 
 tutorial, we will not 

rd are provided in your Custom 
Reports documentation.  

 

5. The screen shown below is the Custom Reports Design Window.  This window is 
used for report creating and updating.  When you select New from the main 
window, the designer first presents you with
assists you in creating a basic report.  For the purposes of this
be using the wizard.  Instructions for using the wiza
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TASK: Select New blank report and Click Next. 
 

 
 
6. We are now ready to begin designing our report.  Data reports are designed with 

.  Let’s start with the first band common in most 
reports: The Title Band. 

report bands.  A report band is an area of data or text, which will repeat based on 
criteria we set at design time

 
TASK: Click on the Band button circled in the screen shot below.   
TASK: Click anywhere on the design page to drop the band on the page.  (The design 
page is the white area filling the center of the window with grid lines.) 

 

 
7. We are now presented with the “Band Editor” window. Note the Type of band is 

set to Title. This window has many advanced options which are covered in the 
Custom Reports documentation. 

TASK: Click OK to place the Title band on the design page.   

Selecting New Blank 
Report 
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8. The design page should now contain BAND1 as shown below.  You will notice that 

BAND1 also shows that it is a Title band.  Any text and/or data which is placed in 
the title band will be the first thing printed on your report.  It will print only on the 
first page of the report – hence the name “Title.” 

 

 
9. We will be designing an employee mailing list report; therefore, we want the title of 

our report to say “Employee Mailing List.”   
TASK: Click on the Text button circled in the screen shot below.   
TASK: Click in the middle of the Title Band (BAND1). 

 

Band 1 

Band1 Dialog Box 
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10. You are now presented with the Label window.   
 

TASK: On the line where it says “ReportLabel,” type in “Employee Mailing List.”    
TASK: Click OK. 

 

 
 
 

11. Your screen should now look similar to the one shown below.  The next step is to 
center the label in the band.   

 
TASK: Click on the “center horizontally” button circled below to center the label in the 
band. 

 

Selecting the Label 
button 

184 Appendix C 



 

 
 

12. Now we need to add another band.   
 

TASK: Click on the Band  button and Click in the design window.   
TASK: Choose “Column Header” for Type and Click OK. 
TASK: Click the Band button again and Click in the design window.  
TASK: Choose “Detail” for Type and Click OK.   

 
Your design window should now contain a total of three bands (Title, Column Header, 
Detail) as shown in the screen below: 

 
 

13. e Detail band. The next step is to add the data fields to th
 
TASK: Click on the data field button circled in the screen shot below.   

 

Centering Horizontally 

Band1, Band2, 
and Band3 
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TASK: Click inside of the Detail band to bring up the “Data Field” window shown 
below. 
TASK: Select the field “FIRST” from the pulldown menu as shown below. 
TASK: Click the OK button. 

 

 
 

Continue adding data fields so that your detail band is laid out as shown below. 
 

Selecting the Data 
Field button 

Data Field Dialog
Box 
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14. Now we need to change the size of font for the fields on the report.   

TASK: To select all of the fields on our report, hold down your Shift key on the 
keyboard and and keep it down while Clicking on each field (FIRST, LAST, 
ADDRESS1, ADDRESS2, ADDRESS3).   
TASK: Click on the font size dialog box shown below and set the font size to 8. 

 

 
 

15. Now we are ready to fill in our Column Header band.  This band will be printed on 
the top of our Detail band and is generally used for printing the names on columns 
on the report.  We need to add text labels over the top of each datafield in the detail 
band. 

 
 

TASK: Use the Text  button to add the text “First Name” above the [FIRST] 
 field in the Column Header band. data

TASK: Continue adding text labels to the Column Header band above each data field so 

Selecting the font 
size 

that your screen matches what is shown in the picture below. 
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TASK: Select all the text labels in the Column Header band by holding down the SHIFT 
ey and g on each of them.  

TASK
k  Clickin

: et their font size to 8 and turn on the Bold and Underline properties by Clicking 
on the “B

 S
” and “U” buttons. 

 

16. Add the Date and Time to your report.   
 

 

  TASK: Click on the System Field button.
TASK: Click in the top left hand corner area of the Title Band. 

e Band, you are presented with the 
 
17. After dropping the System Field in the Titl

System Field Window shown below.   
 
TASK: Select Date/Time as the Type as shown in the screen below. 
TASK: Click OK.  The (Date/Time) text should be in the Title Band as shown in 
picture above. 

Screen should like 
this  
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18. Add one final band to your Report.   
 

TASK: Click on the BAND button  and then click in the design window.   
TASK: Select “Summary” as the type.   
TASK: Click OK.  Your screen should look like the one shown below: 

 
 

9. Add a text label to the Summary band. 
 

ASK

1

T : Click on the Text field button . 
TASK: Click inside the Summary band.   

ASKT : Type “Total Records”: in the Label field and Click OK. 
ASKT : Set the label font size 8, Bold and Underlined.   

 

TASK: Click on the System field button . 

Systemfield Dialog 
Box 
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TASK: Click inside the Summary band.   
TASK: t the Type as “Detail Count” and Click OK. 

  
 Se

 
 

0. Optional – Advanced Reporting Features – Script Language 
 

he following section shows you how to add a small piece of Script Code to your report.  
his section is optional; if you wish to skip this section, go to Item 30. 

ustom Reports provides an advanced way for you to add flexibility and creativity to 
our reports using script language.  A detailed explanation of this feature and its use are 

the Custom Reports documentation. 
 
In order to access an item on your report, whether it’s a field label or a text label, it must 
have a name.  In this example, we will be adding code to access the labels in the 
summary band; therefore, we must give them a name.   
 
TASK

2

T
T
 
C
y
provided in 

: Select the text label “Total Records” by clicking on it with your LEFT mouse 
button.  It should appear selected by having six small boxes around its perimeter as 
shown below. 
TASK: Now that it’s selected, click on it with the RIGHT mouse button.  A small drop 
menu will appear as shown below.   
TASK: Click on Options. 

Completed Screen 
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21. This will bring up the options window for this text label as shown below.   
 
TASK: Enter TOTALRECORDS in the Name field and click OK. 

 

 
 

22. We have now given the “Total Records”: text label the name “TotalRecords.” A 
name is required in order to access this label in the script language.  We must now 
give a name to the Detail Count label. 

ASK
 

T : Click on the [Detail count] field.  It should appear selected. 
ASKT : Right-click on the [Detail count] field. 
ASKT : Click on Options.  

TASK: Enter DETAILCOUNT in the Name field and Click OK.  

Right-clicking on Tota
Records and selecting 
Options 

Options Dialog Box 

l 



 

23. Now that these 2 labels have been given names we can access them in code. Script 
code is normally attached to the band which contains the labels you wish to modify.  
In this case, since these labels are in the summary band, we will enter the code into 

band    To do this, select BAND4 (the summary 
o m d. 

 

the summary ’s script window.
e  the active banband); w  need t ake it

TASK: Click on the Summary band (BAND4). The summary band should now be 
highlighted.   
TASK: RIGHT-click insid he summary bane of t d. Be sure your mouse pointer is over 

iel  in the mary  click in an open area of the band. You 
e the dow enu 

one of the f ds Sum  band – you must
should se drop- n m shown below.   
TASK: Clic n .  k o  Scripts
 

 
 

up the Scripts wi This is the window where you 
re Print and After Print.  Any 

Bef  Print e band prints.  Any code 
 in the fter Pri indo u want to add 

i  the loo r layo xecuting before it 
erefore, we wi ter ou e Before Print window.   

 

This will bring ndow as shown below.  
enter the script code.  This window contains 2 tabs – Befo
code entered in the ore  window will execute before th
entered A nt w w will execute after the band prints.  If yo
code to mod fy k o ut of text in the band, it must be e
prints; th ll en r code in th

TASK: Enter th ing  in the Before Print window: e follow  code
 

ECO
 

he above code tells Custom Reports to do the following: If the DetailCount is greater 
than 0, set the color of the label TotalRecords to Blue; otherwise, set the color of the 
label TotalRecords to Black.   

Right-clicking on T
Records and selec
Scripts 

If (DETAILCOUNT>0) 
  SetFontColor(‘TOTALRECORDS’, Blue) 

otal 
ting 

Else 
  SetFontColor(‘TOTALR RDS’, Black) 
Endif
 
T
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TASK: Click OK to save the report code.
 

 

 
 

24. The basic layout of our report is now complete.  The next step is to save our report.   
A K
 
ST : Select File > Save from the main menu.   

TASK: Enter “Employee Mailing List” as the name of this report and Click Save. 
 
25. We can now preview the results of our report.   
TASK: From the main menu select File > Preview.   
 
 
 
 
 
 
 
 
 
 
 

Script Dialog Bo

 

x 
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Your view of the report should look similar to the screen below.  If you did the Optional 
- Advanced section the Total Records: line at the bottom of your report should be 

red blue. colo
 

  
 

TA KS : To exit the Print Preview, Click Close.   
TASK: To exit the report designer, from the main menu, select File > Exit.  If you’re 
prompted to save the report, select Yes.   
TASK: To exit the Custom Reports main window, click Exit. 

 

tu

 

This concludes the Custom Reports tutorial.  Custom Reports have many more powerful 
res that we encourage you to explore. fea
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Appendix D: 
Import / Export File 
Format  

 
 
You may import and export only the fields on the Field Layout page. There are two 
different formats that you may use: Tab Delimited and Fixed Length.  
 

 Tab Delimited format you may use any program that allows you to save as Tab 
elimited. Excel and Access are two that will allow this. This is the easiest format. 

 
r  Last Name, First Name, etc. Also, 

lds that you will leave blank. For 
m e, we create a Tab Delimited file 

column for Middle Initial field], 
mn for Title field], 

ll of the fields in bold are 
umn for MI, Title and Employee Code 

 
S Editor or any other editor that shows 

must correspond to the Length column 
nd using the Tab Delimited format.  

 
 
 
 
 
 
 
 

 

For a
D
 
When entering your information into a spreadsheet such as Excel, you will need to 
follow the order of the field names according to the Field Layout page.  

Fo example, the columns should have SSN first, then
for any fieyou will need to leave a blank column 

exa ple, following the format on the Field Layout pag
with the fields: SSN, Last Name, First Name, [blank 
Location, Department, Date of Hire, Full/Part Time, [blank colu
[blank column for Employee Code field] and Active Status. A
required. We would still need to have a blank col
in the order of the fields.  

For a Fixed Length format, you may use the DO
you the field length. The lengths of each field 
under the Field Layout page. We recomme

 
 

195 Appendix D 



 

The
bold ust include them. 

 
Field

 following is the field layout for importing text files into Optima.  Fields shown in 
 type are required and all import text files m

 Name  Length Format 
  (if fixed  
  length 
  format) 

l Security Number 11 123-45-6789  

 
 
 

First up to 21 characters 

Loca  50 up to 25 characters or numbers 
a

te

me or Part-Time (only) 

If you have Confidential Employee Record installed, your text file can also include the following fields: 
 
Date of Birth  10 MM/DD/YYYY (slashes required) 
Address 1  30 up to 30 characters or numbers 
Address 2  30 up to 30 characters or numbers 
Home Phone  30 800-123-4567 (dashes required) 
City   30 up to 20 characters or numbers 
State (2 character)   2 2  characters, i.e., FL 
Zip Code  15 33325-1234 (-1234 can be omitted) 
Salutation    5 Mr. – Ms. – Mrs. – Dr. (only) 
Employee Security Level 16 up to 16 characters or numbers 
Security Clearance Date 10 MM/DD/YYYY (slashes required) 
Race   25 Must match a valid race on the detail tab.   
EEO Category  25 Must match a valid category on the detail tab. 
Sex M/F    1 M or F only 
Driver’s License Number 15 up to 15 characters or numbers 
I9 Renewal Date  10 MM/DD/YYYY (slashes required) 
Veteran Status  25 Disabled - Vietnam Era - Other Veteran –  
                                                                        Not Applicable (only)   
Office Phone & Ext. 30 800-123-4567 Ext. 123  

ax   30 800-123-4567  

 

Field 
Layout 

Socia
Last Name  20 up to 21 characters 

 Name  20 
Middle Initial  20 up to 20 characters 

tion 
Dep rtment  50 up to 25 characters or numbers 
Da  Of Hire  10 MM/DD/YYYY (slashes required) 
Full/Part-Time  10  Full-Ti
Titl   30 up to 3e 0 characters or numbers 
Employee Code  14 up to 14 characters or numbers 
Active Status A,I,T 10 Active or Inactive or Terminated (only) 
 

F
E-mail address  30 up to 30 characters or numbers 
Address Effective Date 10 MM/DD/YYYY (slashes required) 
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Appendix E: 
onverting your 
ersion 6 Custom 
eports to Optima 

Note that the following instructions only apply to users of Version 6 of Optima 
Attendance Controller and Confidential Employee Record. 
 
The custom reports we are referring to are the reports that were created by you or 
another user. This is different from the ready-made templates within the custom reports. 
You have two choices regarding your Version 6 customized reports.  
 
1. You may re-create the custom report in Optima by using the Wizard within custom 

reports (see Appendix C.) This is the recommended method.  
 

2. Or you may manually convert your Version 6 custom report to the Optima Version.  
 
There are five (5) tasks that are needed to be completed in order to manually convert 
each of your custom reports.  We only recommend going through these steps if you 
cannot re-create the custom report using the first choice above.  These tasks should be 
done from the same computer with both programs installed. 
 

C
V
R
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Task One – Exporting your report and
1. Open Version 6 and go to the Repo

 saving it as a .qr2 
rt Runner screen (as shown above) where your 

ure the report will 

. 
can be the same as the report name. Once 

ith an extension of .qr2. Write down the path and 
report name for use in Task Two.  

. Keep Version 6 open at the Custom Report screen (shown above) and go to Task 

 
T Loading Ver 6 repo stom Report Utility 
1 program
2 u, s yee Summary. The Employee Summary 

t to t eports feature.  
3 w Rep
4 ate th e name can be the same as the Version 6 

5 rt, the . 
6 en clic 2. 
7 ersion 6 file is located.  
8 en cli his will load the Version 6 report into the 

 Utilit k 3. 
 

custom report is located.   
2. Select your custom report and click on EDIT. 
3. From the FILE menu click on PREVIEW. This just makes s

come up.  
4. Close the Print Preview window.   
5. Select FILE, ADVANCED, EXPORT REPORT
6. Enter a name for the report. The name 

the name is saved it will save it w

7
Two. 

ask Two - rt into the Optima Cu
. Launch your Optima . 
. From the Reports men elect Emplo

Report is only used to ge he Custom R
. Click Custom , then Ne ort. 
. Enter a name to design

customized report.  
is report. Th

. Select New Blank Repo n click Next

. Select the File menu, th k Open QR

. Navigate to where the V

. Click on the .qr2 file th ck Open. T
Optima Custom Report y. Go to Tas

 

198 Appendix E 



 

Task Three - Change Page Header Ban
1. With your Version 6 report open to 

d from TABLE1 to MEMREPORT  
the Optima Custom Report Utility, click the 

rt, 

e PageHeaderBand title.  
aderBand selected, right-click on it and select SCRIPTS. 
ere it has ‘Table1’ with ‘memreport’ making sure to keep the 

single quote marks around it.   
. Click OK. 

sk Four. 

Report menu and select Datasets. 
2. Under the Main Report Table, click the drop down arrow and select memRepo

then click OK. 
3. Click once on th
4. With the PageHe
5. Replace everywh

6
7. Go to Ta
 

 
 
Task Four – Change grGroup Header and grGroup2 from TABLE1 to 

MREPORT ME
 

2. 

4. 
5. lick the Database Field button. 

7. d screen.  

9. 
10. 

1. Click once on the Group Header band (NOT the GROUP1 field) to select it. The
Group Header is the dark colored band. You may click anywhere on the band to 
select it.  
Right-click on Group Header and select EDIT. 

3. Locate Group by field or expression. 
Click on the 3 dots button to the right of Group1.  
Under Insert at Cursor Position, c

6. Under the Available Fields, select Group 1 and click OK. 
Click OK at the Expression Wizar

8. Click once on the grGroup2 band (NOT the GROUP2 field) to select it. You may 
click anywhere on the band to select it.  
Right-click on grGroup2 and select EDIT. 
Locate Group by field or expression. 
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11. Click on the 3 dots button to the right of Group2.  
Under Insert at Cursor Position, click the Database Field button. 
Under the Available Fields, select Group 2

12. 
13.  and click OK. 

 
5. Follow the above steps if you have more group bands. 

Five. 

14. Click OK at the Expression Wizard screen.  
1
16. Go to Task 
 

 
 

1.  (circled above), you should see both TABLE1 and 

a Custom Reports. 
2. Field Names are usually on the Detail Band and normally not in bold. Title headings 

are usually in bold. Field names are the fields that give you your actual data on a 
report. Normally, you’ll see two fields with the same name when editing a report. 
One is usually the title, and the other is the data field. With all that said, the next 
step is to change all data fields (not titles) from Table1 to MemReport. 

3. Follow the remaining steps for each data field (such as Full Name, EESSN, DOH, 
etc.) on the Detail Band. 

4. Click once on the first data field, such as Full Name, then right-click and select 
EDIT. 

5. Click on the drop down arrow in the first block and select memReport, then click 
OK.  

6. Do steps 4 – 6 for all data fields.  
Once those tasks are completed, you should be able to see your custom report under the 
Employee Summary Custom Reports interface. (See screenshot below.)  
 

Task Five – Changing all field names from Table 1 to MemReport 
In the Data Field box
MEMREPORT.  If not, save the custom report you’re working on, close out of the 
Optima Custom Reports and make sure that Version 6 Custom Reports is open, 
then reopen the Optim
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You have the option to allow others to see this report from their computer by clicking in 
the checkbox for “Make this report available to everyone.” 
 
See Chapter 12 Custom Reports and Appendix C for more information.  
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Appendix F: 
Standard Time Vs 
Military Time 

 
The following chart is for reference. 
 
 
Standard Time           Military Time 
12      pm               1200 hrs 
12:30 pm 1230 hrs 
1        pm                   1300 hrs 
2        pm                       1400 hrs 
3        pm                       1500 hrs 
4        pm                      1600 hrs 
5        pm                      1700 hrs 
6        pm                      1800 hrs 
7        pm                      1900 hrs 
8        pm                      2000 hrs 
9        pm                      2100 hrs 
10      pm                      2200 hrs 
11      pm                      2300 hrs 
12      am                      2400 hrs 
1        am                      0100 hrs 
2        am                      0200 hrs 
3        am                      0300 hrs 
4        am                      0400 hrs 
5        am                      0500 hrs 
6        am                      0600 hrs 
7        am                      0700 hrs 
8        am                      0800 hrs 
9        am                      0900 hrs 
10      am                      1000 hrs 
11      am                      1100 hrs 
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Appendix G: 
ET215 Terminal Quick 
Start 
 
 
Overview 
This is a QUICK START document for use with the Time Clock Remote Ethernet 
Terminal. It will help the first time user get a terminal installed and communicating 
rapidly. It is strongly recommended that this documentation is reviewed BEFORE 
installation of the terminal is attempted. 
 
It is assumed that the user has a host computer with the TCP/IP network protocol 
installed and the computer is connected to the Ethernet network. It is also assumed that 
the installer is familiar with network fundamentals such as IP address and port number. 
The Optima Time Clock Remote program is required to remotely configure and test the 
terminal over the network.  
 
Time Clock Remote Configuration 
The terminal must be configured with a valid IP address BEFORE it can be installed on 
the network. Initially this process is accomplished using the keypad & display. Once it is 
configured properly and installed on the network, it can be reconfigured over the 
network using the Optima Time Clock Remote program. 
1. Attach the power adapter to the terminal and plug the adapter into a power 

receptacle. (See picture below.) 
2. The terminal should “beep” three (3) times and then display the “Offline” message. 
3. Hold down the “S1” & “S2” keys and then press the “IN” key to enter the 

configuration mode. A menu will be display, press the “2” key to modify the 
configuration parameters. 

4. The default IP address will be displayed. In most cases the default IP address 
(192.168.168.50) will have to be changed. Use the keypad to modify the IP address 
value and press the “Enter” key. 

5. The default network mask will be displayed next. Change this if you have a network 
mask and press the “Enter” key.  

6. The other setup parameters are presented one at a time on the terminal display. 
Press “Enter” until you get to MODE. Change the Mode parameter to 2. The 
default values for the others should be valid for most applications and can be 
accepted by simply pressing the “Enter” key.  
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7. When all of the setup parameters have been entered, the terminal will return to the 
configuration menu. Press the “Enter” key to exit the configuration mode. The 
“Offline” message will be displayed. 

8. At this point the terminal can be powered down and is ready for installation. 
 
Installation 
Once the Time Clock Remote has been configured, it can be installed on the network. 
1. Connect the terminal (RJ-45) to a 10/100BaseT Ethernet hub (or switch) with a 

standard Ethernet cable. (See picture below.) 
2. When power is applied one of the network status LED indicators should light. 
3. Start the Time Clock Remote program on the host Windows PC computer and 

login by going to File > User Login. 
4. Click File > New Terminal to create a new terminal connection. The Terminal 

Name is what will display under Help > System Information on any Optima 
program. Select the Time Clock Remote (or the appropriate Terminal Type) and 
enter the IP address and the Port Number (default is 1070). 

5. Select Connect at Startup and press Connect. The Time Clock Remote program will 
display Connected and the Terminal will respond with the date and time. This 
indicates the Terminal is communicating over the network and is ready to accept 
commands. 

6. Data can be entered on the Time Clock Remote keypad by pressing the numeric 
keys and then pressing the “Enter” key. The entered message will appear on the 
telnet client screen.  

7. If the Time Clock Remote is equipped with a card reader (mag-stripe) the decoded 
output can be displayed. 

Optional digital I/O functions can also be tested using the RELAY, INPUTS, and 
COUNTER commands. 
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